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1 Introduction

The EyeLink® Data Viewer is a tool that allows users to display, filter, and create output
reports from EDF data files recorded with EyeLink eye trackers (EyeLink I, EyeLink II,
EyeLink 1000, EyeLink 1000 Plus, EyeLink Portable Duo, etc.). Data Viewer includes
the following areas of functionality.

1.1 Data Visualization

Data Viewer supports three viewing modes: Spatial Overlay View, Temporal Graph
View, and Animation Playback View. In the first two viewing modes, users can specify
which event types to display, including fixations, saccades, blinks, messages, buttons,
and inputs. Sample traces can also be displayed. The Animation Playback View plays
back the trial and shows where the participants look over time.

Spatial Overlay View allows gaze data to be viewed superimposed on the background
image that the participant was looking at while the data was being recorded. This view is
ideal for relatively static trial presentations, like reading or visual search paradigms.
Fixations can be displayed as either circles or as a scan path. Saccades can be displayed
as lines with an arrow specifying the saccade direction. Blinks can be displayed as a line
joining the last valid sample position prior to the blink and the first valid sample
following the blink. Message, input, and button events can be displayed as a small
rectangle, where the position of the event is determined by the position of the nearest
sample recorded at the message, input, or button event time.

The Temporal Graph View provides a two dimensional plot of trial data. The X axis
represents time, while the Y axis represents the location of the samples or events being
plotted. This view is suitable for a wide range of experimental paradigms, including those
using dynamic trial displays. The scale of the graph can be changed via zoom in and
zoom out operations. This view supports binocular display of sample position, pupil size,
velocity, and acceleration traces.

In both Spatial Overlay View and Temporal Graph View, the color of individual events,
as well as the global color of a given event type or sample trace, can be changed as
desired. There are many preference settings that can be configured by users, saved, and
then applied to future loaded data.

The Animation Playback View plays back the participant’s gaze data, with a concurrent
time code displaying the time from the start of trial recording. If the image or images that
were shown during the trial recording are available, they can be loaded as the background
for the Animation Playback View. A trackbar control displays the progress of the
playback and lets users select a specific position to start playback. The speed of playback
can also be adjusted.
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Multiple viewing windows can be opened at one time, displaying data from different
trials or displaying data of one single trial in the Spatial Overlay View, Temporal Graph
View, and Animation Playback View concurrently.

Version 2.3 of EyeLink Data Viewer added support for the Aggregate Mode. This mode
allows users to superimpose eye tracking data from multiple participants/trials on the
same background image in the Spatial Overlay View, and to play back gaze positions
from several trials/participants simultaneously over time in the Animation Playback
View. Summary statistics (e.g., average recording duration, event counts, fixation
duration, and saccade amplitude) can also be obtained for the entire aggregate trial group.
For the ease of data comparison between participants or conditions, different drawing
colors can be applied to the events of individual trials or participants.

1.2 Event Selection

EyeLink events can be selected from within either of the static data views (Temporal
Graph View or Spatial Overlay View). Detailed properties of the selected event can be
examined within an Inspector Window that also provides a list view of all visible events
in the selected trial. Properties of a selected event that are editable by users (like the
event’s color) can be modified directly within the Inspector Window.

1.3 Interest Area Definition

The Spatial Overlay and Animation Playback Views allow the creation of any number of
interest areas for the trials. Rectangular, elliptical, and freehand interest area shapes can
be created. The position and shape of the Interest Area can be modified after Interest
Area creation.

Users can view fixation-based statistics for a selected interest area, including the fixation
count and total dwell time for the interest area, as well as the proportion of fixations and
dwell time relative to the trial totals.

Interest area templates can be created and applied to multiple trials, speeding the process

of defining interest areas for multiple trials / participants.

1.4 Event Filtering

Data Viewer supports data filtering, including deleting, merging, and drift correcting
event types. Not all filtering functions are available to all event types. The original
EyeLink EDF file is never modified by Data Viewer, so the original recorded data is
always available.
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Events can be hidden within a viewing session through the definition of some temporal
filtering preferences or interest periods. Hiding events allows users to focus on a subset
of a trial’s data. Hidden events can be made visible again later if required.

Events can also be deleted from within Data Viewer. This is useful, for example, if the
researcher inspects a specific fixation or saccade event and determines that the event
detection performed by the EyeLink on-line parser did not satisfy their needs. If a
fixation or saccade event is deleted, the surrounding saccade or fixation events are
automatically merged to keep the event structure consistent.

The position of a fixation event can also be adjusted if required. This is only suggested if
it is obvious to the user that improper system setup or calibration has resulted in a trial’s
fixation data containing significant drift that can be easily corrected manually. Any event
that is adjusted in this fashion is flagged so that it is clear which events have been
manually altered. Optionally, if the position of a fixation is adjusted, the adjoining
saccade end point and start point are also adjusted so that the saccade positions are kept
consistent with fixation positions.

1.5 Interest Periods and Reaction Time Definition

For each trial, users may selectively view and perform analysis on data within a specific
period of time within a trial (Interest Period). Data Viewer allows users to create interest
periods based on messages, input, and button events. The created interest periods are
added to an interest period list. Users can navigate between different interest periods by
selecting the desired interest period from the list. For each interest period, only those
events falling within that period are shown in the Spatial Overlay, Temporal Graph
Views, and in the event list of the Inspector Window. In addition, only those events and
data within the selected interest period (custom-defined interest period, or the default —
“Full Trial Period”) are exported to the output file.

One important variant of the interest period is the reaction-time period. Reaction Time
Definitions (RTD) can be created and applied to all trials loaded into an EyeLink Data
Viewer session. Each RTD can have a set of trial condition variables that must be
matched for the RTD to be applied to a given trial. The message event to use as the start
time for the reaction time can be defined. Each RTD can have a fixation, saccade, input,
button, or message event as the ending event for the reaction time calculation.
Depending on the event type selected for the reaction time end event, a set of event
properties can be specified to determine which event should be used within each trial. A
number of RTDs can be created for a given Data Viewer session, allowing multiple
reaction time conditions to be specified. Each trial will only be matched to at most one
RTD.

1.6 Data Output and Analysis

Data Viewer can produce a range of output reports.
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The Trial Output Report generates one row of data for each trial. A set of output variables
can be selected, with each variable output as a column in the report. Variables include the
count of each event type visible within the trial, the average fixation duration and
saccadic amplitude, as well as the reaction time calculated for the trial based on the
reaction time definitions created for the Data Viewer session.

The Fixation Output Report provides information about fixation events; each row of the
report represents a fixation event. Fixation report variables include fixation start and end
time, duration, average position, interest area identifier, etc. A set of relative variables is
also available, including the previous and next fixations’ position, angle, distance, and
direction.

The Saccade Output Report generates one row for each saccade. Again, a set of output
variables can be selected, with each variable output as a column in the report. Saccade
output report variables include saccade start and end time, start and end position,
amplitude, angle, direction, average and peak velocity, etc. A set of relative variables is
also available, including the previous and next saccades’ start and end position, etc.

The Interest Area Output Report generates one row for each interest area in every trial.
Variables include the interest area identifier, label, fixation index list, number of fixations,
summed dwell time, and proportions of fixations and dwell time in the interest area
relative to the trial.

The Sample Output Report generates one row of data for each eye sample in a trial.
Variables include the index of the sample, time of the sample, gaze position (X, y),
velocity, acceleration, and pupil data of the current sample. If appropriate target position
messages are read from the EDF file, the position, velocity, and acceleration data of (up
to two) targets can also be provided.

The Message Output Report provides information concerning the messages written in
each trial. Variables include the index, label, text, and time of the messages. The message
report also provides the eye movement event data (fixation, saccade, blink) and sample
position at the time when a message was recorded to the EDF file.

Data Viewer can also output group-level summary statistics. The Aggregate Event
Statistics provide an event summary report for each trial group. Variables include blink,
button, fixation, saccade, input, fixation run, and sample count averaged across trials, as
well as the mean and median fixation duration and saccade amplitude for the entire trial
group. The Aggregate Interest Area Report provides information about each interest area
in each trial group. Variables include dwell time, fixation count, first fixation
time/duration, and run count, as well as the percent of trials visited/revisited.

In addition, users can also save the Spatial Overlay and Temporal Graph views into

image files, save the playback of the trial into a movie file, or create a "landscape" view
(i.e., fixation or heat map) for a trial or for a group of trials with the same background
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1.7 Experiment Integration

Data Viewer can respond to specific commands that are written directly into the .EDF file
by the experimental software, allowing very high levels of integration. These commands
are interpreted by Data Viewer when the data file is loaded and can automate several
areas of functionality.

By using a set of predefined viewer commands, the programmer of an experiment can
inform Data Viewer regarding:

a) The image(s) to load for each trial’s Spatial Overlay View.

b) The Interest Areas to load for each trial.

c) The Reaction Time Definitions to apply to the Data Viewing session.

d) The trial condition variables and values to use for each trial.

e) The position of the target in a dynamic display.

If you use SR Research Experiment Builder software, please make sure you use the
Experiment Builder Project Checklist to check the experiment project before data
collection. Following the steps in the list will ensure optimal integration with Data
Viewer. The checklist is contained in the Experiment Builder User Manual (or from this
link https://www.sr-support.com/forums/showthread.php?t=1012).

1.8 Citing EyeLink Data Viewer

Please use the following to cite the Data Viewer software in your manuscript:
EyeLink Data Viewer 3.1.97 [Computer software]. (2017). Mississauga, Ontario,
Canada: SR Research Ltd.
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2 Installation

2.1 System Requirements

Operating System: Windows XP, Vista, 7, 8, or 10, Mac OS X 10.6 or later, Linux
(Ubuntu x86 and x64, 14.04 LTS or later)

Processor: Pentium 4 1.4 GHz or higher (avoid computers with atom CPU)
RAM: Minimum 1GB MB RAM (2GB or higher recommended)

Disk Space: 240 MB free disk space for application plus space required for EyeLink data
files and saved viewing sessions.

Graphics Card: video card with OpenGL 2.0 support and with at least 128 MB RAM; a
recent video card with OpenGL3.0 support is required for dynamic heat map
presentation.

Monitor Resolution: 1024x768 or better resolution

Other: Free USB port required

2.2 Installation on Windows

The latest version of the Data Viewer installer can be downloaded from https://www.sr-
support.com/showthread.php?4434. If you have a previous version of EyeLink Data
Viewer installed on the computer, please choose the “Clean Install” option when running
the DV installer or uninstall it through Windows© Control Panel before installing the
newer version. By default, the EyeLink Data Viewer software will be installed at
"{Windows Drive}:\Program Files (x86)\SR Research\DataViewer".

Important: A USB license key provided by SR Research is required to run this
application and must remain connected to the PC while the application is running. If a
USB license key is not detected by the program, the application will run in a DEMO
mode supporting limited data loading.

2.2.1 For Standard Installation (applicable to most users)

The following installation instructions are applicable to users who use a standalone USB
license key that supports a single-PC license.
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. Install the EyeLink Data Viewer software. Double click on the

EyeLinkDV_3.*.exe installer, keeping the default settings.

Install the standalone HASP key driver (if this is the first time that the USB
license key has been used on the display PC). You may install the driver by
clicking "Start -> All Programs -> SR Research -> Install Hasp Driver" from your
computer desktop, or by double clicking on "hdd32.exe" in "C:\Program Files
(x86)\SR Research\Common" folder.

Insert the license key into the display computer. Click on the License Manager
utility (Start -> All Programs -> SR Research -> License Manager) to check for
the licensing status for the Data Viewer software.

From the computer desktop, click "Start -> All Programs -> SR Research ->
EyeLink -> DataViewer -> DataViewer" to run the application.

2.2.2 For Installation using Network Licensing

The following is applicable to users who have purchased a network license (i.e., a shared
license for several computers on a network that are running EyeLink Data Viewer at the
same time) for the Data Viewer software.

1.

Install the Data Viewer software. Double click on the EyeLinkDV_3.*.exe
installer, keeping the default settings on InstallShield Wizard screens except for
the following two:

*  On the "Setup Type" dialog box, select "Custom".

* On the "Select Feature" screen, make sure that both "HASP4" and "HASPHL"
driver options are selected.

Install the network HASP key driver. You may install the driver by clicking "Start
-> All Programs -> SR Research -> HASP HL Driver" from your computer
desktop or double clicking on "HaspUserSetup.exe" in "C:\Program Files
(x86)\SR Research\Common" folder.

Install network HASP License Manager. You may install the tool by clicking
"Start -> All Programs -> SR Research -> Networked HASP License Manager"
from your computer desktop or double clicking on "Imsetup.exe" in "C:\Program
Files (x86)\SR Research\Common" folder. Failing to install this will report a "NO
HASP Key Found" error in the SR License Manager dialog box.

*  When installing the license manager, set the "Installation Type" to Service
(nhsrvice.exe).

*  On the "HASP License Manager" dialog box, check either Yes or No to
continue.

If this is the server computer, you may install optional Aladdin Monitor software
by clicking "Start -> All Programs -> SR Research-> Aladdin Monitor" from your
computer desktop or double clicking on "Aksmon32.exe" in "C:\Program
Files\SR Research\Common" folder.

Test license status.

* Please make sure that the server and client computers are running and visible
to each other in the same network group (check this out from "My Network
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Places -> View Network computers"). Contact your system administrator if the
computers cannot see each other in the same network group.

* Please make sure that the network license key is plugged into the server
computer (remove all other HASP license keys) and drivers are already installed.
* Now, click "Start -> All Programs -> SR Research -> License Manager" to
check the licensing status of each of the client computers in the network.

2.3 Installation on Mac OS X

The latest version of the Data Viewer installer can be downloaded from https://www.sr-
support.com/forums/showthread.php?t=4434. If you have a previous version of EyeLink
Data Viewer installed on the computer, please uninstall it first by removing the
"/Applications/EyeLink Data Viewer" folder to Trash. Now double click on the
EyeLinkDV_3.*.dmg installer. Select the "EyeLink DataViewer 3.*" folder in the
package, and drag and drop it into the "Applications" folder. The software is now
installed at "/Applications/EyeLink Data Viewer 3.*". Click on "DataViewer.app" to run
the software.

To run Data Viewer in a fully licensed mode, users need to purchase a license key for the
software and have the key attached to the computer on which the Data Viewer software is
installed. If this is the first time that the license key has been used on your Mac, you will
need to install the driver for the key. The driver installer can be found in the folder after
unpacking the DataViewer installer program. Double click on the
"Sentinel HASP RTE Installer.dmg" file and then run the "Install HASP SRM Runtime
Environment" application with default settings. The license key will glow if the driver
installation is successful.

2.4 Installation on Linux (Ubuntu x86 and x64)

For installation on Ubuntu x86 and x64, please use the PDF document that can be found
at the Data Viewer download page - https://www.sr-
support.com/attachment.php?attachmentid=4171. If you have not yet done so, please
follow the instructions to first set up our software repository at its new URL address, and
then Section 1.5 of that PDF document related to installing Data Viewer and its
dependency packages.

EyeLink Data Viewer ©2002-2017 SR Research Ltd. 8



3 Working with Files

Data Viewer can import EyeLink EDF files. The software loads each data file into a Data
Viewing Session (DVS). A DVS can consist of many EyeLink data files. Only one DVS
can be open within Data Viewer at a time (although in Windows multiple copies of Data
Viewer can be run simultaneously).

Once a DVS has been created and EyeLink data files have been imported into it, the DVS
file can be saved and then reloaded at a later date for future analysis. It is much quicker
to open a saved DVS than to reimport the original EDF files.

All changes made during a viewing session only affect the DVS data; the original EDF
files are never altered.

3.1 Creating a Data Viewing Session (DVS)

From the menu, choose:
File — New

Tip: A new viewing session can also be created by clicking the Create New Data
Viewing Session tool ® on the standard toolbar, or press Ctrl N on Windows or 3§ N
on Mac OS X.

Tip: To find out the meaning of a tool on the standard toolbar, simply hover the mouse
over the tool.

3.2 Saving a Viewing Session
From the menus, choose:
File — Save

Tip: The viewing session can also be saved by clicking the Save Data Viewing
Session tool 21l on the standard toolbar, or press Ctrl S on Windows or 3£ S on Mac OS
X.

When a new viewing session is saved, Data Viewer will create a {session name}.evs file
as well as a {session name}.res folder - both of these are contained within a folder that
has the viewing session name and both of them are required for a proper re-opening of
the viewing session later on.

Note: For Experiment Builder projects, it is sensible to save the viewing session in the
“results” or “myfiles” subfolder of the deployed project so that everything stays together.

EyeLink Data Viewer ©2002-2017 SR Research Ltd. 9



3.3 Opening an Existing Viewing Session

To open an existing viewing session
1) From the menus, choose:
File — Open ...
2) In the Open dialog box, browse to the location of the file and select it.
3) Click Open

Tip: A saved viewing session can also be opened by clicking the Open Existing Data
Viewing Session tool 2 on the standard toolbar, or press Ctrl O on Windows or 3§ O
on Mac OS X. The viewing session can also be opened by double clicking on the
{session name}.evs file. Please make sure that the {session}.res folder is available;
otherwise the viewing session cannot be properly opened.

Note: Viewing sessions saved with an earlier version of Data Viewer can be opened with
later versions of the software. However, earlier versions of Data Viewer will not be able
to open a viewing session saved by later versions of the software.

Note: If a viewing session cannot be opened with a “Cannot open the active session”
error, please check whether the current viewing session is already open. This error can
also arise because of an unhandled .lock file from a crashed viewing session — removing
this file will fix the issue.

3.4 Saving an Existing Viewing Session to a Different File
To save a viewing session to a file
1) From the menus, choose:
File — Save As...
2) Inthe Save As dialog box, browse to the directory in which you want to save the
document.
3) In the File Name text box, type in the name for the document.
4) Click OK.

Tip: The viewing session can also be saved by clicking the Save Data Viewing
Session As ... tool I&¥ on the standard toolbar.

3.5 Importing EyelLink Data Files
EyeLink EDF files can be imported into an already opened Viewing session or, if no

Viewing session is open, a new one will be created for you when the data files are
imported.
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To import a single .EDF file,
1) From the menus, choose:
File — Import Data ... — EyeLink Data File ...
2) In the Open dialog box, browse to the location of the EDF file that you want to
import and select it.
3) Click Load.

Tip: EyeLink data can also be imported by clicking the Import EyeLink Data File
button B on the standard toolbar,

Multiple EDF files can be imported through “File — Import Data ... — Multiple
EyeLink Data Files ...”, or Press Ctrl | on Windows or &£ 1 on Mac OS X. This can also
be done by clicking on the & icon in the application toolbar. In the “Import EyeLink
Data File” dialog box, browse to the intended “Location”. A list of EDF files will be
displayed. If the "Include Sub-directories" option is checked (default option), the target
directory and its subdirectories are searched; otherwise, only the location selected will be
searched. Select the intended files and then click “Import”.

Import EyeLink Data File . 5_'

v Include Sub-directories

Location ID AMy Documents I

Select all Select None Invert Selection Impork Cancel

Figure 3-1. Import Multiple EDF Files

Some earlier versions of the software didn’t load samples by default for performance
considerations. To make sample data available to a viewing session, you will need to first
change the data loading preferences and then reload the EDF file.

1. Before loading any EDF files, please close the current viewing session and click
"File -> New" to create a new session.

2. Click the "Preferences" tab in the Inspector Window and go to "Data Loading"
preferences. Check the "Load Samples" option. If you want this change to be
persistent over future viewing sessions, you may consider saving this as a default
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setting. This can be done by selecting any preference tree node, clicking the right
mouse button and selecting "Save Properties as Defaults".
3. Now start loading in the EDF files.

Note: To load data files using the SceneLink gaze mapping, please make sure to enable
the “Enable SceneLink Gaze Mapping” and “Generate SceneLink Frame Messages” in
the “Data Loading” preferences settings before you import the data files. Make sure that
you have already created the lookup tables for the trials in SceneLink.

Note: The time it takes to load the data files will depend on their size and particularly on
whether or not you are loading samples from the data file. Data Viewer will take a few
minutes to initially parse a 60-minute binocular 500 Hz recording if loading all events
and samples. Once you have saved the viewing session, reloading the session takes a
fraction of the time because the data is in a format optimized for the Data Viewer.

3.6 Packaging a Viewing Session

For the ease of transferring a data viewing session from one computer to another, or from
one folder to another, users can create a single packaged file of the current data viewing
session by clicking "File -> Package ..." from the application File menu. This will zip up
the current viewing session and save the packaged file at a location selected by the user.
The packaged viewing session, still preserving the necessary image and interest area
integration, can be unpacked by double clicking on the file on a computer with version
2.2.1 or later of Data Viewer installed. Important! The package file only contains
necessary files for reconstructing the data viewing session at another location or
computer; it is not a complete backup of the original experiment data and does not
contain the original .EDF files. Users are strongly recommended to make a backup
copy of the original experiment data.

Tip: The Data Viewing session can also be packaged up by clicking the "Package

Existing Data Viewing Session" button (gj) on the application tool bar or pressing F5 on
Windows.

3.7 Unpacking a Packaged Viewing Session

A packaged viewing session can be unpacked by double clicking on the .dvz file on a
computer with a recent version of Data Viewer installed, or by clicking "File ->
Unpack ..." from the application File menu. In the following dialog box, users can
specify the source file to be unpacked and the directory where the session should be
unpacked.
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unpack x|
Packed Project (Source) || I

Directory Unpacked To (Destination) IC:\Temp\Untjﬂed

OK | Cancel

Figure 3-2. Unpack a Packaged Viewing Session

Tip: The Unpack Viewing Session dialog box can be started by clicking the "Unpack

Data Viewing Session" button (ﬁ) on the application tool bar or pressing F3 on
Windows.

3.8 Merging Viewing Sessions

Data Viewer allows users to import EyeLink data from multiple participants so that the
analysis and report output can be performed within a single session. If users have already
saved individual viewing sessions for each of the EDF files, Data Viewer provides an
option to merge the individual viewing sessions into the current active session. Click
“File -> Merge Viewing Session ...” from the application file menu bar, browse to the
folder where the individual .evs file is located, select the file, and click Open in the dialog
box. Upon merging, all of the data adjustments (e.g., fixation cleaning, moving, merging)
and interest area and image/video integration in the viewing session that is being merged
will be preserved. However, its session preferences, selection of report variables, and
interest period configuration will be dropped — the settings from the currently active
viewing session will be used instead. Please also note that settings from the old viewing
sessions can be exported and imported into the current active session if desired.
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4 Data Viewer Windows

Data Viewer uses a desktop framework that contains all windows of the Viewer
application. Once a Data Viewing Session (DVS) is opened and EyeLink data is loaded,
two windows will appear: the Inspector Window on the left and the Trial View Window
on the right. The Inspector Window allows users to choose data to be viewed, to review
statistical summaries, and to configure default application settings. The Trial View
Window allows a graphic examination of the data for the selected trial. Both windows
can be minimized and maximized within the Application desktop when running Data
Viewer on Microsoft Windows whereas the Inspector Window is built into the main
Application desktop and cannot be maximized/minimized on Mac OS X. The figure
below shows the viewer desktop after loading one example file.

~e' EyeLink Data Viewer Version 2.4.0 - Untitled_pictures.evs (E:\Untitled_pictures)
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Figure 4-1. Viewer Display after Loading an Example Recording File
4.1 Inspector Window

The Inspector Window consists of 2 tabs, the Data Tab and the Preferences Tab (see
Figure 4-2).
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4.1.1 Data Tab

The Data Tab consists of 3 panels (Figure 4-2, left Panel). The top panel provides a tree
view of the viewing session. The first level of the tree view contains trial-grouping nodes
(§ ). EyeLink Data Viewer lists trials within a viewing session by either data file or by
experimental conditions. Each trial-grouping node has a set of tree leaves representing
the trials (I-:J) that are contained within that node. Navigation in the tree view can be done
by clicking on the nodes with a computer mouse or by pressing the cursor keys. A closed
trial group node can be opened by double clicking on the node or by pressing the right
cursor key. Double clicking on an opened trial group node or pressing the left cursor key
will close the trial group. To navigate between trials or trial groups, use the up or down
cursor key, or perform a single click on the target node.
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Figure 4-2. Components of the Inspector Window (Left: Data Tab; Right: Preference
Tab)

EyeLink Data Viewer ©2002-2017 SR Research Ltd. 15



The middle panel represents a list of components that are within the selected node of the
analysis session tree. If a trial is selected in the session tree, a list of visible events is
displayed. If an Interest Area Set is selected, a list of interest areas that make up the set is
displayed.

The bottom panel is a table representing the properties of the selected tree node or
selected list component. For example, if a fixation is selected, all properties of the
fixation are listed in the properties table. Some properties, like color, are editable, by
clicking on the property value with the mouse.

4.1.1.1 Data Tree Hierarchy

When a data file is loaded, the tree view panel lists the possible analysis levels in a
hierarchical order. Users can obtain information on the trial groups and individual trials.
Within each trial, statistics on all events (fixations, saccades, blinks, button presses, and
messages) and interest areas can also be retrieved.

4.1.1.2 Trial Groups

By clicking on a trial-grouping node (E-l? ), information on this trial group can be obtained
in the bottom panel of the Inspector Window. Typically, this includes the label of the
group (values of the grouping variables), total number of trials, and configurable interest
area information (see section 6.1.3 on how to perform trial grouping). By default, trials
in a viewing session are grouped by the EyeLink data files loaded, but this can be easily
changed by clicking “Edit -> Trial Grouping”.

Version 2.3 of EyeLink Data Viewer introduced Aggregate Mode (¥%), which allows
users to visualize eye-tracking data from multiple participants/trials and provides
summary statistics (e.g., average recording duration, event counts, fixation duration,
saccade amplitude) for the entire trial group. A warning dialog box will be displayed
when the Aggregate Mode button is clicked for the first time in the viewing session.
Please note that data visualization in the Aggregate Mode requires trial data to be loaded
into memory. For performance consideration, Data Viewer will only load trials from the
current trial group into memory; if you are analyzing a large dataset not all trials will be
loaded into memory. You can determine the number of loaded trials in the current trial
group by clicking on the group node and checking the "Loaded Trial Count" property in
the Inspector Window. The icon in the tree view next to each trial indicates whether the
trial is loaded into memory - filled icons ([-:>' ) indicate a loaded trial whereas open icons (

l-:J) indicate an unloaded trial.
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The following table lists the group properties if trials are grouped by data file. Those
fields that are editable in the viewer are marked with an asterisk. Please note that should
trials in the group fail to load completely because of the memory limit, the summary
statistics displayed in the property table will be based on the loaded trials —the complete
statistics based on the entire trial group can be obtained from the Aggregate Event

Statistics report.

Field Contents

Label * The label of the trial group.

File The file name of the recording (with the path information).
This property is only visible when the default trial grouping
(by recording data) is used.

EyeLink Version Tracker version of the EyeLink system. This property is only
visible when the default trial grouping (by recording data) is
used.

Recorded By The name of the application running on the display side that

produced the current EDF file. This property is only visible
when the default trial grouping (by recording data) is used.

Number Trials

The total number of trials in the trial group.

Loaded Trial Count Total number of trials loaded into memory for aggregated data
analysis (if all trials are loaded, this should be total number of
trials in the trial group).

Loaded Trial Indices A list containing indices of trials in the trial group that are

loaded into memory for aggregated data analysis.

Default Interest Area Set
%

This shows the default interest area set (chosen from the
interest area templates) used for this group of trials. If none,
then displays “Empty Interest Area Set”.

Display Width,
Display Height

Horizontal and vertical resolution of the eye tracker recording
(in screen pixels).

Display Left, Display
Top

The X, Y coordinate (in screen pixels) for the top-left corner
of the recording.

Exclude from Reports *

If checked, the entire data file (if default trial grouping is
used) or grouping node (if trial grouping is applied) will be
excluded from the reports.

Apply Coloring to
Visible Events *

Data Viewer provides default drawing colors for events in the
Trial View Window for all trials/participants. Users can
change the color of the currently visible (visibility toggled on)
events through this property so that a distinct color can be
applied to all events in a trial or in all trials of a trial group (or
participant). Please make sure the "Apply Coloring to Events"
box is checked before choosing the intended color.

Color *

If the "Apply Coloring to Events" box is checked, users can
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customize the colors of currently-visible (visibility toggled
on) events in the Trial View Window so that the selected
color can be applied to all events in a trial or in all trials of a
trial group (or participant).

Average Recording
Duration

Average duration (in milliseconds) of trial recording (between
the START event and the END event) across all trials in the
trial group. This property will only be visible when the
Aggregate Mode is turned on.

Average Number of
Samples

Average number of samples in a trial, calculated as the total
number of samples in the trial group divided by the number of
trials in the group. This property will only be visible when the
Aggregate Mode is turned on.

Average Number of
Fixations

Average number of fixations in a trial, calculated as the total

number of fixations in the trial group divided by the number

of trials in the group. This property will only be visible when
the Aggregate Mode is turned on.

Average Number of
Saccades

Average number of saccades in a trial, calculated as the total

number of saccades in the trial group divided by the number

of trials in the group. This property will only be visible when
the Aggregate Mode is turned on.

Average Number of
Blinks

Average number of blinks in a trial, calculated as the total
number of blinks in the trial group divided by the number of
trials in the group. This property will only be visible when the
Aggregate Mode is turned on.

Average Number of
Buttons

Average number of button presses in a trial, calculated as the
total number of button presses in the trial group divided by the
number of trials in the group. This property will only be
visible when the Aggregate Mode is turned on.

Average Number of
Messages

Average number of messages in a trial, calculated as the total
number of messages in the trial group divided by the number
of trials in the group. This property will only be visible when
the Aggregate Mode is turned on.

Average Number of
Inputs

Average number of input events that occur during the trial,
calculated as the total number of input events in the trial
group divided by the number of trials in the group. This
property will only be visible when the Aggregate Mode is
turned on.

Average Number of [As

Average number of interest areas, calculated as the total
number of interest areas across all trials in the trial group
divided by the number of trials. This property will only be
visible when the Aggregate Mode is turned on.

Average Number of Run

Average number of fixation runs (two consecutive fixations in
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Counts the same interest area belong to the same run) of in a trial. In
the Aggregate Mode, this is calculated as the average run
count across all trials in the trial group. This property will
only be visible when the Aggregate Mode is turned on.

Average Number of [As | Average number of unique interest areas visited in the trial

Visited (calculated as the average count across all trials in the group).
This property will only be visible when the Aggregate Mode
is turned on.

Average Fixation Average duration (in milliseconds) of all fixations in the trial

Duration group. This is calculated by summing up the duration of all

fixations in the trial group divided by the total number of
fixations in the group. This property will only be visible when
the Aggregate Mode is turned on.

Average Pupil Size Average pupil size (in arbitrary units) across all non-blink
samples in the trial group. This property will only be visible
when the Aggregate Mode is turned on.

Average Saccade Average size (in degrees of visual angle) of all saccades in the
Amplitude trial group. This is calculated by summing up the amplitude of
all saccades in the trial group divided by the total number of
saccades in the group. This property will only be visible when
the Aggregate Mode is turned on.

4.1.1.2.1 Deleting a Group of Trials

To remove a group of trials from the analysis, select the grouping node, click the right
mouse button and select the “Remove from Viewing Session” menu item. If trials
contained within a grouping node are deleted from the session, they will be permanently
removed from the tree view (the EDF file will have to be reloaded before information on
that file can be accessed again as there is no undo option in Data Viewer).

4.1.1.2.2 Color Coding Different Participants

Version 2.3 of Data Viewer allows users to apply different colors to code the data from
different participants. After importing the EDF file, go to the property table of the trial-

grouping node ([:Eri ). First toggle on the "Apply Coloring to Visible Events" box and then
choose a customized color. The selected color will be applied to all events contained
within the current selection (group, subject, or trial) that have the visibility toggled on.
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4.1.1.3 Trial

Data Viewer parses trials using the settings in the “Data Loading” preferences. By
default, the start of a Data Viewer trial will be based on the message (“TRIALID”)
defined in the "Trial Load Start Value" preference (in "Data Loading" preferences). If
that message is missing, the start of the trial will be the recording start time (i.e., the
"START" line in the EDF file which marks the beginning of a block of recorded
samples/events). Similarly, the end of a trial will be based on the "Trial Load End Value"
setting — the default message is “TRIAL _RESULT”. If that message is missing or not
supplied, the end of the trial will be the recording end (i.e., the END line, which marks
the end of a block of data) or the next start message, whichever comes first. If a user did a
long continuous recording, shorter trial segments can be created based on the pair of
splitting messages mentioned above. Trial splitting can also be done using a pair of
INPUT values — see the options in the Data Loading Preferences.

For performance optimization, Data Viewer dynamically manages its use of computer

memory by loading and unloading trials in a viewing session. Filled icons (I-:rl ) indicate a

loaded trial whereas open icons (-EJ) indicate an unloaded trial. Information on
participants’ performance in individual trials can be retrieved by clicking on the trial
node of the tree view — the trial will be loaded upon the click if previously unloaded.
Once a trial is selected for analysis, the middle panel of the Data Tab lists all of the
visible events and messages in the trial and the bottom panel provides a general summary
of performance in that trial. The following table lists the trial-level analysis variables.
Those fields that are editable in the viewer are marked with an asterisk.

Field Contents

Label * Label of the trial.

Index Trial sequence.

Recording File File name of the recording.

Recording Start Time

Timestamp when the trial recording started (in milliseconds
since EyeLink tracker was activated).

Recording End Time

Timestamp when the trial recording ended (in milliseconds
since EyeLink tracker was activated).

Recording Duration

Duration (in milliseconds) of the trial recording.

Sampling Rate 250, 500, 1000, or 2000 Hz, depending on the version of the
eye tracker and setting used during data collection.
Interest Period Label Label of the currently selected interest period.

Interest Period Start

Start time of interest period (in milliseconds relative to the
trial recording start time).

Interest Period End

End time of interest period (in milliseconds relative to the trial
recording start time).

Interest Period Start
Matched

Whether an event that matches the start of the selected interest
period has been found in the current trial.
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Interest Period End
Matched

Whether an event that matches the end of the selected interest
period has been found in the current trial.

Reaction Time

Configurable response time determined by the Reaction Time
Definition associated with the trial. Use the value of Duration
1f RT is undefined.

RT Event Index

Index of event that triggered the end of the reaction time; -1
when NO_MATCH. The index is relative to a specific event
type; for example an index of 5 for a Saccadic RT means the
5" saccade in the trial.

RT Event Type

The way in which the trial reaction time is ended, possible
values are TIMEOUT, BUTTON, INPUT, FIXATION,
SACCADE, MESSAGE, or NO MATCH.

RT Definition Label

Label of the reaction time definition (see section 6.3.1
Managing Reaction Time Definitions). “.” if undefined;
“CUSTOM” if the RT definition is a custom one (see Section
7.4 Reaction Time Definitions).

Apply Coloring to
Visible Events *

Data Viewer provides default drawing colors for events in the
Trial View Window for all trials/participants. Users can
change the color of the currently visible (visibility toggled on)
events through this property so that a distinct color can be
applied to all events in a trial or in all trials of a trial group (or
participant). Please make sure the "Apply Coloring to Events"
box is checked before choosing the intended color.

Color *

If the "Apply Coloring to Events" box is checked, users can
customize the colors of currently-visible (visibility toggled
on) events in the Trial View Window so that the selected
color can be applied to all events in a trial or in all trials of a
trial group (or participant).

Number Samples

Total number of samples in the trial recording.

Number Fixations

Total number of fixations in the trial recording.

Number Saccades

Total number of saccades in the trial recording.

Number Blinks

Total number of blinks in the trial recording.

Number Button Presses

Total number of button presses in the trial recording.

Number Messages

Total number of messages in the trial recording.

Number Input Events

Number of input events that occur during that trial.

Average Fixation

Average duration (in milliseconds) of all fixations in the trial.

duration
Average Saccadic Average size (in degrees of visual angle) of the saccades in
Amplitude the trial.

Exclude from Reports *

When checked, the trials involved will NOT be included in
any output reports.

Interest Area Set *

Setting of the interest areas (“Custom Interest Area Set” or
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“Empty Interest Area Set”). If interest areas have been
defined, they can be removed by selecting “Empty Interest
Area Set”.

Number of [As Total number of unique interest areas in the trial. This
variable is only visible if the trial contains interest areas.

Run Count Total number of fixation runs in the trial (two consecutive
fixations in the same interest area belong to the same run).
This variable is only visible if the trial contains interest areas.

Visited [As Reports total number of unique interest areas visited in the

trial. This variable is only visible if the trial contains interest
areas.

X Resolution,
Y Resolution

X/Y gaze resolution of the trial (in screen pixels per degree of
visual angle).

Recorded Display Width | Horizontal resolution of the eye tracker recording (in screen
pixels).

Recorded Display Vertical resolution of the eye tracker recording (in screen

Height pixels).

Recorded Display Left The X coordinate (in screen pixels) for the top-left corner of
the recording.

Recorded Display Top The Y coordinate (in screen pixels) for the top-left corner of
the recording.

Mode This specifies the eye-tracking mode (Pupil-only vs. Pupil
with CR).

Pupil Data Type This specifies the type of pupil size data (AREA or
DIAMETER) recorded in the trial.

Eyes Left, Right, or Binocular.

Event Parse Type This reports whether eye events (fixations and saccades) were
recorded in GAZE or HREF coordinates.

File Filtering Level Filtering level (OFF, STD, or EXTRA) applied to the data
saved in the EDF file.

Pupil Tracking This reports the pupil fitting processing type (i.e., ELLIPSE or

Algorithm CENTROID).

Thresholds This reports the pupil and CR thresholds of the tracked eye(s)

at the beginning of the recording.

4.1.1.3.1 Hiding a Trial

To hide a trial from the output reports
1) Click the trial to hide in the top panel of the data tab.
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2) In the bottom panel of the data tab (which contains properties for the trial), find
the entry “Exclude from Reports” and change the current setting so that the option
is checked (default is unchecked).

4.1.1.3.2 Deleting a Trial

To delete a trial from the Data Viewer, simply place the mouse over that trial node, click
the right mouse button and select Remove from Viewing Session. The trial is
permanently removed from the data viewing session and all other trial indexes are
updated accordingly.

4.1.1.4 Interest Area Templates

An interest area template is an .IAS file that contains a set of interest areas. If the same
interest areas are used for several trials, instead of repeating the procedure of creating
interest areas for each individual trial, an interest area template can be loaded to supply
segmentation information for those trials efficiently. The property panel lists the
following summary statistics for an interest area template. Those fields that are editable
in the viewer are marked with an asterisk.

Field Contents

Name * Label of the custom interest arca set.

IA Count Total number of interest areas defined in the trial.

IsCustom Whether the current set of interest areas is user-defined (true)

or an interest area template (false).

Image Name Mapping If the "Auto Select IAS for Trial" property in the
“Output/Analysis” preference settings is true, the value in this
field will be used to associate the IAS to trials automatically.
This functionality is obsolete — users are suggested to make
use of trial grouping feature instead (see section 6.1.3).

Please note that if an interest area template is deleted from a viewing session, interest
areas for all those trials that use that template will be removed as well.

4.1.1.5 Custom Interest Area Set/Empty Interest Area Set

For each trial, the tree view also shows whether or not a custom interest area set has been
defined for the trial. If there is no interest area set, the node Lo will be “Empty Interest
Area Set”. The property panel lists the same elements as the interest area templates,
except that the [sCustom field is “true” for the custom interest area set. When the
Aggregate Mode is enabled, summary statistics for the interest area across all trials in the
trial group are provided (see section 5.9.2).

EyeLink Data Viewer ©2002-2017 SR Research Ltd. 23




4.1.2 Preferences Tab

The preferences tab (Figure 4-2, right panel) provides access to all the elements of the
Data Viewer that can be configured by users. These include everything from the default
colors used for displaying events, to the elements of an EDF file to load. These elements
are broken down into the following categories: General Preferences, Data Loading
Preferences, Output/Analysis Preferences, Data Filters Preferences, Data Views
Preferences (with sub-categories of Spatial Overlay View Settings, Temporal Graph
View Settings, and Animation Playback Settings).

4.2 Trial View Window

The Trial View window displays the data of a selected trial in Spatial Overlay Mode,
Temporal Graph Mode, or Animation Playback Mode. Selecting a trial in the Data
Inspector tree view shows the trial’s data in the Trial View Window. When Aggregate
Mode (¥¥) is enabled, data from the entire trial group to which the current trial belongs
will be displayed in the Trial View Window (Spatial Overlay and Animation Playback
modes only). Users can have several Trial View Windows open at one time by right
clicking on a trial in the Inspector Window and selecting “New Window” in the context
menu.

4.2.1 Selecting Data Elements to Display

At anytime event visibility can be toggled on/off within the Trial View Window. For

example the @ button in the Application Desktop toggles the visibility of Fixation
Events.

@ Toggle Fixation Event Visibility
A Toggle Saccade Event Visibility
e Toggle Blink Event Visibility
&, Toggle Eye Sample Visibility
Toggle Message Event Visibility
@ Toggle Button Event Visibility
o Toggle Input Event Visibility
Toggle Interest Area Visibility
3 Enter/Exit Aggregate Mode

4.2.2 Cloning a Trial View

From the menu, choose:
Window — Clone View.
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This allows, for example, both the Temporal Graph and Spatial Overlay Views to be
shown at the same time on the desktop. You can tile the windows together. Note that
event selection in one view will automatically cause the same events to be selected in the
other view.

4.2.3 Tiling/Cascading Windows

To arrange all open Trial View Windows, from the menu, select:
Window — Tile

or
Window — Cascade

Figure 4-3 shows an example of tiling three open Trial View (Spatial Overlay, Temporal
Graph, and Animation Playback Modes) windows.
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4.3 Spatial Overlay Trial View

The Spatial Overlay view (see Figure 4-4) is selected by pressing the ¥& button in the
Trial View window. This view lets you look at events and samples by placing them
where they were detected in space. If the image that was presented during the trial is
available, it can be placed in the overlay view as the backdrop for eye event drawing.
The background image can be toggled on or off by clicking on the “Toggle Background
Image” button () in the Trial View Window toolbar. The background image for a trial
can be manually changed with the “Change the Overlay Image” button (@) — please note
that this will delete the existing image integration messages and the operation cannot be
reversed. When you replace the background image, please check the “Fit Overlay Image
Change to Display” setting in the Data Views->Overlay preference. If that setting is true,
the image is scaled to fit the display dimensions for the trial. If false, the image size is
not altered and the image is centered on the trial overlay view.

When the Aggregate Mode is enabled, all of the data in the current trial group (i.e., data
from multiple participants) will be displayed in the same Trial View Window for efficient
comparison. Users may apply different colors to code the data from different participants
(see section 4.1.1.2.2; see Figure 4-5). Please note that the titlebar of the Trial View
Window indicates whether data from a single-trial or aggregate data from the trial group
is displayed in the Trial View Window.
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Figure 4-5. Sample Spatial Overlay Trial View from Multiple Participants

Version 2.4 of Data Viewer software supports zooming in or out of the Spatial Overlay
View. This can be done in two possible ways.

1) Press down the left mouse button and drag the mouse in the Spatial Overlay
View until the selection box covers the entire area to be zoomed. Now click the
“Zoom Selected/Reset” button (Qs) in the toolbar.

2) Zooming in and out can be done with the mouse's scroll wheel while pressing
down the Shift key (scrolling up to zoom in the view and scrolling down to
zoom out the view). To adjust the position of the zoomed area in the view, press
down the Shift key and then drag the mouse to the intended position.

To restore the default view, simply click the “Zoom Selected/Reset” button in the toolbar
of the Trial View Window or press the Esc key.

The following buttons are available from the Spatial Overlay View:

e View Trial Data in 2D Temporal Graph Mode: Selects Temporal Graph
View.
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View Trial Play Back Animation: Selects Animation Playback mode.

Save Trial View as Image: Creates an image of the Spatial Overlay View.

Import Area of Interest File: Loads an interest area set file and sets the
interest areas for this trial. Any existing interest areas are deleted from the
trial. After loading, the Interest Area Set for the trial is set to “Custom
Interest Area Set”.

i) Save the Interest Area Set to Disk: Saves the trials interest area set to a file.

A Auto Segment Image into Interest Areas: Creates interest areas
automatically for the trial image.

Display Overlay View in Actual Recording Resolution. Toggles between

displaying eye data and graphics at the recorded resolution and at a custom
sized resolution. If enabled, overlay is not scaled to size of Trial View
Window and is instead set to actual size (One pixel of overlay corresponds to
one pixel of trial display).

) Change the Overlay Image: Selects the image to use as the background of
the overlay. Any existing background graphics are deleted.
@ Create and Use Fixation Heat Map: This creates a heat map for the data in

the current Trial View Window (single-trial data in the non-Aggregate Mode
or trial-group data in the Aggregate Mode). Clicking on the button again
toggles off the heat map drawing. Since Data Viewer uses the saved heat
map for visualization, please make sure you supply a unique file name for the
heat map created for the trial or trial group.

@ Need to Update Heat Map: Data used to generate the current fixation map
may no longer be valid (e.g., trials are removed from the current trial group,
fixations are deleted, merged, or moved, a different interest period applied,
Aggregated Mode is turned on or off, trials are regrouped). Users are advised
to re-create the fixation map.

0

Zoom Selected/Reset: Click this button to zoom in the Spatial Overlay View
after selecting the intended area to zoom. Press this button again or press the
Esc key to restore the default view.

IZ Toggle Background Image: This button can be used to toggle on/off the
background image in the Spatial Overlay View.
@) Keyboard Shortcuts: This supplies a list of keyboard shortcuts used in the

Spatial Overlay View.

4.4 Temporal Graph Trial View

The Temporal Graph View (see Figure 4-6) allows users to view trial data as a trace plot,
where the X axis represents time and the Y axis represents the X / Y gaze location (in
screen pixels), pupil size (in arbitrary unit), acceleration (in degrees/second?), and
velocity data (in degrees/second). To be consistent with the data presentation in the
Spatial Overlay View and Temporal Graph View, version 3.1 or higher of Data Viewer
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displays only events and samples from the currently selected interest period (which is
marked by two colored vertical lines that correspond to the start and end events of the
interest period). Sample traces outside the interest period are grayed out. The Temporal
Graph View is zoomed in to fit the selected interest period by default.

To view trial data in the Temporal Graph View mode, select the I button in the top left
corner of the Trial View Window.
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Figure 4-6. Sample Temporal Graph Trial View

4.4.1 Viewing Sample and Target Data

Temporal Graph view will show trace plots only if the EDF file contains samples and if

sample are activated for viewing (i.e., the “Toggle Eye Sample Visibility” button & on
the Data Viewer tool bar is selected). The position, velocity, and acceleration sample
traces can be selected for viewing from buttons within the Trial View Window.
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A View Trial Data Spatially with Image Overlay: Select Spatial Overlay
View.

View Trial Play Back Animation: Select Animation Playback View.

Save Trial View as Image: Creates an image of the Temporal Graph View.

Zoom In Graph View: Click the button and then drag the mouse to select
the area of the graph view to zoom.

Zoom Out Graph: Zooms out the graph view by a factor of 2.

Add/Edit Event Mode: Enters a mode that allows users to create and edit
eye events in the Temporal Graph View.

© HL SE

Sample Info: Pops a floating window that shows the data of the current
sample (index, time, eye, horizontal/vertical eye
position/velocity/acceleration).

D)

Keyboard Shortcuts: This supplies a list of keyboard shortcuts used in the
Temporal Graph View.

¢

Position Trace: Shows the gaze or target position.

Velocity Trace: Shows the gaze or target velocity data.

Acceleration Trace: Shows the gaze or target acceleration data.

X Sample Trace: Toggles X trace visibility.

Y Sample Trace: Toggles Y trace visibility.

® < x| <|[H

Pupil Sample Trace: Toggles Pupil trace visibility.

To show the eye or target traces, users need to select the type of data (position, velocity,
or acceleration) and data source (X, y, pupil of left eye and/or right eye, x, y of targetl
and/or target2) to be shown. To show the position, velocity, and acceleration traces of
target(s) in this view, messages on the current position of the target(s) must be recorded
in the EDF file. These messages should contain a target position keyword

(“TARGET _POS” by default and can be configured in the “Target Position String” of
Data Loading preference settings), followed by parameters of the individual targets. See
Section 7.3.6 for details of how to configure these messages.

Version 3.1 of Data Viewer introduces a sample cursor line in the Temporal Graph View.
The sample cursor line is a vertical dashed line that moves along with the mouse cursor,
with a pointer (circle) drawn at the intersection point of the line and each of the active
data traces. The cursor line can also be shifted by the left or right cursor key for the ease
of stepping through individual samples. The visibility and color of the cursor line can be
configured through the Temporal Graph View preferences.

Another addition to the Temporal Graph View in version 3.1 is a “Sample Info” window.

Clicking on the Sample Info button (.@) in the toolbar of the Trial View Window pops
up a floating window that displays the information of the current sample, which includes
index and time of the sample, the selected eye and currently visible data traces (e.g., pupil
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size, horizontal/vertical eye position/velocity and acceleration). The Sample Info window
gets updated when a new sample is selected (e.g., by moving the mouse inside the Trial
View Window or by pressing the left/right cursor key). Clicking the "Sample info" button
automatically enables the "Toggle Eye Sample Visibility" button in the Data Viewer
application toolbar as well as the X/Y position and pupil trace buttons of the recorded
eye(s) in the Trial View Window toolbar, if those buttons haven't been toggled on yet.

The scale in which the vertical data is displayed can be changed by clicking the right
mouse button when the mouse cursor is placed on the Y-axis and choose one of the
following options: Ascending (small values on the Y-axis appear on the top of the
screen), Descending (large values on the Y-axis appear at the top of the screen), or Split
(0 appear in the middle of the screen, positive values on the top and negative values at the
bottom).

The X, Y, and Pupil traces can be highlighted. Press the 'x' key to highlight the X trace,
press the 'y' key to highlight the Y trace, and press the 'p' key to highlight the Pupil trace.
If pressing one of these keys does not highlight the intended sample traces, please make
sure that the Trial View Window is currently in focus (double clicking anywhere the
sample traces are plotted to set the keyboard focus to the Trial View Window).

Various aspects of the Temporal Graph View can be configured in the preference settings
(Preferences -> Data Views -> Temporal Graph). For example, users may change the
colors of the sample traces, cursor line, grid line, and interest period boundary lines, the
scaling factor for plotting the acceleration, velocity, and pupil size data, total number of
initially visible samples in the Temporal Graph View window, etc.

4.4.2 Zooming Operations

The Temporal Graph View can be zoomed in and out. To zoom into an area of the
Temporal Graph:

1) Hold the Shift key down or press the ® putton.

2) Position the mouse on the Temporal Graph the upper left hand corner of the area
you wish to zoom into.

3) Press the mouse button and drag the mouse to the lower right corner of the area
you wish to zoom into.

4) Release the mouse button.
5) Release the Shift key.

The graph will be magnified so that the area you selected fills the Trial View Window.

To zoom across only the X axis (leaving the full range of the Y axis visible):
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1) Hold down both the Shift and Ctrl keys (Shift and Command 38 in Mac), or click
the ® button and then hold down Ctrl (Command 3 in Mac)

2) Position the mouse on the Temporal Graph at the left edge of the area you wish to
zoom into.

3) Press the mouse button and drag the mouse to the right edge of the area you wish
to zoom into.

4) Release the mouse button.

5) Release the key(s).

To zoom out the graph, press the = button. The Temporal Graph View will be zoomed
out by a factor of 2.

4.4.3 Add/Edit Event Mode

Version 3.1 of Data Viewer allows users to create new eye events or edit event time in
the “Add/Edit Event” mode (%) of the Temporal Graph View. A new fixation event can
be created by dragging the mouse inside an existing saccade event (if the latter itself
doesn’t contain a blink event) and a new saccade event can be created by dragging the
mouse inside a fixation event. Data Viewer automatically computes the summary
statistics (e.g., duration, position, velocity) of the newly created event based on the eye
samples included in the event.
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Figure 4-7. Creating a New Saccade in the Add/Edit Event Mode

The following steps illustrate how to create a new saccade within an existing fixation
event. A fixation can be created within an existing saccade event in a similar fashion.

1)

2)

3)

4)

S)

6)

7)

On the Application toolbar of the software, enable the “Toggle Fixation Event
Visibility”, “Toggle Saccade Event Visibility”, and “Toggle Eye Sample
Visibility” buttons.

In the Trial View Window toolbar, make sure the “Position Trace” button and
the “Left/Right Eye X/Y Sample Trace” buttons are enabled. Since the event
parsing decision will likely be based on the velocity and/or acceleration data, it
will be useful to enable the velocity and acceleration trace buttons (and use the
“Split Y™ option for the vertical scale so that the velocity and acceleration traces
are displayed in the center of the screen). Users may also toggle on the “Sample
Info” button so that the current sample time, X/Y position, and
velocity/acceleration data are displayed in a floating window and updated along
with the mouse movement.

Users may also zoom in the part of the Temporal Graph View where the new
event should be should be created (see section 4.4.2 for instructions on zooming
in the view).

Now click the “Add/Edit Event Mode” button in the Trial View Window
toolbar. A warning dialog box will be displayed when the mode is entered for
the first time. Note that the % icon is displayed below the current mouse cursor
position when the viewing session is in the add/edit event mode.

Place the cursor line on top of the first sample inside the fixation event that
marks the beginning of the new saccade event — users may use the sample
information displayed in the “Sample Info” floating window. Click the left
mouse button and start dragging the mouse. This will leave a dotted sample line
at the start sample; a new dotted cursor line follows the mouse to indicate the
current sample.

Pay attention to the sample information displayed in the “Sample Info”” window
while dragging the mouse. Release the mouse at the intended end sample. A new
event will be now created. If the time of the end sample exceeds the end time of
the original event, the end time of the new event will be adjusted to be within the
original event.

Toggle off the “Add/Edit Event Mode" button when you finish creating/editing
event. The mode will be toggled off automatically when you move away from
the Temporal Graph View to other modes.

After creating a new event, users may need to perform further adjustments (in case for
example a wrong start or end sample was used). To adjust the start or end sample of a
fixation or saccade event, please follow the steps below:

1) Make sure the “Add/Edit Event Mode” button is toggled on.
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2) Select the event to be adjusted in the Temporal Graph View. Note the borders of
the event are bolded upon selection.

3) Hold down the Alt key. When you approach the left/right border of the selected
event, the mouse cursor will change (F*). Hold down the left mouse button and
drag the selected border to the intended position. If keyboard shortcuts are
preferred, use Alt + Left /Right to modify the end time the selected event, and Alt
+ Shift + Left/Right to modify the start time of the selected event.

4) Toggle off the “Add/Edit Event Mode" button when you finish creating/editing
events.

Note: Users can also edit the start time and end time of an event in the property table in
any of the viewing modes.

4.5 Animation Playback View

The Animation View (see Figure 4-7) is selected by pressing the & button in the Trial
View Window. This view plays back the gaze position (superimposed on the background
image or video clip that the participant was looking at while the data was being
recorded), with a concurrent time code displaying the time from the start of trial
recording. When the Aggregated Mode is enabled, gaze positions from several
trials/participants are displayed simultaneously over time creating a "beeswarm"
playback. Users may color code the participants for easy comparison (see section
4.1.1.2.2). If the “Use Average Aggregate Cursor” option in the Animation View
preferences (through “Preferences -> Data Views -> Animation”) is enabled, a
unified/averaged gaze cursor will be displayed during the playback instead.

In addition to the current gaze cursor, Data Viewer allows users to display a gaze history
trail in the Animation View; the default gaze cursor history duration is 300 milliseconds.
Both settings can be changed in the Animation View Preferences. Version 2.4 of the
software supports dynamic heat map presentation in the Animation View (see section
6.2.2 “Dynamic Heat Map”). This can be done by enabling the “Aggregate Mode” (3’033)
and then toggling on the “Enable Dynamic Heat Map in Aggregate Mode” button (@)

Several controls are available for the animation view. Users can start, stop, or pause the

playback by clicking the appropriate button. The speed of playback can also be adjusted
(users can modify the speed value and then press the “Enter” key to register the change).
A trackbar displays the progress of the playback relative to the currently selected interest
period and lets users select a position to start playback.

e View Trial Data in 2D Temporal Graph Mode: Selects the Temporal
Graph View.

A View Trial Spatially with Image Overlay: Selects the Spatial Overlay
View.
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32

Save Trial View as Image: Creates an image of the Animation Playback
View.

&

Import Area of Interest File: Loads an interest area set file and sets the
interest areas for this trial. Any existing interest areas are deleted from
the trial. After loading, the Interest Area Set for the trial is set to
“Custom Interest Area Set”.

e Save the Interest Area Set to Disk: Saves the trials interest area set to a
file.
= Save Trial to Video File: Saves the playback of the trial into a movie

file.

2

Enable Dynamic Heat Map in Aggregate Mode: Click this button to
show the dynamic heat map in the Animation View. This option is only
available when the Aggregate View is enabled.

D)

Keyboard Shortcuts: This supplies a list of keyboard shortcuts used in
the Animation Playback View.

Playback Trial: Starts playing back the trial data. Spacebar is the
shortcut key for play/pause when the Trial View Windows has focus.

SR

Stop Trial Playback: Stops the playback and resets the time code and
gaze cursors. The Esc key is the keyboard shortcut for stopping playback
when the Trial View Windows has focus.

Pause Trial Playback: Pauses the playback. Spacebar is the shortcut
key for play/pause when the Trial View Windows has focus.

4|

Backward Step: Each click on this button steps backwards the playback
by 33 milliseconds. The keyboard shortcut is Shift and Left cursor key
(make sure you click on the Trial View Window first). Pressing the Left
cursor key itself steps back the playback by one millisecond.

i

=

Forward Step: Each click on this button advances the playback by 33
milliseconds. The keyboard shortcut is Shift and Right cursor key (make
sure you click on the Trial View Window first). Pressing the Right cursor
key itself steps forward the playback by one millisecond.

Backward Frame: Each click on this button seeks to the previous
drawing message if available (so the seeking is locked to actual stimulus
drawing instead of by a fixed amount of time). In case of video clip
playback, this allows you to step backward one video frame. The
keyboard shortcut is Ctrl and Left cursor key on Windows and Command
and Left cursor key on Mac OS X (make sure you click on the Trial
View Window first). Pressing the Left cursor key by itself steps back the
playback by one millisecond.

Forward Frame: Clicking on this button seeks to the next drawing
command if available (so the seeking is locked to actual stimulus
drawing instead of by a fixed amount of time). In case of video clip
playback, each click on this button advances the playback by one video
frame. The keyboard shortcut is Ctrl and Right cursor key on Windows
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and Command and Right cursor key on Mac OS X (make sure you click
on the Trial View Window first). Pressing the Right cursor key by itself
steps forward the playback by one millisecond.
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Figure 4-8. Sample Animation Playback View

To save the playback of trial data into a movie file, click the "Save Trial to Video File"

button (@) on the Trial View Window toolbar. In the following "Movie Save Options"
dialog box, enter the movie file path/name, file type and compression method. Click
"Start" to begin saving the movie. Depending on the size of the recording file, this may
take a long time to finish. At any point, user can press "Esc" key to stop the saving
process.

Playing back video clips in the animation view is also supported if the EDF file is created
from an SR Research Experiment Builder recording. The video clip must be encoded in
XVID format and a computer with at least a P4 CPU is required for playback in Data
Viewer. The current frame number is displayed in the top-left corner of the video. If you
want to hide this frame number indicator, please go to "Preferences -> Data Views ->
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Animation" and uncheck the "Display Frame Number" option. Playing .XVD videos in
the Animation Playback View on Mac OS X is supported in version 2.4 or later of Data
Viewer.
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5 Working with Events, Samples, and Interest Areas

EyeLink Data Files (EDF files) contain two streams of data: eye position samples (up to
2000 per second, depending on the system model / sampling rate) and events (eye
movement events such as saccades and fixations, participant responses, and
synchronizing events from the experimental application). Both data streams are time-
synchronized for easy analysis. The file is organized into trials of data, one for each of
the tracker recording cycles. Each trial may have samples, events, or both.

Samples are time-stamped in milliseconds and contain monocular or binocular eye-
position data - Data Viewer currently only reports the eye position in screen coordinates
(GAZE) while other data formats (RAW or HREF) are ignored. Pupil size as area or
diameter is also recorded. Samples may also contain eye-movement resolution (used to
compute true velocity or saccadic amplitudes).

Eye movement events record eye position changes identified by the EyeLink tracker's on-
line parser, such as fixations, blinks, and saccades. Both the onset and end of these events
are marked, allowing samples to be assigned to eye-movement periods without complex
algorithms. Important data for analysis such as average position for fixations and peak
velocity for saccades is also recorded in the events. Other events record participant
responses (such as button presses) and synchronization and data messages from
applications. These can be used to record the time of a change in the display (such as
stimulus onset), or an experimental condition.

Events are generated by the EyeLink eye tracker (EyeLink I, EyeLink II, EyeLink 1000,
1000 Plus, Portable Duo, etc.) in real-time based on an internal heuristic saccade detector
(using a velocity and acceleration-based saccade detection method). A blink is defined as
a period of saccade-detector activity with the pupil data missing for three or more
samples in a sequence. A fixation event is defined as any period that is not a blink or
saccade. To detect a saccade, for each data sample, the parser computes instantaneous
velocity and acceleration and compares these to the velocity and acceleration thresholds.
If either is above threshold, a saccade signal is generated. The parser will check that the
saccade signal is on or off for a critical time before deciding that a saccade has begun or
ended. A detailed discussion on event parsing can be found in section "4. Data Files" of
the EyeLink II or EyeLink 1000/1000 Plus/Portable Duo User Manual.

In addition to providing a file-based and a trial-based summary of performance, Data
Viewer allows a detailed examination of event data such as fixations, saccades, blinks,
buttons, inputs, and messages, as well as sample data. Version 2.3 of Data Viewer adds
support for Aggregate Mode, which allows users to visualize event data from multiple
participants/trials and provides summary statistics for the entire trial group.
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5.1 Common Operations

Data Viewer allows users to perform various manipulations of events, such as selecting a
portion of data for further scrutiny, excluding or deleting a subset of events from analysis,
performing drift correction on fixations, merging neighboring fixations and saccades, etc.
Selecting, hiding, and deleting operations are common to all event types (fixations,
saccades, buttons, blinks, inputs, and messages) whereas merging and drift correction is
available to fixation and saccade events only. The common operations are discussed in
this section whereas the unique operations pertaining to certain types of events are
documented in the relevant event section.

5.1.1 Selecting Events

To select an event (fixation, saccade, blink, button, input, or message), place the mouse
cursor over the event either in the Spatial Overlay/Temporal Graph View or in the event
list of the Inspector Window and click the left mouse button. When in the Animation
Playback View, clicking on an event in the event list will set the playback position of the
trial to the time (message, button, input event) or start time (fixation, blink, saccade) of
the event.

To select more than one event, hold down the Ctrl key in Windows or the command key
in OS X and select the target event, until all desired events are selected. If all events in a
trial are to be selected, simply click the Select All Visible ltems button (R} on the main
toolbar (please note that this is not the “Select Mode” button R in the toolbar of the Trial
View Window) or click the right mouse button and select “Select All”.

To select a group of events within a square region of the Trial View Window, place the
mouse cursor at the top-left corner of the region. Click and hold down the left mouse
button, drag the mouse cursor to the bottom-right corner of the square region, and then
release the left mouse button.

Tip: Holding the Ctrl or command key while selecting an event leaves previously
selected events selected. If the Ctrl or command key is not pressed, previously selected
events are unselected.

5.1.2 Deleting Events

Select the events and click the Delete Selected Items button T on the toolbar (or click
the right mouse button and select “delete”). If an event is deleted, it will be permanently
removed from the Temporal Graph View, Spatial Overlay View, as well as the output

reports, and cannot be “undeleted” (there is no “undo” operation). In addition, deleting a
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fixation or saccade event will have an impact on other temporally contiguous events. For
example, deleting a fixation will merge the saccades on either side of the fixation into one
saccade. Similarly, deleting one saccade will merge the fixations on either side of the
saccade into a longer one.

5.2 Fixations

To examine the fixation information in the data file, first make sure that the fixation

events are visible. This is done by selecting the Toggle Fixation Event Visibility button

@ in the application toolbar.
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Figure 5-1.Sample Spatial Overlay View of Fixation Events

Fixations can been seen and selected if the Trial View Window (Figure 5-1, right panel)
is showing either a Spatial Overlay View or a Temporal Graph View. In the former view,
fixations are represented as a hollow circle located on the trial image at the average gaze
X, y coordinates for the samples contained within the fixation, with fixation duration
displayed near the top-left corner of the circle. In the Temporal Graph View, fixations
are represented as a filled block. All fixation events in a selected trial are listed
sequentially in the middle panel of the Inspector Window. Properties of a selected
fixation are shown in the bottom panel of the Inspector Window. Each field of the
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fixation event property is described in the following table. Those fields that are editable
are marked with an asterisk.

When Aggregate Mode is enabled in the viewing session, fixations from the current trial
will be displayed together with fixations from other trials in the trial group. Color coding
can be applied (by enabling the “Apply Coloring to Visible Events” option in the trial
node or the trial group node and choosing the intended color) to assist in the
identification of the source of the fixations. While all of the visible fixations can be
selected, only those fixations belonging to the current active trial can be modified
(deleted, moved, drift corrected, or merged).

Field Contents

Label * Label of the fixation.

Eye The eye to which the current fixation event is associated.

Start Time Trial time ' when the fixation starts. Please note that if an
interest period is applied, the duration, start time, and end
time of the fixations that overlap with the start or end of the
interest period will be adjusted accordingly.

End Time Trial time ' when the fixation ends.

Duration Duration (in milliseconds) of the fixation. The fixation

duration may be adjusted if the fixation spans the start or end
of an interest period and the "Trim Spanned Fixation Time"
option is enabled in the Data Filter preferences.

Avg. X Position *,
Avg. Y Position *

Average X, Y of the gaze location.

Angle

Angle between the horizontal plane and the line connecting
the current fixation and the previous/next fixation”.

Distance Distance (in degrees of visual angle) between the current
fixation and the previous/next fixation.

Direction Direction (“LEFT”, “RIGHT”, “UP”, or “DOWN”) 3 relative
to the current fixation in which the previous/next fixation is
located.

RT End Event * Whether the current fixation is the reaction time end event
(see section 6.3.1 for reaction time definition).

Hidden Whether the current fixation is hidden from viewing and
output analysis.

Manually Adjusted Whether the fixation has been shifted manually.

Trimmed Whether the fixation’s start or end time has been trimmed by
the interest period.

Color * To achieve better visibility, the color of the currently selected
fixation can be changed by clicking on the color toolbox.

Trial: Label of the trial to which the current fixation belongs.
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Note ! : System time refers to the timestamp (in milliseconds) since the EyeLink tracker
was activated whereas the trial time refers to the time since the trial started. The
default trial start time is the start of the trial recording (i.e., “START” message).
If reaction-time definitions are applied, the trial-start time is reset at the start event
of the RT definition (e.g., “SYNCTIME” message). A negative trial time means
that the event or message occurred before the trial start time.

Note > : The calculation of the angle between the previous/next fixation and the current
fixation is directional, with the arrow pointing towards the previous/next fixation
(see Figure 5-2 for an illustration of angle calculation).

Previous/Next
Fization® 90°

180° ‘-\ 0°

Current Fization

()

-90°
Figure 5-2. Diagram for Angle Calculation

Note *: The direction of the previous/next fixation relative to the current fixation is
determined as “LEFT” if the angle is greater than 135° or less than -135°, “UP” if
the angle is between 45° and 135°, “RIGHT” if the angle is between -45° and 45°,
and “DOWN” if the angle is between -135° and -45°.

5.2.1 Selecting Fixations

In addition to the common method of event selection by mouse, a group of temporally
contiguous fixations may also be selected by using a combination of the Shift key and the
up or down cursor keys. Select the first fixation by mouse in the event list of the
Inspector Window and hold down the Shift key. Press the down cursor key to select the
next fixation, until all target fixations are selected. Use the up cursor key to unselect the
recently selected fixations or go to fixations before the first selection.

5.2.2 Merging Fixations

In some cases, two or more temporally contiguous fixations can be merged and
represented as a “larger” fixation. To merge fixations, select the fixations and click the
Merge Selected Items button [5 on the toolbar (or click the right mouse button and
select “merge”). Data Viewer version 3.1 and higher takes the duration of each original
fixation into consideration (i.e., duration-weighted) when calculating the position of the
newly created fixation. Users can revert to the old calculation method (i.e., using a simple
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average of the original fixation positions) by turning off the “Apply Time Weighted
Merge” option in the Data Filters preferences.

Note: Only two or more temporally contiguous fixations can be merged. Merging two
neighboring fixations will remove the intermediate saccade that connects between them.
The parameters of the saccades before and after the merged fixations will also be adjusted
accordingly. Fixation merging cannot be performed if there is a blink between the
selected fixations (unless the “Adjust Saccades with Fixations” in the “Data Views”
preferences is turned off).

5.2.3 Drift Correcting Fixations

Sometimes, a drift in the gaze position may occur due to poor system setup, headband
slippage, or excessive head/body movement. Normally, the eye tracker operator would
notice this problem and perform a recalibration or drift correction. If, however, the issue
was not addressed during recording, it may be possible to manually adjust the fixation
events so that some degree of data analysis can still be performed. Please note that
performing a drift correction will only affect event data, including fixation location and
associated saccade beginning/end points. The sample data will be unaffected by the drift
corrections performed in Data Viewer.

5.2.3.1 Drift-correcting a Group of Selected Fixations
To perform drift correction:
1) Select the fixations to be drift corrected
2) Hold the Alt key down
3) Click anywhere on the Trial View Window so that it receives the input focus
4) Move the selected fixations with the cursor keys to the desired locations
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Figure 5-3. Drift Correcting Fixations on One Line of Text.

Tip: In cases where several fixations on one single line (such as in reading research) are
to be drift-corrected, another method is to select all of the desired fixations, then right-
click in the Trial View Window and select “Drift Correct”) to align them to their average
Y position (see Figure 5-3). Alternatively, select all of the desired fixations, then press
Ctrl+D on Windows (or Command D on Mac OS X). This operation will fail if one or
more fixations deviate more than 30 pixels in the Y dimension from the mean of the
group of fixations to be drift-corrected in a batch (for example when fixations from
different lines are selected). The tolerable deviation threshold is set to 30 as a default and
can be modified in the Data Views section of the preference settings, as can whether the
X or Y dimension is used for alignment.

5.2.3.2 Precise Drift Correction of a Single Fixation

To carry out more precise drift correction of one fixation,
1) Select the fixation to be drift corrected
2) In the property panel of the Inspector Window, select the entry for “Avg. X
Position” and type in the desired X position
3) Select the entry for “Avg. Y Position” and enter the desired Y position
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Note: Drift correcting one fixation or a group of fixations changes the properties of some
relevant events, such as the start/end point of a preceding or following saccade and its
amplitude.

Tip: Before moving the fixations, it is desirable to turn off the interest area set by
pressing Toggle Interest Area Visibility button L2 in the application desktop toolbar.
Otherwise, the interest area(s) within which the fixations appear will also be moved
along.

5.2.3.3 Cleaning Fixations

For some studies, researchers may want to clean up fixations based on certain rules. Data
Viewer provides two options for fixation cleaning.

1) Fixation Filter preferences

Users can filter out small fixations with the "Merge Nearby Fixations", "Fixation
Merging Amplitude Threshold", and "Fixation Duration Threshold" settings of the Data
Filters preferences. If the "Merge Nearby Fixations" option is checked, a fixation with a
duration shorter than the value set in the "Fixation Duration Threshold" will be merged
with a neighboring fixation, if the latter is within the distance set by the "Fixation
Merging Amplitude Threshold".

2) Four-stage Fixation Cleaning

(Please Note: this option is intended for use only by reading researchers who want to
follow a cleaning procedure that is established in their field. It is not intended, nor is it
necessary for other users to clean their data using this function.)

For some reading studies, users may want to apply a more refined fixation cleaning
algorithm. To apply a cleaning in Data Viewer, select the intended Trial node or
Recording session node, then right-click and select the “Perform 4-stage Fixation
Cleaning” option. A log file will be created in the “Output” folder of the current viewing
session.

EyeLink Data Viewer ©2002-2017 SR Research Ltd. 46



iii)

Perform 4-stage Fixation Cleaning x|

v Stage 1 |v Stage 2 |v Stage 3

Duration Threshold [so 40 [140
Distance Threshold |0. 5 | 1.25
[v Stage 4

Minimum Duration Il-‘!O
Maximum Duration |800

[ Delete Fixations Outside Interest Areas

Start I Cancel

Figure 5-4. Options for Fixation Cleaning.

STAGE 1. Within each interest area (typically a word in reading studies), Data
Viewer checks whether each fixation's duration is shorter or equal to the Stage 1
Duration Threshold. For those short fixations, the software further checks the
duration and distance of the fixations immediately before and after the current
fixation. The fixation will be merged to one of its neighboring fixations if the
neighbour’s duration is longer than the threshold value and its distance along the
x-axis (in degrees) from the current fixation is shorter or equal to the Stage 1
Distance Threshold. If both the previous and next fixations meet the above
criteria, the current fixation will be merged to the longer of the two. Uncheck the
“Stage 1” box to skip this stage.

STAGE 2. This stage is similar to STAGE 1 except that different fixation
Duration and Distance Threshold values are used. For this stage to be effective, a
shorter duration and a larger distance threshold should be used compared to Stage
1. Uncheck the “Stage 2” box to skip this stage.

STAGE 3. Data Viewer searches for interest areas that include at least three
fixations shorter than the Stage 3 Duration Threshold value and no fixations
longer than the Duration Threshold. In such cases the shorter fixations are merged
into a single fixation. Uncheck the "Stage 3" box to skip this stage.

STAGE 4. Data Viewer deletes every fixation shorter than or equal to the Stage 4
Minimum Duration threshold, or longer than or equal to the Stage 4 Maximum
Duration threshold. Uncheck the "Stage 4" box to skip this stage.

If the "Delete Fixations Outside Interest Areas" box is checked, this will remove
all fixations falling outside of any interest area. Important: If no interest area is
defined, checking this option will result in all fixations being removed!
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5.2.4 Creating a New Fixation Event

Version 3.1 of Data Viewer allows users to create a new fixation event by dragging the
mouse inside an existing saccade event (if the latter doesn’t contain a blink). Please see
section 4.4.3 “Add/Edit Event Mode” for details on how to create a new event in the
Temporal Graph View. For the newly-created fixation event, Data Viewer automatically
computes the event statistics such as duration, average X/Y eye positions and pupil size
based on the eye samples included in the event. Properties of the neighboring events are
also updated following the creation of the new fixation event.

5.3 Saccades
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Figure 5-5. Sample Spatial Overlay View of Saccade Events

Saccade events (see Figure 5-5) can be toggled on/off in both the Spatial Overlay and
Temporal Graph Views by clicking the Toggle Saccade Event Visibility button Z A
saccade is represented as an arrow in the Spatial Overlay View (pointing towards the
endpoint) and as a colored solid line in the Temporal Graph View. The following table
lists the properties of a saccade event. Those fields that are editable in the viewer are
marked with an asterisk.

| Field

‘ Contents
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Label *

Label of the saccade.

Eye The eye to which the current saccade event is associated.

Start Time Trial time (in milliseconds relative to the start of the current
trial) when the saccade starts.

End Time Trial time (in milliseconds relative to the start of the current
trial) when the saccade ends.

Duration Duration (in milliseconds) of the saccade.

Start X *, Start Y *

X, Y coordinates of the start position.

End X *, End Y *

X, Y coordinates of the end position.

Amplitude Size (in degrees of visual angle) of the saccade.

Peak Velocity, The average and peak values of gaze velocity in degrees of

Average Velocity visual angle per second. The peak velocity calculation
depends on whether the samples are loaded in the viewing
session.

RT End Event * Whether the current saccade is the reaction time end event
(see section 6.3.1 for reaction time definition).

Hidden Whether the current saccade is hidden from viewing and
output analysis.

Manually Adjusted Whether the saccade has been adjusted manually.

Color* To achieve better visibility, the color of the currently selected
saccade can be changed by clicking on the color toolbox.

Trial: Label of the trial to which the current saccade belongs.

When Aggregate Mode is enabled, saccades across all of the trials in the trial group will
be drawn in the Spatial Overlay View. For ease of identifying the source of the saccades,
users can apply color coding (by enabling the “Apply Coloring to Visible Events” option
in the trial node or the Recording session node and choosing the intended color). While

all of the saccades can be selected, only those saccades from the current active trial can
be modified.

5.3.1 Merging Saccades

Sometimes, a large saccade is followed by a small corrective saccade or vice versa. In
certain circumstances users may wish to merge two or more such temporally contiguous
saccades. This can be done by selecting the saccades and clicking the Merge Selected
ltems button 5> on the toolbar (or clicking the right mouse button and selecting
“Merge”). Once the saccades are merged, information on the ordinal sequence for the
current and subsequent saccades is updated and the fixation between the two merged
saccades is deleted.
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Note: Only two or more temporally contiguous saccades can be merged. If saccades are
selected that are not all temporally contiguous, only the neighboring saccades will be
merged.

5.3.2 Adjusting Saccade Position

The start and end position of a saccade event can be adjusted through the property table
of the event,

1) Select the saccade to be adjusted

2) In the property panel of the Inspector Window, select the entry for “Start X,
“Start Y”, “End X, or “End Y” and enter the new value.

Note: Adjusting the start/end position of the saccade may also modify the average
positions of the neighboring fixations. This default behavior can be changed by
unchecking the “Adjust Fixations with Saccades” option in the Data Views preferences.

5.3.3 Creating a New Saccade Event

Version 3.1 of Data Viewer allows users to create new eye events in the “Add/Edit
Event” mode (%) of the Temporal Graph View. A new saccade event can be created by
dragging the mouse inside an existing fixation event — please see section 4.4.3 “Add/Edit
Event Mode” for details on how to create a new event in the Temporal Graph View. For
the newly-created saccade event, Data Viewer automatically computes the event statistics
such as duration, start/end eye positions, average/peak velocity, and amplitude based on
the eye samples included in the saccade event. Properties of the neighboring events are
also updated following the creation of the new event.

5.4 Blink Events

In an EyeLink recording file, a blink event brackets parts of the eye-position data where
the pupil size is very small, or the pupil in the camera image is missing or severely
distorted by eyelid occlusion. Data Viewer reports a blink as part of a saccade event and
therefore events in the Event List of the Inspector Window appear in a sequence like
Fixation -> Saccade -> Blink -> Fixation. It is important to maintain this event sequence
in order to achieve sensible report statistics.

Blink events can be toggled on/off by clicking the Toggle Blink Event Visibility button
% Blinks are represented as a colored solid line in both the Spatial Overlay View and
the Temporal Graph View. Each field of the blink event properties is listed in the
following table. Those fields that are editable in the viewer are marked with an asterisk.

Field Contents
Label * Label of the blink.
Eye The eye to which the current blink event is associated.
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Start Time Trial time (in milliseconds relative to the start of the current
trial) when the blink starts.

End Time Trial time (in milliseconds relative to the start of the current
trial) when the blink ends.

Duration Duration of the blink.

Hidden Whether the current blink is hidden from viewing.

Color * To achieve better visibility, the color of the currently selected

blink can be changed by clicking on the color toolbox.
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Figure 5-6. Sample Temporal Graph View of Blink Events

5.5 Messages

Messages, including messages for built-in EyeLink commands, can be placed in the EDF
file to mark the start and end of a trial or important events such as display changes.
Message events can be toggled on/off by clicking the Toggle Message Event Visibility
button = in the application desktop toolbar. A message is represented as a colored
triangle at the top of the Temporal Graph View and a colored square in the Spatial
Overlay View, centered on the gaze position at the time of the message. Each field of the
message event property is listed in the following table. Those fields that are editable in
the viewer are marked with an asterisk.
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Field

Contents

Label *

Label of the message.

Time

Trial time (in milliseconds relative to the start of the current
trial) when the message was presented. Note that if the
message is presented before the trial starts, a negative time
value will be displayed.

Command

If the message is a command message, this lists the actual
command used. The commands include simple drawing, built
in audio messages, interest area commands, etc. The display
commands and audio commands are not shown in the
message list unless the “Include Display Command
Messages” and “Include Display Command Messages”
settings in the Data Filters preferences have been enabled.

Text

Message text.

X, Y

Concurrent gaze coordinates when the message is recorded (-
100 if no gaze information is available for the time of the
message event).

RT End Event *

Whether the current message is the reaction time end event
(see section 6.3.1 for reaction time definition).

Hidden

Whether the current message is hidden from viewing.

Color *

To achieve better visibility, the color of the currently selected
message can be changed by clicking on the color toolbox.
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Figure 5-7. Sample Temporal Graph View of Message Events.

When Aggregate Mode is enabled, messages across all of the trials in the trial group will
be drawn in the Spatial Overlay View. For ease of identifying the source of the messages,
users can apply color coding (by enabling the “Apply Coloring to Visible Events” option
in the trial node or the Recording session node and choosing the intended color). While
all of the messages can be selected, only those messages from the current active trial can
be modified.

5.5.1 Inserting a New Message

New messages can be added to the Data Viewing session by clicking the right mouse
button and choosing the “Add New Message” option. In the following dialog box (see
Figure 5-8), fill in the intended text in the “Message” field and the value of the time
(either a value relative to the start of the trial or the start of the currently selected interest
period, or an absolute EDF file time). The default value for the latter is set to the current
playback position in the Animation View, the current cursor line position in the Temporal
Graph View, and 0 in the Spatial Overlay View.
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Figure 5-8. Inserting a New Message in a Data Viewing Session

5.5.2 Import Message List

Experiments should place certain messages into the EDF file to enable Data Viewer to
process the files more efficiently. Examples of these commands include defining the
image to overlay, specifying trial variables, defining a start time of RT definition, etc.
These messages will be time-stamped with an accuracy of 1 millisecond from the time
sent, and can be used to mark important events such as display changes. If users forgot to
write these messages when the experiment was created, these messages can still be
imported from a text file.

The loaded message list file must be a plain tab-delimited text file. Each line must be a
valid EyeLink MSG line in the format of:

MSG  EDF time [Offset] Message text
or:
MSG  -Trial Index [Offset] Message text

where:

+ The EDF time/Trial Index value must be an integer. The sign of this field
determines whether it will be treated as EDF_time or Trial Index. If the value is
positive, it is treated as EDF_time, the absolute EDF timestamp to be used for the
message. For example, a value of 62798072 for the EDF _time field will place the
message into the trial that includes the time 62798072. If the value is negative, it
is treated as the Trial Index, and the message will be assigned to the trial with
that index value. For instance, a Trial Index value of -1 would mean the first trial
in the file, and -4 would mean the 4th trial. If no offset value is included after the
Trial Index, the message EDF time will be set to the start of the currently-applied
interest period. (If the default Full Trial Period is currently applied, the message
will be set to the start time of the trial.)

« "Offset" is optional, and must be an integer if specified. If a positive EDF_time is
used, the Offset is subtracted from EDF _time to generate the real message time.
For example, a message line of "MSG 2435806 -14 |V APLAYSTART 0 1
waves/1.wav" suggests that the event the message was referring to
(APLAYSTART) actual happened at time 2435820 (as 2435806 - (-14) =
2435820). If a negative Trial Index value is specified instead, the Offset is used
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to specify the time relative to the currently-selected interest period (or to the start
of the trial if the default Full Trial Period is selected). As with EDF_time, Offset
values used with Trial Index will be subtracted from the start time of the
currently selected interest period. A negative Offset value thus specifies a time
after the start of the currently selected interest period, and a positive value
specifies a time before the start of the interest period.

+ "Message text" can be any string up to 100 characters in size that starts with a
non-numeric character.

» Lines that do not follow these rules are ignored.

For example,

MSG 2435806 -14 !V APLAYSTART 0 1 waves/l.wav
MSG 2436376 -14 !V APLAYSTOP 12578 1 waves/l.wav
MSG 62798072 0 POSN 174 384

MSG 62798072 0 POSN 185 384

MSG -1 1500 VERB_ONSET

MSG -2 1800 VERB_ONSET

To load the message list file:
1) Select the EDF file label in the tree view panel of the Inspector Window.
2) Click the right mouse button and select “Import Message List”.
3) In the following “Open” dialog box, go to the directory where the message list file
is stored and choose the file.
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Figure 5-9. Import Message List File
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After the message list file is imported into the session, a dialog box will be presented to
show the number of valid messages imported.

5.6 Button Events

If an optional, supported button box is attached directly to the Host PC, participants’
responses can be recorded to the EDF file for accurate synchronization with the eye
movement data. Each button press or release is reported as a button event in Data Viewer
to reflect a change in the state of the button box. Button events can be toggled on/off by
clicking the Toggle Button Event Visibility button © . A button event is represented as
a colored triangle in the Temporal Graph View and a colored square in the Spatial
Overlay View, centered on the current gaze position. The following table lists the
properties of a button event. Those fields that are editable in the viewer are marked with
an asterisk.

e\ EyeLink Data Viewer Version 2.4.0 - ~Untitled.evs (C:\Users\EyeLink\AppData\Local\Temp\~ELDV7134487142831143264. =101 x|
File Edit Analysis Window Help
|ole|o|olal@|el <|sEmEEa]s 8 | 2|elo|2|Bfe w|fH |Fammmw =] |||
L inpector ( 5l oix
© 0| f e e Bl@| B )@ v]a|wex|viwex|xjo] b
=] %Jn::jxetdlevs o 1979 3958 5937 7916 9395 11874 13853 15832 17811 19790 21769 2
=] . J-v 1 1 1 1 | 1 1 1 1 1 1 _
text: Trial: 2
text: Trial: 3
B text: Trial: 4 101—
. Interest Area Templates
202—
@ text: T1: Button: -31ms
@ text: T1: Button: 395 ms 303—
=) 5
404—
505—
606—
Field Value 707—
Label: Button: 23719 ms
[Time: 23584 ms
[Button: 5 S
State: Pressed
X: 753.1
v: 703.9 Glis
RT End Event: v
Hidden: false i)
iew Trial Data in 2D Temporal Graph Mode 0.00,155.00
—_—
Figure 5-10. Sample Temporal Graph View Showing the Button Events .
Field Contents
Label * Label of the button event.
Time Trial time (in milliseconds relative to the start of the current
trial) when the button was pressed/released. Note that if the
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button event occurs before the trial starts, a negative time

value will be displayed.

Button Button ID.

State Button pressed or released.

X, Y Concurrent gaze coordinates when the button is
pressed/released (-100 if no gaze information was available
for the time of the button event).

RT End Event * Whether the current button event is the reaction time end
event (see section 6.3.1 for reaction time definition).

Hidden Whether the current button event is hidden from viewing and
output report.

Color * To achieve better visibility, the color of the currently selected

button event can be changed by clicking on the color toolbox.

5.7 Input Events

EyeLink host software can monitor the status of the input port data lines on the host PC
(e.g., the digital input port of the supported analog card, the status/data register of the
parallel port on the host PC with proper configurations) and record the input data to the
EDF file. Any changes in state of the input port data lines, if recorded to the EDF file,
will be reported as an INPUT event in Data Viewer. Input events can be toggled on/off
by clicking the Toggle Input Event Visibility button & An input event is represented
as a colored triangle in the Temporal Graph View and a colored square in the Spatial
Overlay View, centered on the current gaze position. The following table lists the
properties of an input event. Those fields that are editable in the viewer are marked with

an asterisk.
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Figure 5-11. Sample Temporal Graph View Showing the Input Events.

Field Contents

Label * Label of the input event.

Time Trial time (in milliseconds relative to the start of the current
trial) when the input event was received. Note that if the input
is received before the trial starts, a negative trial time value
will be displayed.

Code The value of the input event received (it should be a number
between 0 and 255).

X, Y The X, Y coordinate of the eye position when the input event
is recorded (NaN if no gaze information is available at the
time of the input event).

RT End Event * Whether the current input event is the reaction time end event
(see section 6.3.1. for reaction time definition).

Hidden Whether the current input event is hidden from viewing and
output report.

Color * To achieve better visibility, the color of the currently selected

input event can be changed by clicking on the color toolbox.
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5.8 Samples

Samples can be toggled on/off by clicking the Toggle Eye Sample Visibility button &=
in the desktop toolbar. In the Spatial Overlay View (Figure 5-12, left panel), the samples
are overlaid on the trial image, forming the sample path of the viewing process. Please
note that when the Aggregate Mode button is enabled, unlike all other events, only
samples corresponding to the current active trial are displayed in the Trial View Window.
In the Temporal Graph View (Figure 5-12, right panel), the Xy coordinates of the samples

as well as the concurrent pupil size are plotted as a function of trial time.
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the wide-dool veraneda thatrararoufrd itsTour side

1014

}ﬁeanal Data Spatially with Image Overlay 0:00,448.00 few Trial Data in 2D Temporal Graph Mode 62.00,15.00

Figure 5-12. Sample Spatial Overlay View (left) and Temporal Graph View (right) of
Raw Sample Data

Note: Version 2.1 of Data Viewer loads the samples into the viewing session by default.
If you are using an old version of Data Viewer or default settings from old viewing
sessions, please check the Load Samples property in the Data Loading preference
settings. If you want this change to be persistent over future viewing sessions, you may
consider saving this as a default setting. This can be done by selecting any preference tree
node, clicking the right mouse button and selecting "Save Properties as Defaults" (see
Preference Settings).

Tip: In the Spatial Overlay View, if samples are visible at the same time as events, when
an event is selected, all samples contained within that event are also selected.

5.9 Interest Areas
To work on interest areas in a viewing session, make sure the main Toggle Interest Area

Visibility button o7 in the application toolbar is turned on. To access interest area data
for individual trials, first expand the trial by clicking on the */ node next to it in the tree
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view panel of the Inspector Window, then click the Toggle interest area visibility button
for that trial (see Figure 5-13). The node will be labeled "Custom Interest Area Set" if
custom interest areas are loaded or created or "Empty Interest Area Set" if no interest
areas are defined. The middle panel of the Inspector Window lists all of the available
interest areas for the currently selected trial. The lower panel shows the properties of the
selected interest area.

The following sections discuss the format and properties of interest areas, how to create
(manually, through image segmentation, mouse record, or template import), delete,
copy/paste, save interest areas, and how to modify interest areas (e.g., move, convert,
resize/rescale, flip, rotate, edit points, split, merge, link/unlink). Most of the operations
can be performed through the right-click context menu when an interest area is selected.
Version 3.1 of Data Viewer added an “IA Shape Actions” option to the right-click
context menu to support batch processing of interest area rotation, conversion, flipping,
resizing/rescaling or moving, when one or multiple interest areas are selected from the
Trial View Window, when an interest area set is selected from a trial node in the
treeview, or when a trial group is selected.
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Figure 5-13. Sample Text Display Overlaid with Interest Areas

5.9.1 Format of static and dynamic interest areas
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Versions 2.1 and above of Data Viewer allow both static and dynamic interest areas.
Static interest areas either have no time stamp (in which case they are present for the
entire duration of the trial or selected Interest Period) or a single time stamp which
indicates the time of their onset relative to the beginning of the trial. Dynamic interest
areas have two time stamps - the first indicating the time of their onset, and the second
indicating the time of their offset.

Thus, interest areas can be encoded in one of the following three formats:

Type 1 (no time stamp):

RECTANGLE <id> <left> <top> <right> <bottom> [label]
ELLIPSE <id> <left> <top> <right> <bottom> [label]
FREEHAND <id> <x1, y1> <x2, y2 > ... <xn, yn> [label]
e.g., RECTANGLE 1 0 0 512 384 images\hearts.jpg

Type 2: (one time stamp)

start_offset RECTANGLE <id> <left> <top> <right> <bottom> [label]
start_offset ELLIPSE <id> <left> <top> <right> <bottom> [label]
start_offset FREEHAND <id> <x1, yI> <x2, y2 > ... <xn, yn> [label]
e.g., -500 RECTANGLE 1 0 0 512 384 images\hearts.jpg

Type 3: (two time stamps)

start offset end offset RECTANGLE <id> <left> <top> <right> <bottom> [label]
start _offset end offset ELLIPSE <id> <left> <top> <right> <bottom> [label]
start_offset end offset FREEHAND <id> <x1, y1> <x2, y2 > ... <xn, yn> [label]
e.g., -500 -1500 RECTANGLE 1 0 0 512 384 images\hearts.jpg

The first two examples are static interest areas whereas the third example is a dynamic
interest area. The "start offset" and "end_offset" values are usually negative, indicating a
future time relative to the start of the currently selected interest period (the default Full
Trial Period will be used if no interest periods have been created for the viewing session).
For example, if the current interest period starts at 800 ms following the trial start, the
particular interest area of the Type 3 example above would start at 1300 ms and end at
2300 ms following the trial start. If the interest areas are read from a file that a message
in the EDF file specifies (e.g., the “!V IAREA FILE” message in the EDF file), the
“start_offset” and “end_offset” are relative to the time stamp of that message in the EDF
file.

As with other events in a viewing session (such as fixations and saccades), interest areas
are displayed in the event list. Static interest areas are represented by a dot and dynamic
ones are represented by a folder; there will be a separate folder for each of the dynamic
interest areas in a trial. Each dynamic interest area may contain several instances to
describe the position of the interest area across different time segments (a dynamic
interest area object must contain at least one instance). For example, a fixation screen
(with a “FIXATION_ SCREEN” message written to the EDF file) is shown for 1000 ms
before a target screen (with a “SYNCTIME” message) is presented with a red object
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appearing at (674, 546, 774, 646). The object moves to (462, 634, 562, 734) at time 800
ms after its onset, to (249, 546, 349, 646) at 1600 ms, and to (162, 334, 262, 434) at time
2400 ms and stays there for 800 ms before a blank screen is shown (with a

“BLANK_ SCREEN” message). A dynamic interest area of four instances can be coded

(shown below) to describe the behavior of the red object, assuming that an interest period

is created starting from the SYNCTIME message and this interest period is selected.

0 -799 RECTANGLE
-1599 RECTANGLE
-2399 RECTANGLE
-3199 RECTANGLE

-800
-1600
-2400

2
2
2
2

674 546 774 646 red
462 634 562 734 red
249 546 349 646 red
162 334 262 434 red

You will see the following four entries in the “2:red” folder of the event list, representing
four instances of the dynamic interest area (2:red). See section 5.9.24 for a summary of

the various methods available for creating dynamic interest areas in a viewing session.

2:red (0:799)
2:red (800:1599)

2:red (1600:2399)
2:red (2400:3199)
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Figure 5-14. Sample Interest Area Instances in One Interest Period

The start time and end time of the instances will be different if you then change the
interest period. For example, the start time and end times will look like the following if
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you create and select a new interest period starting from the “FIXATION SCREEN”
message time.

-1000 -1799 RECTANGLE2 674 546 774 646 red

-1800 -2599 RECTANGLE2 462 634 562 734 red

-2600 -3399 RECTANGLE2 249 546 349 646 red

-3400 -4199 RECTANGLE?2 162 334 262 434 red

You will see the following four entries in the “2:red” folder of the event list, representing
four instances of the dynamic interest area (2:red) under the new interest period.
2:red (1000:1799)

2:red (1800:2599)
2:red (2600:3399)
2:red (3400:4199)
22 Example_dont remove.ava= Eyelink Data Viewer M M )

File Edit Analysis Window Help

DEIEE <D O Ocet @ ater @ B R @@3@;@, © IIP_FIXATION vI

& Inspector (Memory Usage 3% ) | o
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2 RAOoPH
A
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= i‘ﬁ test
= O Trial: 1
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Interest Area Templates
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Color: _
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Dwell Time %: 0
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Figure 5-15. Sample Interest Area Instances in Another Interest Period

Clicking on the instance in the event list will highlight the interest area in the Spatial
Overlay View and vice versa. If the Trial View Window is set to the Animation Playback
View, clicking on the instance will set the playback time of the View to the start time of
the instance if the target interest area is not currently displayed.

5.9.2 Interest Area Properties
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The following table lists the properties of an interest area. Those fields that are editable in
the viewer are marked with an asterisk (*). When the Aggregate Mode is enabled,
additional statistics are provided for the interest area aggregated across all trials in the
trial group — those properties are marked with a #.

Property Property Description

Dynamic [A Whether the current interest area is a dynamic one (checked)
or a static one (unchecked). This field is not directly editable.
You can convert a static interest area into a dynamic one or
vice versa through the “Convert to DynlA/StaticlA” option in
the popup menu when you right click on the interest area.

Name * Text of the interest area.

ID Ordinal ID of the interest area.

Group Label Label of the group to which the current interest area belongs.

Type Type of interest area (rectangular, elliptical, or freehand).

Number of Instances

The total number of individual instances of the current
dynamic interest area. This is only applicable when the
dynamic interest area folder is selected, not individual

instances.

Interpolation

Checking this box makes all instances of the interest area
interpolate their position and shape across a time frame
starting at the start time of the current instance and ending at
the start time of the next instance. Basically, enabling this
option will make all instances of the interest area move to the
location of the next instance from the location of the current
instance (over the time frame determined by subtracting the
start time of the first instance from the start time of the next
instance). The “Allow Interpolation” property in the
Output/Analysis preferences should also be enabled to see the
effect.

X-coordinate of the left-most edge of a rectangular or
elliptical interest area.

Y-coordinate of the top-most edge of a rectangular or
elliptical interest area.

Right *

X-coordinate of the right-most edge of a rectangular or
elliptical interest area.

Bottom *

Y-coordinate of the bottom-most edge of a rectangular or
elliptical interest area.

Center *

Pixel coordinate (x, y) for the center of the interest area. This
is only applicable for Rectangle and Ellipse interest areas.

Bound's Center *

The center of the bounding rectangle for the freehand interest
area.

Selected Freechand Point
%

This field is usually empty and not editable. The coordinates
of the vertex will be displayed here only when the vertex of a
freehand interest area is selected for modification. To do this,
first select the freehand interest area, then hold the Alt key
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down while clicking the left mouse button on top of the
vertex. The coordinates of the vertex are then updated
constantly, and users can edit the coordinates by typing the
number in rather than using the mouse.

Angle Angle of the rotated interest area (or its instance) relative to
its original orientation.

Pixel Area Area of the interest area in pixels.

Color * To achieve better visibility, the color of the interest area or its
instances can be changed through a color selector.

Time EDF file time of the message specifying the interest area if it

was created using the ''V IAREA' command during recording.
If the interest area was created manually or from an interest
area template file during the viewing session, the time value
will be -1 and this attribute will not be visible from the
property table. This time stamp is useful in case you need to
filter interest areas based on the currently-selected interest
period (see “Show Interest Areas Pre Interest Period” and
“Show Interest Areas Post Interest Period” preferences in
“Preferences -> Data Filters”). This field is for static interest
areas only.

Start Time relative to IP
/ End Time relative to [P

The start time / end time (in milliseconds) of the dynamic
interest area or its instance relative to the start of the currently
selected interest period. This field is for dynamic interest
areas only. After instances of dynamic interest areas are
created in the viewing session or imported from an interest
area file, the start time and end time will be adjusted if a new
interest period is chosen.

Start Time relative to
Trial / End Time relative
to Trial

The start time / end time (in milliseconds) of the dynamic
interest area or its instance relative to the start of the trial.
This field is for dynamic interest areas only and its value
remains fixed regardless of the interest period that is currently
selected.

(Instance) Fixation
Count

Total number of fixations within the interest area (instance) in
the current interest period.

(Instance) Fixation %

Percentage of total fixations in a trial falling within the current
interest area (instance) in the current interest period.

(Instance) Dwell Time

Total time (in milliseconds) spent on the current interest area
(instance) in the current interest period.

(Instance) Dwell Time
%

Percentage of trial dwell time spent on the current interest
area (instance) in the current interest period.

(Instance) Run Count

Number of times the interest area (instance) was entered and
left in the current interest period.

Loaded Trial Count #

Total number of trials loaded into memory for aggregated data
analysis (if all trials are loaded, this should be total number of
trials in the trial group). This property is only visible if the
Aggregate Mode is turned on.
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Loaded Trial Indices #

A list containing indices of trials in the trial group that are
loaded into memory for aggregated data analysis. This
property is only visible if the Aggregate Mode is turned on.

Number of Trials Using
this IA #

Total number of trials in the current trial group that have an
interest area with this ID in the current interest period.

Average Fixation Count
#

Average number of fixations falling within the interest area in
the current interest period. This is calculated as the total
number of fixations into the interest areas with this ID,
divided by the number of trials using this interest area
(TRIALS _USING_THIS IA). This property is only visible if
the Aggregate Mode is turned on.

Average Fixation Count
% #

Percentage of total fixations in a trial falling in the current
interest area. This is calculated as the total number of
fixations into the interest areas with this ID, divided by the
total number of fixations in those trials using this interest area
(TRIALS _USING_THIS IA). This property is only visible if
the Aggregate Mode is turned on.

Average Dwell Time #

Total time (in milliseconds) spent in the current interest area
in the current interest period. This is calculated as the sum of
the duration of all fixations into the interest areas with this ID,
divided by the number of trials using this interest area
(TRIALS _USING_THIS IA). This property is only visible if
the Aggregate Mode is turned on.

Average Dwell time % #

Percentage of trial dwell time spent on the current interest
area. This is calculated as the sum of all fixation duration into
the interest areas with this ID, divided by the total fixation
dwell time of those trials using this interest area. This
property is only visible if the Aggregate Mode is turned on.

Average Run Count #

Average number of times the Interest Area was entered and
left (runs). This is calculated as the sum of run count from all
trials using this interest area, divided by the number of trials
using this interest area (TRIALS USING_THIS IA). This
property is only visible if the Aggregate Mode is turned on.

Percent of Trials Visited
#

This is calculated as the total number of trials with at least one
fixation on the interest area with this ID divided by the total
number of trials using this interest area

(TRIALS _USING_THIS IA). This property is only visible if
the Aggregate Mode is turned on.

Note: The coordinate information (Left, Top, Right, and Bottom) is applicable to
rectangular and elliptical interest areas only.

5.9.3 Manually Creating Interest Areas

To create an interest area:

1) Select the Trial View Window by clicking on or in it, so that the window is active.
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2)

Select the Interest Area shape that you want to create from the toolbar of the Trial
View Window:

Rectangular Interest Area Shape

Ellipse Interest Area Shape

Ko O

Freehand Interest Area Shape

For rectangle and ellipse interest areas:

3)
4)

o)
6)

7

Hold down the left mouse button in the top-left corner of where you want the
interest area to be created.

Drag the mouse down to the right until the selection region covers the area that you
want to select.

Release the mouse button.

In the “New Area of Interest Data” dialog box, fill out the “Label” field. If you are
creating a static interest area, leave the “Dynamic IA” box unchecked and press
Enter. For a dynamic interest area, you will need to further configure its properties -
please see the subsection below on configuring dynamic interest areas for details.
Repeat steps 3-6 to create more interest areas of the same type. Press the Select

Mode icon ( R ) from the toolbar of the Trial View Window to stop creating interest
areas.
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Figure 5-16. Creating a Freehand Interest Area

For Freehand interest area shapes:

3)
4)

o)
6)

7)

8)

Click the left mouse button on the first point of the shape you want to create.

Move the mouse to the second point and click the left mouse button again. A line
joining the points will be displayed.

Repeat step 4 for each point of the freehand shape.

Press the ENTER key when you have specified all points you wish to create. Data
Viewer will automatically join the first and last points of the interest area. Note that
you can cancel the creation of a freehand interest area by pressing the Esc key.

In the “New Area of Interest Data” dialog box, fill out the “Label” field. If you are
creating a static interest area, leave the “Dynamic IA” box unchecked and press
Enter. For a dynamic interest area, you will need to further configure its properties -
please see the following section for details.

Repeat steps 3-7 to create more interest areas of the same type. Press the Select

Mode icon ( R ) from the toolbar of the Trial View Window to stop the creation
process.

Note: Please avoid creating self-intersecting freehand interest areas, as this will cause
problems for the proper calculation of pixel area and determination of whether the gaze
position is within the interest area.
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Configuring Dynamic Interest Areas:

If the “Dynamic IA” checkbox is ticked additional properties will be shown in the New
Area of Interest Data dialog:

~e’\New Area of Interest Data ) x|

~ | |¥ DynamicIA

Label: ITarget

Start Time relative to IP:|2000 — _ End Time: |15000|
Start Time relative to Trial: |2129 End Time: |15129
Relate to:

None (Don't relate)

1: Target

2: Circle

[~ Perform Clean up

[~ Move animation to end of IA

Enter Cancel |

Y

2)

3)

4)

5)

Figure 5-17. Sample Interest Area Instances in another Interest Period

Start Time relative to IP: The start time (in milliseconds) of the current instance of
the interest area relative to the start of the currently selected interest period. It is
critical that an interest period has been created and selected before creating
a dynamic interest area. You can either type in the value in the edit box or click
the left indicator on the sliding bar and drag it to the intended position.

IP End Time: The end time (in milliseconds) of the current instance of the interest
area relative to the start of the interest period. You can either type in a value in the
edit box or click the right indicator on the sliding bar and drag it to the intended
position.

Start Time relative to Trial: The start time (in milliseconds) of the current instance
of the dynamic interest area relative to the start of the trial. This field is read-only
and changes along with the “Start Time relative to IP”.

Trial End Time: The end time (in milliseconds) of the current instance of the
dynamic interest area relative to the start of the trial. This field is read-only and
changes along with the “Trial End Time”.

“Relate to”: this specifies whether the current instance is a member of a new
interest area (“None (Don't relate)”) or a new instance of an existing dynamic
interest area. If the latter is the case, select the existing interest area from the list
below. The newly-created instance will be created in the folder of the selected
interest area in the event list.
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6) Perform Clean up: If this option is checked, Data Viewer will perform a Clean up
operation on the instances of the interest area (e.g., to trim instances with
overlapping times - see section “5.9.13 Cleaning Up Dynamic Interest Areas”
below).

7) Move animation to end of IA: If this option is checked, the playback time of the
Animation View will be set to 1 millisecond after the end point of the newly
created interest area instance.

5.9.4 Creating Interest Area: Image Segmentation

If a trial image has already been loaded, Data Viewer can create interest areas for the trial
by auto-segmentation. This is done by clicking the “Auto Segment Image to Interest

Area” button (ﬁﬂ) in the toolbar of the Spatial Overlay View window.

Note: If the trial already has existing interest areas, version 3.1 of Data Viewer prompts
users to choose “Replace” (remove all of the existing interest areas for the trial), “Add to”
(keep the existing interest area setup and create newer ones), or “Cancel” option when the
Auto Segment button is clicked. Please note that auto segmentation is more feasible for
those displays in which the individual items can be easily isolated, such as in reading and
visual search studies where a background of a single color is present, but not good for
some visual scenes in which the boundaries between individual elements are not clearly
defined (see Section 8.8 on preference settings for image segmentation).

5.9.5 Saving Interest Areas

Interest areas that have been created for any one trial can be saved into a template file and

re-used on other trials. To save interest areas:

1) Click the Save the Interest Area Set to Disk button () on the toolbar of the
Trial View Window.

2) In the Save dialog box, go to the directory where the interest area set should be
saved.

3) In the File name text box, type in the name of the file. Data Viewer will
automatically fill in the file extension (.ias).

4) Press the Save button. Note: if it is the first time you save an .ias file in the viewing
session, a prompt will appear asking if the .ias set should be saved as a template for
use in the current session.

In the saved interest area file, static interest areas will not have a time stamp. For
dynamic interest areas, the time stamps associated with each instance of the interest area
will be based on the currently selected interest period. So it is critical that the interest
period is set correctly before saving the template. Please note that the time stamps will
change if an incorrect interest period is selected when saving — this will mean that when
the template is applied to other trials (when the interest period is set properly) the
instances will not have the correct time stamps.
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Note: If there are non-ASCII characters in the labels of the interest areas, you need to
enable the “Use UTF8 Encoding” option in the “Output / Analysis” preferences to ensure
the labels saved properly.

5.9.6 Importing Interest Area File (for a specific trial)

Interest areas from a file can be imported and applied to a specific trial.
1) Click the Import Area of Interest File button () on the toolbar of the Trial View
Window
2) In the Open dialog box, browse to the location of the interest area file that you want
to import and select it.
3) Click Import.

The interest areas imported from the file will be added on top of the existing interest
areas in the trial. For dynamic interest areas, the start and end time will be mapped
relative to the currently selected interest period. If no interest period is created for the
session, the default “Full Trial Period” will be used.

5.9.7 Emptying an Interest Area Set

To empty the current interest area set for a trial:
1) Select the target trial in the tree view whose interest areas are to be emptied
2) In the property panel of the trial, find the entry “Interest Area Set” and choose
“Empty Interest Area Set”.

Existing interest areas in a recording session file or a group of trials can be similarly
cleared by setting the “Default Interest Area Set” entry of the property table to “Empty
Interest Area Set”.

5.9.8 Loading Interest Area Templates

If the same interest areas are used across a group of trials, instead of repeating the
procedure of creating interest areas for each individual trial, an interest area template can
be used to supply the interest area information to a group of trials. To import an interest
area template file into a viewing session:

1) From the application menu, choose:

File —> Import Data —> Interest Area Template
2) Inthe Load dialog box, browse to the location of the interest area (.ias) file(s) that
you want to import and select it/them.
3) Click Load.

The interest area template files imported will be listed in the “Interest Area Templates”
section, which is at the bottom of the tree view in the Inspector Window.
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Figure 5-18. Interest Area Templates Listed in the Tree View

5.9.9 Using Interest Area Templates

An interest area template, if already loaded into the viewing session, can be used to apply
the interest area data across a group of trials (see section 6.1.3 for information on the trial
grouping feature of Data Viewer). To apply an interest area template to a trial or group of
trials,
1) Click the viewing session icon (*+) and perform trial grouping if necessary.
2) In the tree view panel of the data tab, select the trial/group onto which the interest
area template should be applied.
3) In the property panel of the target trial or trial group, find the entry “Interest Area
Set” (“Default Interest Area Set” for a trial group) and select the intended interest
area template from the dropdown list.
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Important: When applying an interest area template to a trial or a group of trials, the
start time and end time of the dynamic interest areas that are applied to the trial/group of
trials will be set relative to the currently selected interest period. If no interest period is
created for the viewing session, the default “Full Trial Period” will be used. So it is very
important that a proper interest period be created and selected before applying interest
area templates containing dynamic interest areas to a trial or group of trials!

5.9.10 Deleting Interest Area Templates

Interest area templates can be deleted from the template list. In the tree view panel of the
Inspector Window, find the "Interest Area Templates" folder where all of the interest area
templates are located. Select the target interest area template from the list, click the right
mouse button, and select "Delete". If the deleted interest area template is used by a trial,
the "Interest Area Set" property of that trial will be set to "Empty Interest Area Set" and
existing interest areas will be removed.

5.9.11 Selecting Interest Areas

To select an interest area or an instance of a dynamic interest area, place the mouse
cursor over the interest area in the tree view window and click the left mouse button. The
interest area is highlighted in both the Trial View Window and the event list. To select
more than one interest area, hold down the Ctrl key on Windows or the Command key 38
on Mac OS X and select the target area by left-clicking - repeat until all of the desired
interest areas are selected. If all of the interest areas in a trial are to be selected, simply
click the Select All Visible ltems button (ii\_i) on the main application toolbar (or click
the right mouse button and select “Select All”).

Selection can also be made from the event list in the Inspector Window by clicking on the
“Custom Interest Area Set” node of the trial in the tree view and selecting the interest
areas from the event list panel. The selected interest area will be highlighted in the Trial
View Window. When an instance of a dynamic interest area is selected from the event
list, the playtime of the animation view will be set to the start time of that instance.

Note: If you are not able to select any interest area or instance, please make sure none of
the interest area shape buttons (L, O, or DQ) are active. You may press the Select Mode
icon ( R ) from the toolbar of the Trial View Window to stop creating interest areas.

If there are eye events within the interest area to be selected, clicking on the interest area
may end up selecting the eye events instead. To make a more precise interest area

selection, you may toggle off the visibility of the eye events first, make the interest area
selection, and then toggle the visibility of the eye events back on if desired.

5.9.12 Copying and Pasting Interest Areas
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A new interest area can be created by copying and then pasting an existing one. Select the
target interest area, click the right mouse button, choose the “Copy” option from the
popup menu, and then choose the “Paste” option. The new interest area will be centered
at the current mouse position if the “Paste to Current Mouse Position” option is enabled
in the Output/Analysis preferences; otherwise, it will be pasted around the original copy,
with or without an offset (according to the “Apply Offset to Pasted Items” setting).

The Copy-and-Paste procedure can be used to create a copy of an existing static interest
area, the entire dynamic interest area folder, or an instance of a dynamic interest area.

Additional “Paste Current” and “Paste After” options are available after copying an
instance of a dynamic interest area. The “Paste Current” option, applicable to the
animation view only, will create a new interest area instance with the start time being the
current playtime of the animation view. The duration of the new instance is the same as
the original instance. The “Paste After” option is available in both the animation view
and the Spatial Overlay View. This option will create a new interest area instance of the
same duration immediately following the end time of the original one.

5.9.13 Cleaning Up Dynamic Interest Areas

When creating dynamic interest areas, you may occasionally create instances of an
interest area that overlap in time. The overlapping interest area instances can pose a
problem for data analysis (e.g., when calculating dwell time on a dynamic interest area).
Data Viewer provides a clean up option so that you can fix any overlapping timing issues
for an interest area, a trial, a group of trials, or the entire viewing session. When cleaning
up two interest area instances with overlapping times, if the two instances start at the
same time, the more recently-created one will be preserved; otherwise, the overlapping
portion of the instance that starts earlier in time will be removed. For example, instance A
(start time a; and end time ay) starts before instance B (start time b; and end time by). The
cleanup process will preserve the original instance B while trimming the original instance
A so that only the portion from al to b;-1 remains.

Figure 5-19 Cleaning up Overlapping Dynamic Interest Area Instances

5.9.14 Mouse Record Mode

Mouse Record mode provides an easy interface to create new instances of dynamic
interest areas in the Trial Playback Animation view. This mode allows you to copy the
last instance of an interest area and insert new instances with a mouse click at the
intended playback time and position.
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1) Select an instance of a dynamic interest area either in the tree view or by clicking on
it in the Trial View Window.

2) Right-click in the Trial View window and select “Mouse Record” the popup menu
(see the screen capture below).

3) Now click the “View Trial Playback Animation” button in the toolbar of the Trial
View Window.

4) Set the Animation Playback View to the intended playback time, by using the slider
bar at the bottom of the Trial View window, using the Forward/Backward Step and
Forward/Backward Frame buttons or keyboard shortcuts, or by playing the video. If
playing the video, you may want to adjust the playback speed during mouse
recording to a lower value, particularly if you have fast moving stimuli. If the video
is playing, click the “Pause Trial Playback” button in the video playback progress bar
or press the Spacebar to pause the trial playback.

5) Then move the mouse into the Trial View Window (note that the mouse cursor
changes into a +), and click the left mouse button at the intended location to add a
new instance of the selected interest area with the same dimensions as the previous
instance. If the mouse button is held after clicking, the new interest area can be
dragged to the intended location and placed by releasing the mouse.

6) Click the Play button or press the Spacebar to resume video playing, or use the
Forward/Backward Step and Forward/Backward Frame navigation buttons to
navigate to the time of the next instance. Repeat steps 5-6 until all of the instances
are created.

7) End the Mouse record mode by clicking on the Select Mode icon ( R ) from the
toolbar of the Trial View Window, or by pressing the Esc key.

Note: Although Mouse Record mode can be used to create interest areas while the
animation is playing, it is best practice to set the exact time position by pausing the video
clip first, then to create the interest area(s) at that specific time point. To create interest
areas while the playback is in progress (e.g., for longer video clips), it is best to slow the
playback speed before playback; otherwise you may see large lags in the start time of the
interest areas (due to slow human reaction times!) and may have to adjust the start times
manually. By default, Mouse Record mode will enable the “Interpolation” property of a
dynamic interest area and its instances, so that Data Viewer will interpolate the position
and size/shape of the interest area between successive instances. In the Animation View,
interpolated interest areas are drawn in dashed lines. If using non-continuous dynamic
interest areas, it may be useful to disable the “Interpolation” property for the interest area
or the non-continuous instances.

In the Mouse Record mode, a mouse click will trim the end time of an existing instance
and start a new interest area instance at the current playback time. Version 3.1 of Data
Viewer added hotkeys that allow users to terminate a dynamic interest area in mouse
record mode to better support applications where instances of a dynamic interest areas are
not temporally continuous (e.g., the object is briefly occluded or goes off screen). A
mouse click while the Ctrl key (or the Command key on Mac OS X)) is pressed creates no
new instance of interest area but rather trims the end time of the first active instance to be
found to the current time. Pressing the Shift key in the mouse record mode creates a new
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instance of interest area without extending the end time of the previous instance to the
current time.
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Figure 5-20. Mouse Record Mode
5.9.15 Moving an Interest Area

Selected interest area(s) can be moved by following the steps below:

1) Select the interest area(s) (make sure the selection is highlighted in either the Spatial
Overlay or Temporal Graph View of the Trial View Window).

2) Hold down the Alt key (on Linux, hold down both the Alt and Windows key).

3) Place the mouse cursor on top of the interest area(s) and press and hold the left
mouse button. The mouse cursor now turns into a four-headed arrow %°.

4) Drag the interest area(s) to the intended location.

5) Release the mouse button.

The position of the selected interest area(s) can also be adjusted by pressing the left,
right, up, and down keys while holding down the Alt key. Users can also adjust the
location of an interest area by editing the “Center” value in the property table. The
position of Rectangular and Elliptical interest areas can be further adjusted by editing the
“Left”, “Top”, “Right”, and/or “Bottom” values.
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Version 3.1 of Data Viewer added an “IA Shape Actions -> Move” option on the right-
click context menu to move selected interest area(s) by a specified pixel value when one
or several interest areas are selected from the Trial View window, when the interest area
set is selected from the trial node of the treeview, or when a trial group is selected.

5.9.16 Flipping Interest Areas

To facilitate redrawing of interest areas for flipped images, Data Viewer allows users to
horizontally or vertically flip selected interest areas (rectangle, ellipse, or freechand) with
the “IA Shape Actions -> Flip Horizontal/Flip Vertical” option on the right-click context
menu. The flipping is performed based on the center of the screen - users may need to
move the interest areas to the intended locations after the flip. The interest area flipping
can be done when individual interest areas are selected, when the interest area set is
selected from the trial node of the tree view, or when a trial group is selected.

5.9.17 Conversion between Different Interest Area Shapes

Version 3.1 of Data Viewer added options to convert between different interest area types
(rectangle, ellipse, or freehand). Users can select an interest area and then choose the
intended interest area type provided in the “Type” field of the property panel.
Alternatively, users can select the interest area and choose the “IA Shape Actions ->
Convert to Freehand/Rectangle/Ellipse” option from the right-click context menu.

Note: The conversion from an ellipse to a freehand interest area is done by creating a
polygon of 12 equally-spaced points across the original shape. Conversion from a
freehand interest area to a rectangle or ellipse is based on the minimum bounding
rectangle.

5.9.18 Resizing Rectangular and Elliptical Interest Areas

A rectangular or elliptical interest area can be resized by following these steps:
1) Select the interest area (make sure the selection is highlighted in the Trial View
Window).
2) Hold down the Alt key (on Linux, hold down both the Alt and Windows key).
3) Place the mouse over the edge to be dragged (the arrow cursor changes into a sizing
cursor ).
4) Press the left mouse button and drag the edge to the desired location.
5) Release the mouse button.

To carry out a more precise adjustment for a rectangular or elliptical interest area:
1) Select the interest area to move or adjust.
2) In the property panel of the interest area, select the entry for “Left” and type in the
desired x-coordinate of left-most edge.
3) Select the entry for “Top” and type in the desired y-coordinate of top-most edge.
4) Select the entry for “Right” and type in the desired x-coordinate of right-most edge.
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5) Select the entry for “Bottom” and type in the desired y-coordinate of bottom-most
edge.

Please note that the coordinates must be made such that the “Left” value will be smaller
than the “Right” value and the “Top” value will be smaller than the “Bottom” value.

Version 3.1 of Data Viewer allowed batch resizing of selected interest area(s) through the
“IA Shape Actions” option on the right-click context menu. When the "Resize Edges"
option is selected, a dialog box will be displayed to allow users to specify the intended
pixel value of adjustment to Left, Right, Top, and Bottom edges — a positive value
expands the existing interest areas whereas a negative value shrinks the existing interest
areas. When “Resize by %’ option is selected, a dialog box will be displayed to allow
users to enter a resizing factor (100 is the original width/height) to expand/shrink the
selected interest areas.

5.9.19 Resizing Freehand Interest Areas

A freehand interest area can be resized by following these steps:
1) Select the interest area (make sure the selection is highlighted in the Trial View
Window).
2) Hold the Alt key down (on Linux, hold down both the Alt and Windows key).
3) Place the mouse over the vertex to be moved (the move cursor changes into a hand

cursor {b and a red circle is drawn on top of the vertex).
4) Press the left mouse button and drag the vertex to the desired location.
5) Release the mouse button.

Version 3.1 of Data Viewer allowed users to resize freehand interest areas through the
“IA Shape Actions -> Resize by %’ option on the right-click context menu. A dialog box
will be displayed to allow users to enter a resizing factor (100 is the original
width/height) to expand/shrink the selected interest areas.

5.9.20 Rescaling Interest Areas to a Different Screen Resolution

Data Viewer provided an option for users to rescale interest areas from one screen
resolution to another. This is useful for example if users had existing interest areas
prepared for one screen resolution and would like to re-use them for data collection at a
different screen resolution. To rescale interest areas, select the desired interest areas and
choose the “IA Shape Actions -> Rescale Screen Resolution” option on the right-click
context menu. In the following dialog box, specify the intended horizontal and vertical
scaling factors (100 is the original resolution).
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5.9.21 Rotating Interest Areas

When one or several rectangle, ellipse, or freehand interest areas are selected, the
following rotation operations can be performed using the right-click context menu option
“IA Shape Actions”: Rotate Left 90° and Rotate Right 90°. More rotation options are
provided when freehand interest areas are selected. A “Rotate by Angle®” option is
available for the left or right rotation by an angle value specified in the dialog box.

Version 3.1 of Data Viewer also implemented a fully interactive rotation of freehand
interest areas using computer mouse. To do that,

1) Select the freehand interest area in the Trial View Window
2) Press down the Ctrl and Alt keys (Command and Alt keys on Mac OS X)
3) Hover the mouse on top of any vertex of the freehand interest area. The shape of

the mouse cursor will change into <.

4) Now drag the mouse in the direction you want. The freehand interest area will
rotate around its bound’s center. The rotation angle relative to the original
position is displayed in both the property panel of the interest area and in the Trial
View Window (0 is the angle when the interest area was originally created).

5.9.22 Adding a Point to a Freehand Interest Area

To add a new point to a freehand interest area:

1)
2)
3)

4)
5)

Select the interest area (make sure the selection is highlighted in the Trial View
Window)

Hold the Alt key down (on Linux, hold down both the Alt and Windows key).

Place the mouse over the existing edge where a point will be added (the arrow cursor

changes into a hand cursor {b )
Press the left mouse button. A new vertex will be created.
Now move the newly added vertex to the intended location.

5.9.23 Deleting an Existing Point from a Freehand Interest Area
To remove an existing point from a freehand interest area:

1)

2)
3)

4)
5)

Select the interest area (make sure the selection is highlighted in the Trial View
Window)

Hold the Alt key down (on Linux, hold down both the Alt and Windows key).
Place the mouse over the vertex to be removed and click the left mouse button (the
arrow cursor changes into a hand cursor and a red circle is drawn on the vertex).
Click the right mouse button, and choose the “Delete” option from the popup menu.
When the delete confirmation dialog box is displayed (“Do you want to delete the
selected point from the Freehand Interest Area?”), choose “Yes”. Data Viewer will
automatically join the two points around the deleted one.

5.9.24 Deleting Interest Areas
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To delete interest areas or instances of an interest area:
1) First toggle off all of the eye event visibility buttons in the application toolbar so that
interest areas can be deleted without removing any eye events within them.
2) Select the interest areas or instances of an interest area to be deleted.
3) Press the right mouse button.
4) Select the Delete option from the popup menu.
5) Confirm that the IAs should be deleted.

Interest areas can also be deleted by clicking the Delete Selected Items button (@) or
the Cut Selected Items button (7<) on the application toolbar.

When you delete an instance from a dynamic interest area, Data Viewer will
automatically select the instance immediately prior to the deleted instance.

5.9.25 Splitting Interest Areas

Rectangular and elliptical interest areas can be split either horizontally or vertically. To
split an interest area:

1) Select the interest area to split.

2) Press the right mouse button.

3) Select “Split” and then “Horizontally” or “Vertically” from the popup menu.

When splitting an instance of a dynamic interest area, the duration of the instance is split
as well - one of the newly created instances takes the first half of the original duration
and the other takes the second half of the duration. If only the time of the interest area
instance should be split, simply select the “Time only” option from the popup menu.

5.9.26 Merging Interest Areas / Instances of a Dynamic Interest
Area

Two selected rectangular or elliptical interest areas can be merged in the following way:
1) Click "Toggle Fixation Event Visibility" button ((?) on the application toolbar to
turn off the fixation visibility so that fixation events will not be merged.
2) Press the Ctrl key on Windows or the Command key & on Mac OS X to select the
interest areas to be merged.
3) Click the right mouse button to bring up a popup menu, select "Merge" from the list.

Multiple instances of a dynamic interest area can also be merged. The start time of the
newly created instance will be the start of the earliest instance and the end time will be

end of the latest instance.

5.9.27 Linking/Unlinking Interest Areas

The above-mentioned “merge” operation creates a minimum bounding rectangle interest
area that encompasses the original interest areas. This may not be ideal for some
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applications as it may include regions that are not part of the original interest areas (e.g.,
Figure 5-21). Version 3.1 of Data Viewer provides a “link” option for freehand interest
areas that replaces the selected interest areas with a new one that contains their original
shapes linked to each other by a line via their closest points. This linking allows the
representation of multiple shapes in one interest area that aids in the combined analysis of
gaze data (e.g., calculation of the dwell time, fixation count, run count, regression-related
variables, etc. for spatially non-contiguous objects). Rectangle and ellipse interest areas
need to be converted into freehand interest areas before they can be linked. An “Unlink”
option is used to reverse the link process to restore the original interest area shapes. Note:
presently dynamic interest areas do not support the link/unlink operations.

The following figure illustrates the difference between the “merge” and “link” operations.
Panel A: Two original interest areas (note the fixation falling outside of the two [As).
Panel B: Rectangle interest areas are first converted into freehand ones and then linked
together — note the linked interest area includes the same number of fixations as in the
original interest areas. Panel C: A new interest area created by the merge operation — note
the larger area and more fixations included after the merge.

Panel A: Original Interest Areas

Panel B: Linking Panel C: Merging

Figure 5-21. Interest Area Linking versus Merging

5.9.28 Conversion between a Static Interest Area and a Dynamic
Interest Area

Unlike a static interest area, a dynamic interest area consists of one or multiple instances,
each of which has a start time and end time. Data Viewer supports the conversion
between these two types of interest areas: instances of a dynamic interest area can be
converted into static interest areas by removing the start time and end time whereas a
static interest area can be converted into a dynamic one, with the start time being 0 and
end time being the duration of the trial. The conversion process preserves the spatial
coordinate of the original interest area. The conversion can be done in the following way:
1) Select the interest area(s) to convert
2) Click the right mouse button and select “Convert to DynlA/StaticlA” from the pop-up
menu
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3) Modify the start time and end time as appropriate if converting to a dynamic interest
area

5.9.29 Examples of Creating Dynamic Interest Areas in a Viewing
Session

This section briefly summarizes various methods for creating dynamic interest areas
using the example given at the beginning of the Chapter. A fixation screen (with a
“FIXATION SCREEN” message written to the EDF file) is shown for 1000 ms before a
display screen (with a “SYNCTIME” message) is presented with a red object appearing
at (674, 546, 774, 646 (Left, Top, Right, Bottom)). The object moves to (462, 634, 562,
734) at time 800 ms after its onset, to (249, 546, 349, 646) at 1600 ms, and to (162, 334,
262, 434) at time 2400 ms and stays there for 800 ms before a blank screen is shown
(with a “BLANK_SCREEN” message). A dynamic interest area of four instances can be
coded (shown below) to describe the behavior of the red object, assuming that we create
an interest period starting from the onset of the SYNCTIME screen.

0 -799 RECTANGLE2 674 546 774 646 red
-800 -1599 RECTANGLE2 462 634 562 734 red
-1600 -2399 RECTANGLE2 249 546 349 646 red
-2400 -3199 RECTANGLE2 162 334 262 434 red

There are several possible ways to create the instances of this dynamic interest area.
Regardless of the method chosen, the first step would be creating an interest period and
selecting it as the active interest period.
1) Click the "Interest Period List" combo box at the far-right hand of the application
menu bar and select "Edit ...".

2) Click the New Interest Period button (D ) on the Interest Period Manager dialog box.

3) In the general tab, enter a label for the current interest period in the label edit box and
choose "Message Event" in the “End Event Type” drop-down list.

4) Now click the "Details" tab. Set the “Start Event” as Message and its “Start Time
Message Text” as "SYNCTIME" and "End Time Message Text" as
"BLANK SCREEN" (both message texts are case-sensitive without quotation
marks).

5) Close the Interest Period Editor dialog. The "Interest Period List" combo box should
now display the label of the newly created interest period.

Next, create the first instance of the interest area following the steps discussed in section
“5.9.3 Manually Creating Interest Areas”. In the property table of the interest area
instance, set the “Left” value to 674, “Top” to 546, “Right” to 774, “Bottom” to 646,
“Start Time relative to IP” to 0, and “End Time relative to IP” to 799. The subsequent
interest area instances can be created using one of the methods described below.

Method 1: Manual Creation in Animation View
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Set the Trial View Window to the Animation Playback View, as this view is useful for
displaying, creating, and editing of instances of a dynamic interest area. You may play
back the trial to the intended interest period time and manually draw each of the
subsequent instances (please note that the top-left corner of the animation view displays
both the current playback time relative to the currently selected interest period and to the
start time of the trial). The coordinates, start time and end time can be adjusted through
the property table of the instances.

Method 2: Copy and Paste

First copy the existing instance either from the event list in the Inspector Window or by
clicking on it in the overlay / animation view and then paste it. If needed, for the newly
created instance, edit the “left”, “top”, “right”, “bottom”, “Start Time relative to IP”, and
“End Time relative to IP” fields in the property table of the instance (the position of the
interest area can also be adjusted by holding down the Alt key and then dragging it to the
intended position). Repeat this process until all of the instances are created.

Method 3: Copy and Paste Current

First copy the existing interest area instance. Set the Trial View Window to the animation
view and play back the trial to the intended interest period time (you may first drag the
indicator on the slider at the top of the Trial View Window, and then use the left/right
arrow key to get to the precise playback time). Now click the right mouse button and
choose the “Paste Current” option. A new instance with proper time stamps will be
created. You can adjust the position of the instance by holding down the Alt key and
dragging the instance to its intended location, or by editing the “left”, “top”, “right”,
“bottom” values in the property table of the instance. Repeat this process until all of the
instances are created.

Method 4: Mouse Record mode in Animation Playback View

First copy the existing interest area instance. Click the right mouse button and choose the
“Mouse Record” option. Set the Trial View Window to the Animation Playback View
and play back the trial to the intended interest period time (you may first drag the
indicator on the slider at the top of the Trial View Window, and then use the left/right
arrow key to get to the precise playback time). Now place the mouse cursor on top of the
intended location and click the left mouse button — a new instance will be created
following the mouse click. Repeat this process until all of the instances are created.

It may take some time for you to create the interest area instances for the very first
recording file. Once the interest areas are saved into an .ias file, you can import that .ias
file into the viewing session and use it as a template for subsequent similar trials across
recording sessions.

5.9.30 Output Reports and Preferences
Versions 2.1 and above of EyeLink Data Viewer support report creation for both static

and dynamic interest areas. However, dynamic interest areas introduce a number of
complexities to data analysis. For example, you may run into scenarios where a single
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fixation lands in multiple interest areas. Some Data Viewer variables (e.g., the
"CURRENT FIX INTEREST AREA INDEX" variable in the Fixation Report) require
a fixation to be assigned to a single interest area. If a fixation lands in multiple dynamic
interest areas, by default, this assignment will be based on the duration of fixation on
respective interest areas - the interest area with the longest duration gets the fixation
assignment. Occasionally, users may want to do the fixation assignment based on the
index of the interest areas. This can be configured through the preference setting
“Preferences -> Output/Analysis -> Assign Fixations to Dynamic IA Ordered by Relative
Duration". The default value is true, so to assign fixations by interest area index, uncheck
this option to set it to false.

Another related issue when a fixation lands in multiple interest areas is the calculation of
actual dwell time on each of the interest areas and fixation count. Data Viewer has an
“Include Fixation in Single IA” option in “Preferences -> Output/Analysis”. When
selected, the fixation is assigned to one of the interest areas only (see the above paragraph
on how the “winning” interest area is determined) - the interest area assigned gets the full
length of the fixation when calculating dwell times. If this option is disabled (default
setting), the fixation can be assigned to multiple interest areas, and effective duration (the
total amount of time that fixation and instances of the same IA intersect) for each of the
interest areas is used for the calculation of dwell times. This option will affect the
calculation of some variables in the Fixation Report

(e.g., CURRENT FIX INTEREST AREAS,

CURRENT FIX INTEREST AREA DWELL TIME, etc.) and Interest Area Report
(e.g.,JA_ DWELL TIME, IA FIXATION COUNT, etc.). The following table illustrates
the effect of this option with four consecutive fixations. Columns “IA_1 Duration”,
“IA_2 Duration”, “IA_3 Duration” are the duration of fixation onto each of three interest
areas.

Fixation | Fixation Duration | IA_1 Duration |IA_2 Duration |IA_3 Duration | WinningIA
1 516 376 141 516 3
2 33 33 0 0 1
3 137 137 0 0 1
4 552 411 143 0 1

If the “Include Fixation in Single IA” option is checked, the first fixation is assigned to
interest area 3, and the other three fixations are assigned to interest area 1. The

IA_ DWELL TIME for interest area 1 will be 722 ms - the sum of full duration of the
three fixations that are assigned to the interest area (33, 137, 552). The

IA_ DWELL TIME value will be 0 ms for interest areas 2, and 516 ms for interest area 3.
The IA_FIXATION_ COUNT for each of the three interest areas will be 3, 0, and 1,
respectively. If the “Include Fixation in Single IA” option is not checked, then the

IA_ DWELL TIME calculation will be based on the effective duration (instead of the full
fixation duration) on the target interest area. Thus, the [A DWELL TIME value for
interest area 1 will be 957 ms (=376 + 33 + 137 + 411). The value for interest area 2 will
be 286 ms (=141 + 143) and for interest area 3 it will be 516 ms. The
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IA_FIXATION COUNT for each of the three interest areas will be 4, 2, and 1,
respectively.

Another important parameter to consider is whether the interest area matching is sample-
based or fixation-based (“Perform Sample Based Calculation” in Output /Analysis
preferences). By default, the average x, y position of the fixation is used to identify a
matching interest area. However, this may not be suitable in cases where dynamic stimuli
(e.g., pursuit task following a moving object, or some video clips) are used where the
recorded eye position data may contain smooth pursuit segments where there are large
spreads of samples in the parsed fixation event. If the interest area calculation is sample-
based, samples within fixations (if loaded) are used for interest area matching and report
calculation. The latter may provide a better estimate of the actual dwell time in tasks
using dynamic stimuli.
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6 Data Analysis and Output

One of the goals of the Data Viewer software is to allow users to extract useful eye-
movement information and export data to a tab-delimited text file that can be processed
by most statistical packages. Before performing any data analysis, the first question you
may ask yourself is what part of the recording data you need to look at? Do you need to
analyze the eye movement data for the entire duration of the trial or just a small portion
of it? For example, if you conducted a reading experiment in which each trial displays a
sentence followed by a comprehension question, do you need to look at the portion of eye
movement data from when the participant was answering the comprehension question? If
not, you may create an interest period for the reading part (i.e., from the onset of the
reading screen to the onset of the comprehension questions). Once one or more interest
periods have been set, any reports from Data Viewer will only reflect data from within
the selected interest period.

Next, you will need to determine which report is appropriate for your analysis. Data
Viewer organizes the output reports based on different levels of analysis. Trial Report
provides summary statistics for each trial in each edf (e.g., the duration of the trial
recording in ms, the number of fixations that were made, etc.). The Fixation, Saccade and
Sample Reports provide detailed eye movement measures for each of these event types —
with one row of data per fixation, saccade, or sample. The Interest Area Report provides
eye-movement data outputs related to each of the interest areas. The Message Report
provides an output for each of the message events recorded in the data file with the
corresponding fixation/saccade event. The Aggregate Event Statistics and Aggregate
Interest Area Report provide summary statistics for a group of trials/participants. While
most of the research questions can be answered by extracting and analyzing the data from
one or several of those reports, it is possible that you will need to further process the
report outputs in order to derive measures of interest beyond those produced by Data
Viewer.

When performing analysis, you may organize each of the viewing sessions by loading
one or multiple EDF files. The settings from one viewing session (a "template") can be
exported to different viewing sessions. Thus users may go through each of the output
reports to configure the selection of variables in an intended order, and then export the
variable selection into a property file by clicking on the "Analysis -> Reports -> Export
Report Variable Selection" option in the application menu. For all future viewing
sessions, the variable selection in the reports can be automated by importing the
previously saved property file (by clicking on the "Analysis -> Reports -> Import Report
Variable Selection" option in the application menu). The export/import feature is
similarly available to the interest period definitions and properties of the viewing session.
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6.1 Managing Trial Variables

The Trial Variable Manager (Figure 6-1) and the Trial Variable Value Editor (Figure 6-2)
allow users to review the currently available variables, to assign a default value for the
variables, to create or remove variables, and to change the variable values on a trial-by-
trial basis.

6.1.1 Trial Variable Manager
x|

-Analysis Variables: -

triaI o
freq_x

B | |freay A |
=

@ phase_y
——d |dc_x

dc_y ~|
~Selected Variable: -

Label: |phase_x Default Value (Optional): I

Definition (Optional):

Reset Cancel ] OK I

Figure 6-1. Trial Variable Manager

The Trial Variable Manager Dialog, activated by selecting Analysis — Trial Variable
Manager from the menus, lists the filename (DATA_FILE) and other variables imported
from the EDF file, if the TRIAL VAR LABELS or !V TRIAL VAR command is used.

To create a new variable, click the ® button on the left. A new variable (“label”) with a
default value (“default value”) will appear. To assign a different default value to a
variable, select the variable in the list, and type in the default value in the Default Value
edit box. The label of the variable can be similarly changed through the “Label” edit box.

To remove one variable, select it in the list and click the Delete button ] .
Sometimes, the order in which the variables are listed is important. This is especially

true when you want to match the variable labels created with the Trial Variable Manager
and the actual values read from other sources (e.g., to facilitate cut and paste from excel
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spreadsheets into the trial variable value editor discussed below). To do that, simply
select the variable and use the 4 or ¥ button to move it to the desired position.

6.1.2 Trial Variable Value Editor

The variables and their values can be viewed and edited in the Trial Variable Value
Editor dialog box.

"o\Trial Variable Value Editor x|
File Trial image Condition

dm Trial: 1 DSC_1000.jpa ndefined

dm Trial: 2 town_blur.jpg default value

dm Trial: 3 DSC_3561.jpg default value

dm Trial: 4 DSC_3152.jpg default value

dm Trial: 5 DSC_3711.jpg default value

dm Trial: 6 town.jpg default value

dm Trial: 7 DSC_7641.jpa default value

dm Trial: 8 DSC_2571.jpg default value

dm Trial: 9 DSC_5682.jpg default value

Reset Cancel I OK |

Figure 6-2. Trial Variable Value Editor Dialog

To activate the dialog box, from the menus, choose:
Analysis — Trial Variable Value Editor

The top-row of the dialog box lists the filename, variables imported from the EDF file, as
well as variables created by the Trial Variable Manager. The following rows list the
corresponding values for the variables in each individual trial. To change the value for a
particular cell, double click on the current value, type in the new value (DO NOT include
quotes for text strings), and press Enter to register the change. (Note, it is expected that
users will load EDF files from the same experiment with the same condition labels into
one viewing session. Loading EDF files containing different condition labels from each
other can cause complications.)

Version 1.11.1 added support for copying and pasting directly into the Trial Variable
Value Editor. If you need to add a new column into the editor, prepare an Excel sheet
with the first row being the label of the column. Copy the selection from Excel and paste
it onto top-left cell in the editor (the first row of the “File” column). The new variable
will be added as the last column. If you already have the columns created but would like
to update the content of the column, you can paste the content directly onto the first cell
of the particular column without a row for the column label.
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6.1.3 Trial Grouping

Trial condition variables are important for identifying one specific trial or grouping trials
belonging to the same experimental condition. Thus, instead of going through each of the
individual trials, a trial grouping mechanism can be applied to manipulate all trials of a
certain type collectively. For example, practice trials can be removed from the viewing
session in a batch, interest area templates can be applied to those trials using the same
search display, and a fixation map can be created for the same display image with data
collected from several participants to identify the informative parts of the display. After
trial grouping is performed, Aggregate Mode can be enabled to visualize eye-tracking
data from multiple participants/trials in the same Trial View Window and to export
summary statistics for the entire trial group.

By default, Data Viewer groups all of the trials by the data file. To regroup trials within a
viewing session, select the viewing session icon (), click the right mouse button, and
choose the “Trial Grouping” option. You can also bring up the Edit Trial Grouping
dialog box by clicking “Edit -> Trial Grouping ...” from the application menu, or by
using Ctrl + G keyboard shortcut. In the following “Edit Trial Grouping” dialog, choose
the variable with which the grouping should be performed and press the “Regroup”
button. Multiple grouping variables can be selected and the order of the grouping can be
adjusted by use the 4 and ¥ buttons. For each of the trial grouping variables, users can
further configure whether the trial groups should be sorted in an Ascending or
Descending order. If no grouping variable is chosen, grouping will be performed based
on the data file each trial belongs to.

Edit Trial Grouping .. x|
Select the Trial Conditions to Group By:
Available Variables Selected Variables
TRIAL_FILENAME [FEATURES
PRACTICE PRESENCE

DISCRIMINABILITY
SETSIZE
TRIAL_INDEX
SUBJECT_INDEX

_>» | _a |
_« v |

(No selections will result in trials grouped by data File) (+ Ascending (" Descending

Reset | Cancel | Regroup |

Figure 6-3. Trial Grouping Interface

Once grouping is performed, the trials will be listed by the conditions of the grouping
variables selected (see the right panel of Figure 6-4). The property panel of each group
lists the label (values of the grouping variables), total number of trials, and configurable
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interest area information for the group. Users can apply an interest area template to all
trials in the group by setting the Default Interest Area property for the grouping node (see
section 5.9.9 Using Interest Area Templates).

o i

<P Data I ﬁ Preferencesl &P Data I ﬁ Preferencesl

9 |§I T —— —_A_I _4BCN.evs —_A_I
=8 -8 Single_feature: Absent
O Trial: 1 B8 Single_feature: Present
L@ l.:.] Trial: 2 - @ Two_feature: Absent
[.:.] Trial: 3 = @ Two_feature: Present
L Trial: 4 B Trial 115
L Trial: 5 m-L Trial: 118
...,” Trial: 6 g Trial: 121
- B Trial: 7 ~| -G Trial: 122 ~|
Field | Yalue | Field | Yalue |
Mame: BCN.evs Label: Two_feature: Present
MNumber Trials: 153
Created: Jan 16, 2003
Last Modified: Jan 17, 2003 Default Interest Area... |[test] .ias
Empty Interest Area
Mumber Trial Groups: |1
MNumber Trials: 612

Figure 6-4. Applying Trial Grouping by a Trial Condition Variable and setting an
Interest Area Template for a group of trials.

Data Viewer Versions 1.11.1 and higher include an “Exclude from Reports” option in the
property panel of the groups so that users can block outputting particular groups of trials.

6.2 Fixation Map

EyeLink Data Viewer allows users to create a fixation map to identify informative parts
of a display based on trials from a single participant or multiple participants viewing the
same background image. To create a fixation map (or heat map), a 2D Gaussian is
applied to each of the fixations - the Gaussian center is the fixation location, the width of
the Gaussian is influenced by an adjustable sigma value in degrees of visual angle (the
larger the sigma value, the larger the area that will be influenced by the fixation), and the
height of the Gaussian can be weighted either equally for all fixations or by the duration
of individual fixations. This 2D Gaussian is added to an internal map by adding weight to
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that area of the map. After the above process is applied for all fixations, the internal map
is normalized so it can be applied to the color or brightness scale used to create a
composite view (see Figure 6-5).

EyeLink Fixation Map (Duration Based) for IP: “Full Trial Ii0gkals
Aggregate Data for “town.jpg" - Trials=3, Fixations%3. Max
ations B,

Figure 6-5. Example Fixation Map

To create a fixation map for a single trial, select the relevant trial node (Q) in the top-
panel of the Inspector Window, click the right mouse button and select the "Create
Fixation Map" option (see Figure 6-6). To create a fixation map for a group of trials,

select the relevant group node (EE ). Click the right mouse button and select the "Create
Fixation Map" option. In the following "Save Fixation Map ..." dialog box, enter the
intended file name with a proper file extension .BMP, .JPG, or .TIFF. Properties for a
fixation map can be configured through the Output/Analysis preferences settings.

Versions 2.3 and above of EyeLink Data Viewer provide a convenient interface () for
creating a fixation map, displaying it directly in the Trial View Window (rather than
creating a separate window), and saving it to the hard drive. The fixation map will be
based on whatever data that is currently displayed (data from the current trial only when
in the non-Aggregate Mode or data from the trials in the entire trial group when in
Aggregate Mode — please check the title of the Trial View Window). Clicking on the
button again toggles off the fixation map drawing. It is possible that the data used to
generate a fixation map may no longer be valid at a later stage of analysis (e.g., trials are
removed from the current trial group, fixations are deleted, merged, or moved, a different
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interest period applied, aggregated mode is turned on or off, trials are regrouped). Data
Viewer will attempt to detect such scenarios by displaying a different fixation map icon (
). Users are advised to create the fixation map again if this happens. Please note that if
the “Exclude from Reports” property of a trial or trial group is checked, fixation data
from that trial/trial group will not be included when generating the fixation map, even
though fixations from that trial/trial group may still be displayed in the Spatial Overlay
View.

~e' EyeLink Data Viewer Version 2.6.0 - Untitled.evs (C:\Temp\Untitled)
File Edit Analysis Window Help

e f=TE=0 0 WS Y s sl ] A S S N

emor, 1=} [~o Trial View: picture : picture: Triak 1
< Data | o Preferenoesl
J Untitled.evs
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2
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?; pictun  Clean up All Dynamic Interest Areas
. InterestA Open in New Window

Create Difference Fixation Map
Select Trial Background Image
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Figure 6-6. Creating a Fixation Map

EyeLink Data Viewer supports creating fixation maps based on the duration of fixations,
count of fixations, percent of fixations, and percent of dwell time across the display. This
is configurable through the "Type (1 = Duration, 2= Count, 3 = Count Density, 4 =
Duration Density)" option of the Output/Analysis -> Fixation Map preference settings. If
a duration or duration-density type is selected, the height of the Gaussian is weighted by
the duration of the individual fixations; for a count-based or a count density fixation map,
the height of the Gaussian is the same for every fixation. The map activity is averaged
based on trial count pooled across participants (i.e., a map based on 1 trial that has 1
fixation will have a same fixation output as a map based on 10 trials, each trial with 1
fixation at the same location). The title of the fixation map indicates the type of fixation
map created, the total number of trials and fixations contributing to the output, and the
maximum per-trial-average value for the type of map chosen. The legend of the map
indicates how long or how often participants have looked across the map. By default, the
frequently fixated areas are painted in red whereas the less-fixated areas are painted in
green. The drawing colors and the transparency of the drawing can be configured through
the preferences. A gray-scale version of the fixation map is also available if the "Enable
Heat Map Mode" option is unchecked. This creates a see-through map, with the
background image being most visible in those areas that were fixated most / longest.
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The following (Figure 6-7) is a sample output of the four different fixation maps for the
same trial. Note the difference between the duration/duration density maps and the
fixation/fixation density maps: A - original fixations in the Spatial Overlay View; B - the
duration-based fixation map; C - the density distribution of the fixation durations (i.e.,
proportion of trial dwell time on each area of the display); D - the count-based fixation
map; and E - the density distribution of the fixation counts (i.e., how frequently each area
of display area has been visited).
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Figure 6-7. Types of Fixation Map

The count density and duration density maps, visualizing the proportion of fixation
duration and fixation count relative to the trial total, may produce different outputs from
the count and duration maps when the absolute trial duration or fixation count differ
greatly across trials. The following example (Figure 6-8) illustrates the difference
between the duration and duration density maps, and between the fixation count and
count density maps. Panels A and B - original fixations in the Spatial Overlay View in
two trials — note the difference in the total fixation number and total trial duration
between the two trials; C - the duration-based fixation map; D - the density distribution of
the fixation durations; E - the count-based fixation map; and F - the density distribution
of the fixation counts.
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Figure 6-8. Types of Fixation Map

A single fixation map is useful for the purpose of identifying which parts of the display
the participant or participants focused their gaze on; the legend displays colors that
correspond to the peak and lowest activation values. However, fixation activities across
two different fixation maps cannot be directly compared if the scales of the two maps are
very different. To make such a comparison, users may set an intended peak activity value
in the "Fixed Maximum Value" field of the preference settings. By default (with a value
of -1 in the "Fixed Maximum Value" field), the peak value displayed in the legend will
be the actual maximum per-trial-average value for the map. If a user-defined peak value
is set, the drawing of the fixation map will be adjusted according to this new scale. A
black line is drawn on the heatmap scale to indicate the actual maximum activation of the
heatmap (if that value is less than the fixed maximum). A white line is drawn on the
heatmap scale to indicate the "Low Activity % Cut-off" when the setting is greater than 0
and the "Fixed Minimum Value" set in the preferences. This low activity cutoff feature
ignores areas on the map with an activation value lower than 10% (default) of the peak
value. If the low activity cutoff value is set to 0, the whole display is colored.

Panel A of Figure 6-9 shows the original fixations in a trial. Panel B shows the fixation-
count based map using the default "Fixed Maximum Value" (-1) and "Low Activity %
Cut-off" (10% - the white line position). Panel C shows the same trial but with a different
"Fixed Maximum Value" (4) - the actual peak value in the map is indicated by a black
line. Panel D illustrates the output using a "Fixed Maximum Value" of 2.0 (which is the
same as the actual peak value), a "Fix Minimum Value" of 0.5 (which is higher than the
default 10% cutoff value, i.e., 0.2 fixation), and the “Clip Map Below Fixed Minimum”
option checked. Notice that areas below the fixed minimum value are clipped (and
therefore not colored).
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Figure 6-9. Adjusting the Scale of the Fixation Map
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6.2.1 Difference Fixation Map

While individual fixation maps can be created for each trial group, some users may be
interested in visualizing the difference in fixation pattern between groups directly on a
single map. Version 2.4 of Data Viewer allows users to create a difference fixation map
between two trials or trial groups (assuming they have the same recording resolution). In
the top-left tree view panel, hold down the Ctrl key and select two trials or trial groups
that you wish to compare. Click the right mouse, and choose “Create Difference Fixation
Map” option. The following example illustrates a difference heat map in a pro-saccade
task where the subject maintained a fixation in the center of the screen and then saccaded
to a target that appeared either on the left or right side of the screen. Panels A and B
show the original fixation data — red and blue fixations are from the trials in which the
saccade target appeared on the left and right side of the screen respectively. Panel C is the
difference fixation map between the two groups of trials.

Figure 6-10. Example Difference Fixation Map

To create the difference heat map, Data Viewer first generates a separate activation map
for each of the two groups, and subtracts the activation values between the two maps. The
maximum difference in fixation duration is then identified between the two maps. This
value is used to create a symmetrical color scale with the values ranging from negative
maximum duration to positive maximum duration. Areas where one group fixates more
will be associated with a positive difference value and painted in green-yellow-red color
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gradient; areas where the other group fixates more will be associated with a negative
difference value and painted in green-cyan-blue color scale. The title of the difference
heatmap indicates which trial group is associated with a positive difference value and
which group is associated with a negative difference value. A default low activity cut-off
value (10%) is used on both sides of the scale (marked with a white line in the scale) so
that no coloring is applied when the difference is small. The color map will then be
painted on top of the background stimulus.

Please note that the difference map created by Data Viewer is intended for qualitative
visualization of the difference in fixation pattern between trials or trial groups, it is not
intended to provide any statistical tests of the differences.

6.2.2 Dynamic Heat Map

Version 2.4 of Data Viewer supports dynamic heat map presentation in the Animation
Playback View. Users first need to perform trial grouping so that all trials using the same
stimulus (e.g., video clip) are included in the same trial group and enable the “Aggregate
Mode” (¥%) so that data collected for the same stimulus from multiple subjects / trials are
displayed in the same window. Now toggle on the “Enable Dynamic Heatmap in
Aggregate Mode” button (@) in the toolbar to see the real-time rendering of the dynamic
heat map when the trial playback progresses. Please note that a recent video card with
OpenGL 3.0 support is required for the dynamic heat map presentation. If Data Viewer
detects an unsupported video card, it will automatically disable the heat map mode and
draw the gaze cursors instead in the Animation View. It is possible to see the raw gaze
data alongside the dynamic heat map — simply enable the “Show Gaze Cursor when in
Heat Map Mode” option in the “Fixation Map” preferences.

Similar to the static fixation map in the Spatial Overlay View, the dynamic heat map is
generated by calculating pixel intensity for all points on the screen. The intensity at a
given point is again weighted by a Gaussian distribution determined by the relative
distance to a gaze position. While the static heat map uses the parsed fixation data,
dynamic heat map accumulates gaze samples from multiple subjects/trials within a fixed
temporal window (centering on the current playback position and splitting the duration
equally forward and backward). This temporal window is used to smooth the heat map
transition between video frames. Shorter window durations tend to show rapidly
appearing and disappearing hot spots whereas longer window durations may result in a
distorted presentation as it may include too much past and future data in the rendering.
The default temporal window size is 300 milliseconds. Users can adjust “Heat Map
Window Duration” field in the “Fixation Map” preferences if necessary.
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Figure 6-11. Example Dynamic Heat Map when Participants (N = 14) Viewing a Video
Clip of Playing Frisbee. The temporal window is 300 ms and the max duration is fixed to
60 ms.

After the pixel intensity is calculated for all points on the screen (accumulating gaze
samples within the temporal window), the pixel intensity is mapped to a color scale so
that a heat map is painted on top of the background image/video frames. Because the
fixation pattern will vary as the stimulus presentation unwinds, the peak value of the gaze
duration will vary across different playback positions. As a result, the automatic peak
value in the static fixation map cannot be used here as this makes the interpretation of
data difficult (it is impossible to perform a direct comparison of viewing pattern between
frames if the heat maps are painted in different color scales). Instead a “Fixed Maximum
Value” must be established in the Fixation Map preferences for the dynamic heat map
rendering - the default is set to 60 milliseconds for a Window Duration of 300
milliseconds (the Fixed Maximum Value should be bigger if a larger Window Duration is
used). Obviously, the maximum value will vary from one stimulus set to another and as a
result, users are expected to come up with an appropriate fixed maximum value
accordingly.
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6.3 Managing Reaction Time Definitions

Another important application of the trial condition variables is for managing reaction-
time definitions for all the trials in the same experimental condition. A typical trial
recording could be ended in several ways, such as a button response, a saccade event, a
fixation event, or a special message. To obtain an accurate reaction time (RT) measure,
the EyeLink Data Viewer relies on a set of reaction time definitions to parse the start and
end events for RT calculation. The reaction time manager allows users to configure the
way in which the trial starts and ends for each condition of the experimental design.
Once a set of RT definitions has been created and applied, the RT start and end event
information is available in both the Trial View Window and the Inspector Window.

6.3.1 Reaction Time Manager

The Reaction Time Manager is used to create, edit, or delete reaction time definitions for
different experimental conditions. Users can set parameters of a trial end event and
specify condition values that must be matched for the RT definition to be applied to a
given trial.

To configure reaction time definition,
1) From the menus, choose:
Analysis — Reaction Time Manager

~g\ Reaction Time Definition Manager 1 x|

s

[New RT Definition |

_~ |
v |

1

[~ Override Custom Reaction Time Definitions

Reset Cancel | OK |

Figure 6-12. Reaction Time Definition Manager
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In the Reaction Time Manager dialog (see Figure 6-12), users can create a new
reaction time (RT) definition by clicking the New RT Definition button ® on the
left, edit an existing RT definition by clicking on the ¥ button, and remove an
RT definition by clicking on the W putton.

Users who have already had custom reaction time messages defined in the EDF
file need to decide whether the custom RT messages from the EDF file or any
new RT definitions created here should take precedence when both of them are
applicable for a particular trial. If "Override Custom Reaction Time Definitions"
box is checked, the new RT definitions created through the Reaction Time
Definition Manager will take precedence; otherwise, the custom RT messages
written in the EDF file will be used.

2) Click the New ® button. In the Reaction Time Definition Editor dialog (General
Tab; see Figure 6-13)

a. Enter a label for the current RT definition in the Label edit box

b. Select the type of RT end event from the End Event Type combo box

c. In the Trial Condition Qualifiers group box, select the trial condition
variables and enter the intended values for the current RT definition (DO
NOT include quotes for text strings). Please note that the Trial Condition
Qualifiers settings are optional. If values are specified for some of the
variables, the RT definition will only be applied to those trials whose
variable values match the ones specified.

~¢\ Reaction Time Definition Editor x|

§"Genera'|'§| Reaction Time |

Label Inew RT: 01 Type ISaccade Event vl

(~Trial Condition Qualifiers

Trial Conditions Selected Value
TYPE Normal

Reset | Cancel | ok |

Figure 6-13. Reaction Time Definition Editor (General Tab)

3) Select the Reaction Time tab (see Figure 6-14).
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Figure 6-14. Reaction Time Definition Editor (Reaction Time Tab)

The layout of the Reaction Time tab depends on the type of end event you
selected in the General tab. One common feature though, is the configuration of
the start time message. In the Start Time Message Text edit box, type in the
intended message string (the default is “SYNCTIME”). The "Use Substring
Match for Messages" option, if checked (default), searches for any string that
contains the message text specified here. If this option is unchecked, the message
string should be exactly like the one specified. For example,

"SYNCTIME SIGNAL" will not be accepted if the specified text is
"SYNCTIME" and the "Use Substring Match for Messages" option is unchecked.
Users can also provide a customized “Start Event Offset” value so that the
reaction time period does not start right on the time of the message event (a
negative number in milliseconds means that the reaction time period starts earlier
than the matching event whereas a positive number means that the reaction time
period starts later than the matching event).

Button Event:
This will treat a particular button press/release as the reaction time end event.
Select the intended button ID from the Button Number combo box and choose the

button state (button press or release).

Input Event:
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This will treat a particular input event as the reaction time end event. Set the
intended Input Number for the End Time Input Event.

Message Event:

This will treat the first occurrence of a matching message as the end event for
reaction time calculation. In the “End Time Message Text” edit box, type in the
message string (DO NOT include quotes for text strings).

Fixation Event:
This will end the trial by the appearance of a specific fixation. In the edit boxes,
fill in the minimum fixation duration (in milliseconds) required, as well as the X)

coordinates of the center of the fixation region and the diameter of the region.

Saccade Event:

This will end the trial by the occurrence of a specific saccade. Users can choose to
set a minimum saccadic amplitude (in degrees of visual angle) required, as well as
the X) coordinates of a region center and the diameter of the saccade region into
which the qualifying saccade should fall. If these parameters are left blank then
the first saccade following the Start Time message will be the qualifying saccade.

4) Once all of the desired RT definitions have been set, arrange the order of the
definitions by using the 4 and ¥ buttons in the Reaction Time Definition
Manager dialog. This operation is important only when more than one RT
definition can be met for a single trial - Data Viewer will apply the first matching
Reaction Time definitions in the list. Therefore, if you have both specific RT
definitions (those are qualified by “Trial Condition Qualifiers”) and general
definitions, always put the specific definitions before the general ones.

5) Click OK to close the Reaction Time Manager dialog. This will apply the
reaction definitions to all trials. If there are lots of trials in a viewing session, this
may take some time to finish.

6) RT definitions that are no longer required or are not appropriate, can be removed

by clicking on the “Delete Selected RT Definition” button on the Reaction Time
Definition Manager dialog box.
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Figure 6-15. Deleting Reaction Time Definitions

6.3.2 Viewing Reaction Time Information

If the reaction time events are applied, such information is available for viewing in the

Trial View Window (see Figure 6-16). In the Spatial Overlay View, a red RT symbol is
displayed near the end event. In the Temporal Graph View, a green line is drawn at the
time when the start time message is presented and a red line is drawn at the time when the
end event occurs (to see these graphics, make sure that the Display RT Graphics field in
the Data Views Preferences is checked; see section 8.6).
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Figure 6-16. Reaction Time Graphics in Both the Spatial Overlay View and the
Temporal Graph View of the Trial View Window

In the event list of the Inspector Window, select the end event that meets the reaction
time definition for the selected trial. The RT End Event field of that event is
automatically checked. This field will be unchecked and reaction time calculation will be
updated if the user decides to choose another event as the RT end event by checking the
same field of the newly selected event.

6.4 Interest Periods

In addition to reaction-time definitions, users may also selectively view and perform
analysis on data within a specific period of time within a trial (Interest Period). For
example, users may want to examine the eye data between two important markup
messages; for a trial with multi-page manipulation, analysis may be performed separately
for the period of each page presentation. Data Viewer allows users to create interest
periods based on messages, button events, input events, or duration. In order to facilitate
interest period creation, when programming an experiment, users should mark up
possible interest periods with messages or other important events such as button presses.
If different stimuli are shown in each of the interest periods, users should also make sure
the integration messages that are used to load images, text, or draw simple graphics be
recorded within the scope of the intended interest period; otherwise gaze data will be
overlaid on top of wrong images.

6.4.1 Creating Interest Periods

To create an interest period,
1) Click the “Interest Period List” combo box at the far-right hand of the application
menu bar and select the “Edit ...”.
2) Similar to the reaction time manager dialog, users can create a new interest period

by clicking the New Interest Period ® button on the left, edit an existing interest
period by clicking on the Edit Selected Interest Period ™ button, and remove an

interest period by clicking on the Delete Selected Interest Period ™ button. Data
Viewer also supports exporting and importing of interest periods across viewing

sessions. For example, users may create intended interest periods for one session,
and then export the interest Beriods into a property file by clicking on the "Export

the Interest Period" button [ . For all future viewing sessions that involve EDF
files with the necessary messages/button presses/input values that fit the interest
period definitions, creation of the interest periods can be automated by importing
the previously saved property file (by clicking on the "Import the Interest Period"

button B:'_).

EyeLink Data Viewer ©2002-2017 SR Research Ltd. 106



~eh Interest Period Manager x|

&]| New Interest Period |

Reset Cancel | OK |

Figure 6-17. Interest Period Manager

3) Click the New Interest Period ® button. In the following Interest Period Editor
dialog, enter a label for the current interest period in the “Interest Period Name”
edit box. The following steps explain in detail how to configure the IP Start Event
Settings and IP End Event Settings of the new interest period to be created.

4) In the IP Start Event Settings box, users need to specify the Interest Period Start
Event Type, and the Start Event Offset (msec). The start event of an interest
period can be a message (clicking on the “EDF Message” radio button) or an
input event (clicking on the “Input” radio button).

* [f'the start event is a message, enter the message string in the “Message Text”
field (case-sensitive; DO NOT include quotes for the text string). If this field
is left empty, this will be the start of the trial recording. A "Use Substring
Match for Messages" option is available for the message event type. If
checked (default), Data Viewer searches for any string that contains the
message text specified here. If this option is unchecked, the message string
should be exactly like the one specified. For example,

"SYNCTIME_ SIGNAL" will not be accepted if the specified text is
"SYNCTIME" and the "Use Substring Match for Messages" option is
unchecked.

* [f'the start event is an input event, enter a value in the “Input Value” field and
choose the proper Input Event Value Format - “Decimal”, “Binary”, or
“Hex”.

For both the message and input start event type, users can specify the “Start Event
Offset (msec)” - a time offset that can be used when the interest period does not
start right on the time of the message or button event. A negative number in
milliseconds should be used when the interest period starts earlier than the
matching event, and a positive number should be used when the interest period
starts later than the matching event.
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5) Users can similarly specify the event type and offset value in the IP End Event
Settings box. The end event type of an interest period can be an EDF message,
input event, button event, or fixed duration.

* EDF Message — This will treat the first occurrence of a matching message as
the end event for the interest period. Enter the desired message string in the
“Message Text” field (case sensitive, with no quotes for the text string).
Check the "Use Substring Match for Messages" option if you would like Data
Viewer to search for any string that contains the message text specified here.
Otherwise please have this option unchecked if the message string should be
exactly like the one specified.

* Input - This will treat a particular input event as the interest period end event.
Enter a value in the “Input Value” field and choose a proper Input Event
Value Format - “Decimal”, “Binary”, or “Hex”.

* Button - This will treat a particular button press/release as the interest period
end event. Select the intended button ID from the Button Number combo box
and choose the desired button action (pressed or released).

* Duration - The interest period can also be based on a duration following the
detection of the start message (e.g., 10 seconds following the “SYNCTIME”
message). In the “IP Duration (msec)” edit box, enter the desired duration of
the interest period — a value of 0 creates an interest period from the matching
start event to the end of the trial. Version 3.1 of Data Viewer allows users to
create multiple consecutive duration-based interest periods by checking the
“Create Multiple Consecutive IPs” box on the right side and entering the
desired number in the “Total Number of IPs” box. These options are only
available when creating new interest periods but not when editing existing
ones.

For the EDF message, input, or button end event type, users can specify the “End
Event Offset (msec)” - a time offset to be used when the interest period does not
end right on the time of the message, input, or button event. A negative number
in milliseconds should be used when the interest period ends earlier than the
matching event, and a positive number should be used when the interest period
ends later than the matching event.
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Figure 6-18. Interest Period Editor

6) At the bottom of the Interest period editor, there is a general option of “Apply
Strict Event Matching”. If this option is enabled, a strict match of the start event
and end event is required for the interest period creation. That is, a valid interest
period will only be created when a matching event is found for both the start
event and end event in the trial; otherwise an empty interest period will be created
for the trial. If the option is unchecked, Data Viewer will use the start time of the
trial as the start of the interest period if no matching start event is identified in the
trial, and use the end time of the trial as the end of the interest period if no
matching end event is found.

7) Click OK to close the Interest Period Editor dialog. This will apply the interest
period for all trials.
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6.4.2 Using Interest Periods

The newly-created interest periods are added to the existing interest period list, which
includes two default interest periods — “Full Trial Period” and “Reaction Time Period”.
The Full Trial Period corresponds to the entire trial recording. If Reaction Time
definitions have been created in the current viewing session (through “Analysis ->
Reaction Time Manager”), Reaction Time Period corresponds to the trial segment
between the start and end of the reaction time. If no reaction time definition is created or
no valid reaction time definition is found in a trial, the “Reaction Time Period” is the
same as the “Full Trial Period”.

Users can navigate between different interest periods by selecting the desired interest
period from the list. For each interest period, only those events falling within that period
are shown in the Spatial Overlay, Temporal Graph Views, and in the event list of the
Inspector Window. In addition, for all of the following output reports (trial, fixation,
saccade, interest area, sample, aggregate event statistics and aggregate interest area
reports), only those events and data within the selected interest period (custom-defined
interest period, or the default — “Full Trial Period” or “Reaction Time Period”) are
exported. If the “Create Output Report for All Custom Interest Periods™ option on the
output dialog box is checked, data export will include all custom interest periods created
in the viewing session (the “Full Trial Period” or “Reaction Time Period” is included
only if it is the currently-selected interest period).

The property table of the trial nodes provides feedback on the interest period selected. It
displays the times of the interest period (“Interest Period Start” and “Interest Period End”)
as well as whether a matching event is identified for the start and end of the interest

period (“Interest Period Start Matched” and “Interest Period End Matched”). Such
feedback is also available as individual variables (IP_ LABEL, IP. START TIME,

IP_ END TIME, IP_ START EVENT MATCHED, and I[P END EVENT MATCHED)
in the output reports.

Applying an interest period will filter out all events that are not within the scope of the
selected interest period. This may also affect the eye events that overlap with the start/end
of the interest period. If the "Trimmed Spanned Fixation Duration" setting of the "Data
Filters" preference is enabled, the duration, start time, and end time of the fixations that
overlap with the start or end of the interest period will be trimmed accordingly.

6.5 Trial Report

Trial reports summarize the performance of individual trials. If you want to look at a
segment of data from each recording trial instead of the default full trial period, please
make sure that you have created and selected a proper interest period or reaction time
definition before creating a trial report.
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6.5.1 Creating a Trial Report

To obtain a trial report,

1) From the application menus, choose:
Analysis -> Reports -> Trial Report

~ah EyeLmk Data Viewer Version 2.6.0 - Untitled.evs (C:\Temp\Untitled)
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Figure 6-19. Creating a Trial Report.
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2) In the following output report dialog, select the variables in the list of available output
variables (left panel) and press ">>" to enter the variables into the list of selected output

variables. You can also drag the selected variables and drop them to the intended position
in the selected variables list.
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Figure 6-20. Variables Used in the Trial Report.

* To remove variables from the output list, simply select the variables and press <<.
You can also drag the selected variables and drop them back to the Available
Variables list.

* To change the order in which the variables are listed, simply select one variable
and use the 4 or ¥ button to move it to the desired position. Repeat this step
until all the chosen variables are in the right position. You can also select the
variable(s) and then drag and drop them to the intended position.

* Data Viewer supports exporting and importing of variable selection across
viewing sessions. For example, users may go through each of the output reports to
configure the selection of variables in an intended order, then export the variable
selection into a property file by clicking “Analysis -> Reports -> Export Report
Variable Selection”. For future viewing sessions, the variable selection in the
reports can be achieved by importing the previously saved property file by
choosing “Analysis -> Reports -> Import Report Variable Selection” (except for
user-defined variables if they are used differently across experiments).

3) Once all the desired variables have been entered into the output list, press the Next
button.
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4) In the Save dialog box, browse to the directory in which you want to save the output
report. The default output directory can be configured through "General Preferences".

f| Save

: IMicrosoft Excel File (*.xs) ﬂ Cancel |

Figure 6-21. Saving the Output Report.

5) In the File name text box, type in the name for the document and choose the
appropriate file extension. Note: if the output report file extension set to "All Files" and
the file name does not contain an extension, the file name is appended with a ".txt" by
default.

6) Press the "Save" button.

6.5.2 Variables in the Trial Report

The following variables are listed in the trial report. Outputs for those variables marked
with an “*” will change if a different interest period is used.

Field Contents
RECORDING SESSION LABEL Label of the data file.
* AVERAGE BLINK DURATION Average duration (in milliseconds) of all

blinks in the trial within the currently-
selected interest period.

* AVERAGE FIXATION Average duration (in milliseconds) of all
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_DURATION

fixations in the trial within the currently-
selected interest period.

* AVERAGE SACCADE
_AMPLITUDE

Average size (in degrees of visual angle) of
all saccades in the trial within the
currently-selected interest period.

AVERAGE X/Y RESOLUTION

Average horizontal/vertical angular
resolution (in screen pixels per degree) for
the trial.

* BLINK_COUNT

Total number of blinks in the trial within
the currently-selected interest period.

* BUTTON_PRESS COUNT

Total number of button presses in the trial
within the currently-selected interest
period.

DATA FILE

File name of the EDF data file.

DURATION

Duration of the eye tracker recording for
the current trial (i.e., duration between the
“START” event and the “END” event of a
recording segment). This duration is not
affected by any interest period or reaction
time period filtering.

END TIME

Timestamp when the trial recording ends
(in milliseconds since EyeLink tracker was
activated; i.e., EDF file time).

EYE USED

Records which eye's data (LEFT or
RIGHT) was used to create this report.

* FIXATION COUNT

Total number of fixations in the trial within
the currently-selected interest period.

FIXATION DURATION MAX

The longest fixation duration (in
milliseconds) in the trial.

FIXATION DURATION MAX TIME

Start time (in milliseconds since EyeLink
tracker was activated; i.e., EDF file time)
of the fixation with the longest fixation
duration in the trial.

FIXATION DURATION MIN

The shortest fixation duration (in
milliseconds) in the trial.

FIXATION DURATION MIN TIME

Start time (in milliseconds since EyeLink
tracker was activated; i.e., EDF file time)
of the fixation with the shortest fixation
duration in the trial.

IA_ COUNT Reports total number of unique interest
areas in the trial.
INDEX Sequential order of the trial in the
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recording.

* INPUT_COUNT

Number of input events that occur during
the trial within the currently-selected
interest period.

INTEREST AREA FIXATION SEQUE
NCE

Temporal order in which interest areas
were fixated in the current trial. Please note
that this sequence calculation differs from
RUN_COUNT in two aspects: 1) this
variable takes null values (when no interest
area is fixated) into account and represents
them with a 0 value in the list; 2) For
fixations into overlapping interest areas (if
"Include Fixation in Single IA" preference
is not enabled),
INTEREST AREA FIXATION SEQUE
NCE only takes the first interest area for
each fixation and doesn't consider other
overlapping interest areas. RUN_COUNT
is calculated by summing up the individual
runs across all interest areas (which can
contain overlaps and don't count nulls).

INTEREST AREA SET

Setting of the interest area (“Custom
Interest Area Set” if interest areas are
loaded/created and “Empty Interest Area
Set” if not).

* P DURATION

Duration of the interest period in
milliseconds.

IP END EVENT MATCHED

Whether an event that matches the end of
the selected interest period has been found
in the current trial.

*[P_END_TIME

End time (in milliseconds since EyeLink
tracker was activated) of the interest
period.

IP_INDEX

The index (starting from 1) of interest
period created by the user. For the Full-
Trial period or Reaction-Time Period, a
missing value is given as they are not
created by the user.

IP LABEL

Label of the current interest period selected
in the viewing session.

IP_ START EVENT MATCHED

Whether an event that matches the start of
the selected interest period has been found
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in the current trial.

*P_START TIME

Start time (in milliseconds since EyeLink
tracker was activated) of the interest
period.

MEDIAN SACCADE AMPLITUDE

Median size (in degrees of visual angle) of
all saccades in the trial within the
currently-selected interest period.

MEDIAN FIXATION DURATION

Median duration (in milliseconds) of all
fixations in the trial within the currently-
selected interest period.

* MESSAGE _COUNT

Total number of messages in the trial
within the currently-selected interest
period.

* PUPIL_SIZE MAX

Largest pupil size in arbitrary units in the
trial recording within the currently-selected
interest period. Note that

PUPIL SIZE MAX,

PUPIL SIZE MEAN, and
PUPIL_SIZE MIN fields will output a
missing value if samples are not loaded
into a viewing session (see Data Loading
Preferences).

*PUPIL_SIZE MAX_ TIME

EDF Time (EDF file time in milliseconds
since EyeLink tracker was activated) of the
sample with maximum pupil size. Note that
this field will output a missing value if
samples are not loaded into a viewing
session (see Data Loading Preferences).

*PUPIL_SIZE MAX_ X

Gaze X position at

PUPIL SIZE MAX TIME. Note that this
field will output a missing value if samples
are not loaded into a viewing session (see
Data Loading Preferences) or the eye is in a
blink.

*PUPIL_SIZE MAX Y

Gaze Y position at

PUPIL SIZE MAX TIME. Note that this
field will output a missing value if samples
are not loaded into a viewing session (see
Data Loading Preferences) or the eye is in a
blink.

* PUPIL_SIZE MEAN

Average pupil size in arbitrary units in the
trial. Note that this field will output a
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missing value if samples are not loaded
into a viewing session (see Data Loading
Preferences) or the eye is in a blink.

* PUPIL_SIZE MIN

Smallest pupil size in arbitrary units in the
trial. Note that this field will output a
missing value if samples are not loaded
into a viewing session (see Data Loading
Preferences) or the eye is in a blink.

* PUPIL_SIZE MIN_TIME

EDF Time (in milliseconds since EyeLink
tracker was activated; i.e., EDF file time)
of the sample with minimum pupil size.
Note that this field will output a missing
value if samples are not loaded into a
viewing session (see Data Loading
Preferences) or the eye is in a blink.

* PUPIL_SIZE MIN X

Gaze X position at

PUPIL SIZE MIN TIME. Note that this
field will output a missing value if samples
are not loaded into a viewing session (see
Data Loading Preferences) or the eye is in a
blink.

* PUPIL_SIZE MIN_ Y

Gaze Y position at

PUPIL SIZE MIN TIME. Note that this
field will output a missing value if samples
are not loaded into a viewing session (see
Data Loading Preferences) or the eye is in a
blink.

¢ REACTION TIME

Configurable response time determined by
the Reaction Time Definition associated
with the trial. This variable returns a '." if
the trial does not have an RT end event.

¢ RT DEFINITION LABEL

Label of the RT definition (“.” if
undefined). “CUSTOM_RT” if the RT
definition is a custom one.

YRT EVENT BUTTON ID

If the RT end event is the press/release of a
button, records the button ID; otherwise,
records “.”.

¢ RT EVENT END TIME

End time (in milliseconds since EyeLink
tracker was activated, i.e., in EDF time) of
the end event. If end event is not an eye
event (fixation or saccade event), this
variable is equal to

RT EVENT START TIME.

¢ RT EVENT INDEX

Sequential order of the end event (index is
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based on all events of that particular event
type); -1 when NO MATCH.

¢ RT EVENT INPUT

If the reaction time end event is the INPUT
event defined, reports the new INPUT
value; otherwise, a missing value “.” 1
reported.

S

¢ RT EVENT MESSAGE TEXT

Reports the message text of the end event.
If the end event is not a message event,

[

reports ..

¢ RT_EVENT POSITION X/Y

Reports the X/Y coordinates of the fixation
or saccade end event and reports “.” for a
button, input, or message end event.

¢ RT EVENT START TIME

Start time (in milliseconds since EyeLink
tracker was activated, i.e., in EDF time) of
the end event.

¢ RT EVENT TYPE

The type of the end event (BUTTON,
INPUT, FIXATION, SACCADE,
MESSAGE, or NO_ MATCH) for the
Reaction Time Definition associated with
the trial.

¢ RT START TIME

Start time (in milliseconds since EyeLink
tracker was activated; i.e., EDF file time)
of RT definition for a trial.

* RUN_COUNT

Total runs of fixations (two consecutive
fixations in the same interest area belong to
the same run) in the trial within the
currently-selected interest period.

* SACCADE_COUNT

Total number of saccades in the trial within
the currently-selected interest period.

* SAMPLE _COUNT

Total number of samples in the trial within
the currently-selected interest period.

*SD SACCADE _AMPLITUDE

Standard deviation of the amplitude (in
degrees of visual angle) across all saccades
in the trial within the currently-selected
interest period.

*SD FIXATION DURATION

Standard deviation of the duration (in
milliseconds) across all fixations in the trial
within the currently-selected interest
period.

START TIME

Timestamp when the trial recording starts
(in milliseconds since EyeLink tracker was
activated; i.e., EDF file time).
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TRIAL LABEL Label of the trial.

VISITED INTEREST AREA COUNT Reports total number of unique interest
areas visited in the trial (i.e.,
RUN_ COUNT without replacement).

Besides these default variables, additional trial variables will be listed if they have been
defined in the EDF file or created during the viewing session (see section 6.1.1 on trial
variable manager).

6.5.3 Using Trial Report

Please note that in the above table, outputs for all of the variables marked with an “*”will
change if different interest periods are used. For example, the value of these variables in
a Trial Report run with a Reaction Time Period set may be different from the values in a
Trial Report run with Full Trial Period set, as the former will only include a subset of the
data in the report. Therefore, please make sure that you have the right Interest Period
selected when creating your own reports (see figure below; see also section 6.4.2). In
those trials with no reaction time defined, missing values (“.””) will be recorded for those
variables marked with a “q” sign. Please also note that event counts only include visible

events.

6‘*’9
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Full Trial Period
Reaction Time Period

New Interest Period 01
YT 7T T AT 7N T
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Figure 6-22. Using Interest Period for Event Filtering

There are three possible time periods for a trial report: 1) recording period, 2) reaction-
time period, and 3) interest period. The recording period (START TIME, END TIME,
and DURATION) of a trial starts from the “START” message in the EDF file and ends
on the “END” message. This is fixed for a recording trial, regardless of how the user sets
the interest period filters.

If a valid reaction time definition is found for one trial, the RT START TIME is the time
of the RT start message (e.g., time of “SYNCTIME” message),

RT EVENT END TIME, and RT EVENT START TIME are the start and end time of
the RT event (fixation, saccade, button, input, or message). Reaction time
(REACTION_TIME) is calculated as the difference between RT START TIME and

RT EVENT START TIME. Please note that the RT EVENT END TIME and

RT EVENT START TIME will be the same when a button, input, or message is used as
the RT end event, but will be different when a fixation or saccade is defined as the end
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event. If the user does not create a reaction time definition or no valid reaction time
definition is found for one trial, REACTION_TIME, RT EVENT END TIME, and
RT EVENT START TIME, and other variables related to reaction-time definition will
have missing values (“.””) whereas RT _START TIME will be the same as the trial
recording start time (START TIME).

The interest period variables will have different values depending on the settings used in
the interest period filter (see Figure 6-22). If the interest period filter is set to “Full Trial
Period”, the start (IP_ START TIME), end (IP_END_ TIME), and duration
(IP_DURATION) of the interest period will be same as those for the recording period
(i.e., START TIME, END TIME, and DURATION). If the interest period filter is set to
“Reaction Time Period”, the start, end, and duration of the interest period will be same as
those for the reaction time period. If a user has created their own interest period (see
section 6.4.1) and that interest period is used to filter events, the output report will do
summary statistics (variables marked with “*” in the above table) for only those events
falling within that period.

6.5.4 Configuring the Trial Report

Data Viewer allows users to configure the trial report (and similarly other reports). A few
options are available in the “Trial Output Report” dialog box:

* Users can exclude some trials by entering a string in the “Exclude Trial String”
edit box. This string should be one message or part of a message within the trial
recording (see section 7.1 on defining the start and end of a trial) that uniquely
defines the subset of trials to be excluded.

* To enable correct loading of string/text variables into some statistics software,
Data Viewer provides an option of adding a pair of quotation marks for those
variables.

* Ifthe “Create Output Report for All Custom Interest Periods” option is enabled,
the Trial Report will output data across all custom interest periods created in the
viewing session - the “Full Trial Period” or “Reaction Time Period” data is only
included in the report if it is the currently-selected interest period. Users can save
the data from multiple interest periods into a single file or into multiple individual
files.

* [fthe “Create One Report File Per EDF File” option is checked, Data Viewer will
create one report file for each of the EDF files loaded into the viewing session.

Note: If the “Exclude from Reports” property of a trial or trial group is checked, data
from that trial/trial group will not be included in the trial report (and other reports).

6.6 Fixation Report
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Fixation reports provide information about fixation events. Each row of the report
represents a single fixation. Depending on the variables selected for output, each row can
contain information on the previous fixation and/or saccade, as well as the next fixation
and/or saccade.

6.6.1 Obtaining a Fixation Report

To obtain a fixation report,
1) From the application menu, choose:
Analysis -> Reports -> Fixation Report

~eh\ EyeLink Data Viewer Version 2.6.0 - Untitled.evs (C:\Temp\Untitled)
File Edit | Analysis Window Help

Recording Event Sequence Data ... ra 2
|Ble N'R;HI@ @|w

Trial Variable Manager ... Fixation Report ... Ctrl+F
Trial Variable Value Editor ... Saccade Report ... M

@ Data I Reaction Time Manager ... Interest Area Report ... o
i T Trial Report ... coer IO B ‘ fi
LgﬁﬁEd-EVS Sample Report ...
-5 LTIC'(]JrE Message Report ...
—
picture: Trial: 2 Aggregate Event Statistics ... s
picture: Trial: 3 Aggregate Interest Area Report ...
. Interest Area Templates Time Course (Binning) Analysis ...
Import Report Variable Selection ... -
Export Report Variable Selection ...
<EP nichire: Trial: 1: Fivation: 129 me AI

Figure 6-23. Creating a Fixation Report.

2) In the following output report dialog, select the variables in the list of available output
variables (left panel) and press ">>" to enter the variables into the list of selected output
variables. You can also drag the selected variables and drop them to the intended position
in the selected variables list.

* To remove variables from the output list, simply select the variables and press <<.
You can also drag the selected variables and drop them back to the Available
Variables list.

* To change the order in which the variables are listed, simply select one variable
and use the 4 or ¥ button to move it to the desired position. Repeat this step
until all variables are in the right position. You can also select the variable(s) and
then drag and drop them to the intended position.

* Data Viewer supports exporting and importing of variable selection across
viewing sessions. For example, users may go through each of the output reports to
configure the selection of variables in an intended order, and then export the
variable selection into a property file by clicking “Analysis -> Reports -> Export
Report Variable Selection”. For all future viewing sessions, the variable selection
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in the reports can be achieved by importing the previously saved property file
(through “Analysis -> Reports -> Import Report Variable Selection”).

~e\ Fixation Output Report ' X|

~Available Variables —Selected Variables

CURRENT_FIX_ADJUSTED ﬁl RECORDING_SESSION_LABEL
CURRENT_FIX_BLINK_AROUND TRIAL_INDEX
CURRENT_FIX_BUTTON_0_PRESS

CURRENT_FIX_BUTTON_1_PRESS LI
« I

CURRENT_FIX_BUTTON_2_PRESS
CURRENT_FIX_BUTTON_3_PRESS
CURRENT_FIX_BUTTON_4_PRESS

il

CURRENT_FIX_BUTTON_5_PRESS -
< e
~Variable Definition

Exclude Trial String : I
[~ Indude Hidden Events in Relative (Previous / Next) Variables.
|~ TreatHidden Events as Missing Values in Relative (Previous /[ Next) Variables
[~ Place Quotes (™) Around String / Text Variables
[~ Create Output Report For All Custom Interest Periods
{* ReportIP Datain One Fle. € Report IP Data in Multiple Files,
[~ Create one Report File per EDF File

Reset | Undo | Cancel | Next |

Figure 6-24. Variables in a Fixation Report.

3) Once all the desired variables have been entered into the output list, press the Next
button.

4) In the Save dialog box, browse to the directory in which you want to save the output

report. The default output directory can be configured through "General Preferences".

5) In the File name text box, enter the name for the document and choose the appropriate
file extension. Note, if the output report file extension is set to "All Files" and the file
name does not contain an extension, the file name is appended with a ".txt" by default.

6) Press the "Save" button.
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6.6.2 Variables in the Fixation Report

The fixation report includes the following variables. Please note that the values of all
variables marked with a “q” symbol are calculated relative to TRIAL START TIME,
and therefore will be different depending on whether a valid reaction time is found in the
trial (see section 6.5.3 on discussion of three time periods used in Data Viewer).

Field

Contents

RECORDING SESSION LABEL

Label of the data file.

CURRENT FIX ADJUSTED

Whether the current fixation has been adjusted
manually.

CURRENT FIX BLINK
_AROUND

Whether there is a blink preceding or following the
current fixation. Possible values are “AFTER” (a
blink follows the current fixation), “BEFORE” (a
blink precedes the current fixation), “BOTH” (the
current fixation is flanked by a preceding and a
following blink), or “NONE” (no blink appears
around the current fixation).

CURRENT FIX BUTTON 0 PR
ESS

CURRENT FIX BUTTON 8 PR
ESS

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") ifa
specific button (0 - 8) has been pressed during or
after fixation. If no button press is made from the
start of the current fixation to the start of next

fixation, missing value “.” is assigned.

CURRENT FIX DURATION

Duration of the current fixation.

¢ CURRENT FIX END

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START_ TIME") when
the current fixation ends.

9 CURRENT FIX END OTHER

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") when
the current fixation ends (for the other eye in a
binocular recording).

CURRENT FIX INDEX

The position of the current fixation in the trial.
Index numbers range from 1 to n, where n is the
total number of fixations in the trial.

CURRENT FIX INPUT EVENT
S

A list used to store new input events (time and
event code) that occur during the current fixation.

CURRENT FIX INTEREST
AREAS

A list of the interest area IDs that the current
fixation falls into.

CURRENT FIX INTEREST AR
EA DATA

A list containing the data (interest area type,
dynamic/static interest area, and coordinate data) of
the interest area to which the current fixation is
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assigned.

CURRENT FIX INTEREST AR
EA DWELL TIME

Total amount of fixation dwell time (in msec) on
the interest area to which the current fixation
belongs.

CURRENT FIX INTEREST AR
EA_FIX COUNT

Total number of fixations on the interest area to
which the current fixation belongs.

CURRENT FIX INTERESTARE
A GROUP

Group label for the interest area to which the
current fixation is assigned.

CURRENT FIX INTEREST
AREA ID

The ID of the interest area in which the current
fixation falls.

CURRENT FIX INTEREST
AREA INDEX

The index of the interest area in which the current
fixation falls. This measure is the same as the
CURRENT FIX INTEREST

AREA _ID except when there are multiple interest
arcas with the same ID, or interest area IDs didn’t
start from 1.

CURRENT FIX INTEREST AR
EA LABEL

The label of the interest area to which the current
fixation is assigned.

CURRENT FIX INTEREST AR
EA PIXEL AREA

Pixel area of the interest area to which the current
fixation is assigned.

CURRENT FIX INTEREST AR
EA RUN ID

The ordinal sequence of the current run ' of
fixation(s) made towards the current interest area.
If the current interest area does not have a previous
run of fixation(s) on it, this variable will have a
value of 1.

CURRENT FIX INTEREST AR
EA X OFFSET

Horizontal offset of the current fixation relative to
the center of the interest area. If the fixation falls
into multiple interest areas, returns the offset value
relative to the first relevant interest area only.
Returns a missing value (.) for freehand interest
areas.

CURRENT FIX INTEREST AR
EA Y OFFSET

Vertical offset of the current fixation relative to the
center of the interest area. If the fixation falls into
multiple interest areas, returns the offset value
relative to the first relevant interest area only.
Returns a missing value (.) for freehand interest
areas.

CURRENT FIX IS RT END

Whether the current fixation is the end event of the
RT definition.

{ CURRENT FIX LABEL

Label of the current fixation.

CURRENT FIX MSG COUNT ?

Number of visible messages associated with the
current fixation event'. This number will not
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exceed the “Maximum Message Variables for Eye
Event” set in the Output/Analysis Preference
Settings.

CURRENT FIX MSG TEXT #?2

Text string for messages associated with the current
fixation'. There will be as many of these as the
value set in the “Maximum Message Variables for
Eye Event” property of the Output/Analysis
preferences.

¢ CURRENT FIX MSG TIME #
2

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START_ TIME") of the
message'. There will be as many of these as the
value set in the “Maximum Message Variables for
Eye Event” property of the Output/Analysis
preferences.

CURRENT FIX NEAREST
_INTEREST AREA

Nearest interest area the current fixation is assigned
to. If the fixation falls within multiple interest
areas, the assignment is based on the shortest
distance to the center of an interest area. If the
fixation doesn’t fall within any interest areas, the
assignment is based on the shortest distance to the
closest edge of an interest area.

CURRENT FIX NEAREST
_INTEREST AREA DISTANCE

Distance (in degrees of visual angle) between the
current fixation point and the center of the nearest
interest area to the current fixation.

CURRENT FIX NEAREST
_INTEREST AREA LABEL

Label for the nearest interest area to the current
fixation.

CURRENT FIX PUPIL

Average pupil size during the current fixation.

CURRENT FIX REFIX INTERE
ST AREA

Whether this trial has a previous fixation in a
different run' that had the same interest area as the
current fixation. If so, the
CURRENT FIX INDEX value of the very first
fixation in that interest area is reported. If not, 0 is
reported.

CURRENT FIX REFIX PREV I
NTEREST AREA

Whether this trial has a previous fixation in an [A
with higher IA ID than current fix IA ID (see run'
definition).

CURRENT FIX RUN DWELL
TIME

Total amount of dwell time (in msec) in the current
run' of fixations.

CURRENT FIX RUN INDEX

Ordinal sequence of the current fixation in the
current run' of fixations. The first fixation in this
run has a RUN_INDEX of 1 and the second one
has RUN INDEX value of 2, and so on.
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CURRENT FIX RUN SIZE

Number of fixations within the current run'.

9 CURRENT FIX START

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") when
the current fixation starts.

1
CURRENT FIX START OTHER

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") when
the current fixation starts (on the other eye in a
binocular recording).

CURRENT FIX TRIAL SPAN

Whether the fixation starts before the trial starts
and ends after the trial starts, or starts before the
trial ends and ends after the trial ends.

CURRENT FIX X

X coordinate of the current fixation.

CURRENT FIX X OTHER

X coordinate of the current fixation (of the other
eye in a binocular recording).

CURRENT FIX X RESOLUTIO
N

Horizontal pixel-per-degree resolution for the
current fixation.

CURRENT FIX Y

Y coordinate of the current fixation.

CURRENT FIX Y OTHER

Y coordinate of the current fixation (of the other
eye in a binocular recording).

CURRENT FIX Y RESOLUTIO
N

Vertical pixel-per-degree resolution for the current
fixation.

Note: Similar analyses are done for the previous
fixation (variables beginning with

PREVIOUS FIX) and for the next fixation
(variables beginning with NEXT FIX).

DATA FILE

File name of the recording.

EYE USED

Records which eye's data (LEFT or RIGHT) is
used in the current report.

IP END EVENT MATCHED

Whether an event that matches the end of the
selected interest period has been found in the
current trial.

IP_ END TIME

End time (in milliseconds since EyeLink tracker
was activated; i.e., EDF file time) of the interest
period.

IP_INDEX

The index (starting from 1) of interest period
created by the user. For the Full-Trial period or
Reaction-Time Period, a missing value is given as
they are not created by the user.

IP LABEL

Label of the current interest period selected in the
viewing session.

IP START EVENT MATCHED

Whether an event that matches the start of the
selected interest period has been found in the
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current trial.

IP START TIME

Start time (in milliseconds since EyeLink tracker
was activated; i.e., EDF file time) of the interest
period.

LAST BUTTON PRESSED

ID of the pressed button.

¢ LAST BUTTON PRESS TIME

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") when
the last button is pressed.

LAST BUTTON RELEASED

ID of the last released button.

1
LAST BUTTON RELEASED TI

ME

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") when
the last button is released.

9 LAST BUTTON TIME

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") when
the last button is pressed or released.

NEXT FIX ANGLE,
PREVIOUS_FIX ANGLE

Angle between the horizontal plane and the line
connecting the current fixation and the
previous/next fixation (see Figure 5-2).

NEXT FIX DIRECTION,
PREVIOUS FIX DIRECTION

Direction (Left, Right, Top, Bottom), relative to the
current fixation, in which the next/previous fixation
is located.

NEXT FIX DISTANCE,
PREVIOUS_FIX DISTANCE

Distance between the current fixation and the
next/previous fixation in degrees of visual angle.

NEXT SAC_AMPLITUDE

Amplitude of the following saccade in degrees of
visual angle.

NEXT SAC_ANGLE

Angle between the horizontal plane and the
direction of the next saccade (see Figure 5-2).

NEXT SAC AVG VELOCITY

Average velocity of the next saccade.

NEXT SAC BLINK DURATIO
N

Duration (in milliseconds) of the blink found
within the next saccade. If no blink event occurred,
a missing value is given.

NEXT SAC BLINK_END

End time (in milliseconds relative to the start of the
current trial "TRIAL START TIME") of the blink
found within the previous saccade event. If no
blink event occurred, a missing value is given.

NEXT SAC BLINK START

Start time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
blink found within the previous saccade. If no blink
event occurred, a missing value is given.

NEXT SAC CONTAINS BLINK

Whether the next saccade contains blink(s).

NEXT SAC DIRECTION

Direction (Left, Right, Top, Bottom), relative to the
current fixation, in which the next saccade is
aiming. Note a missing value will be reported if the
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NEXT SAC AMPLITUDE is less than 0.5 degree.

NEXT SAC DURATION

Duration of the next saccade in milliseconds.

NEXT SAC END INTEREST
AREAS

Interest areas in which the end point of the next
saccade falls.

NEXT SAC END INTEREST A
REA ID

The ID of the interest area to which the end point
of the next saccade is assigned.

NEXT SAC END INTEREST A
REA_INDEX

Interest area to which the end point of the next
saccade is assigned. This measure is the same as
the NEXT SAC END INTEREST AREA ID
except when there are multiple interest areas with
the same ID, or when interest area IDs didn’t start
from 1.

NEXT SAC END INTEREST A
REA LABEL

Label for the interest area to which the end position
of the next saccade is assigned.

Y NEXT SAC _END TIME

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START_ TIME") when
the next saccade ends.

NEXT SAC END X

X coordinate of the end point for the next saccade.

NEXT SAC _END X RESOLUTI
ON

Horizontal angular resolution (in screen pixels per
degree) at the end of the saccade. If samples are
loaded into the viewing session, this takes the
horizontal resolution of the last sample in the
saccade; otherwise, the horizontal resolution of the
next fixation is used.

NEXT SAC END Y

Y coordinate of the end point for the next saccade.

NEXT SAC END Y RESOLUTI
ON

Vertical angular resolution (in screen pixels per
degree) at the end of the saccade. If samples are
loaded into the viewing session, this takes the
vertical resolution of the last sample in the saccade;
otherwise, the vertical resolution of the next
fixation is used.

NEXT SAC INDEX

Ordinal index of the next saccade.

NEXT SAC INPUT EVENTS

A list used to store new input events (time and
event code) that occur during the next saccade.

NEXT SAC IS RT END

Whether the next saccade is the end event of the
reaction time definition.

¢ NEXT SAC LABEL

Label of the next saccade.

NEXT SAC_MSG_COUNT ?

Number of visible messages associated with the
next saccade event'. This number will not exceed
the "Maximum Message Variables for Eye Event"
set in the Output/Analysis Preference Settings.

NEXT SAC MSG TEXT?

Text string of the messages associated with the next
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saccade’.

I NEXT SAC _MSG TIME ?

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
message'.

NEXT SAC NEAREST END
INTEREST AREA

Nearest interest area to which the end point of the
next saccade is assigned.

NEXT SAC NEAREST END
INTEREST AREA LABEL

Label for the nearest interest area to which the end
point of the next saccade is assigned.

NEXT SAC NEAREST START
INTEREST AREA

Nearest interest area to which the start point of the
next saccade is assigned.

NEXT SAC NEAREST START
_INTEREST AREA LABEL

Label for the nearest interest area to which the start
point of the next saccade is assigned.

NEXT SAC PEAK VELOCITY

Peak values of gaze velocity (in visual degrees per
second) of the next saccade. The peak velocity
calculation depends on whether the samples are
loaded in the viewing session.

NEXT SAC START INTEREST
_AREAS

Interest areas in which the start point of the next
saccade falls.

NEXT SAC START INTEREST
_AREA ID

The ID of the interest area to which the start point
of the next saccade is assigned.

NEXT SAC START INTEREST
_AREA INDEX

Index of the Interest area to which the start point of
the next saccade is assigned. This measure is the
same as the NEXT SAC START INTEREST
AREA _ID except when there are multiple interest
arcas with the same ID, or interest area IDs didn’t
start from 1.

NEXT SAC START INTEREST
_AREA LABEL

Label for the interest area to which the start
position of the next saccade is assigned.

¢ NEXT SAC START TIME

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START_ TIME") when
the next saccade ends.

NEXT SAC START X

X coordinate of the start point for the next saccade.

NEXT SAC START X RESOL
UTION

Horizontal angular resolution (in screen pixels per
degree) at the start of the saccade. If samples are
loaded into the viewing session, this takes the
horizontal resolution of the first sample in the
saccade; otherwise, the horizontal resolution of the
current fixation is used.

NEXT SAC START Y

Y coordinate of the start point for the next saccade.

NEXT SAC START Y RESOL
UTION

Vertical angular resolution (in screen pixels per
degree) at the start of the saccade. If samples are
loaded into the viewing session, this takes the
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vertical resolution of the first sample in the
saccade; otherwise, the vertical resolution of the
current fixation is used.

Note: Similar analyses are done for the previous
saccade (variables beginning with
PREVIOUS SACQ).

TRIAL FIXATION TOTAL Total number of fixations in a trial within the
currently-selected interest period.

TRIAL INDEX Sequential order of the trial in the recording.

TRIAL LABEL Label of the trial.

TRIAL SACCADE TOTAL Total number of saccades in the trial within the
currently selected interest period.

 TRIAL START TIME The start time (in milliseconds since EyeLink

tracker was activated; i.e., EDF file time) of the
trial. If a valid reaction time is found in the trial,
TRIAL START TIME will be set to the start time
of the reaction time definition instead.

VIDEO FRAME INDEX END Index of the video frame that was visible at the end
of the eye event.

VIDEO FRAME INDEX STAR | Index of the video frame that was visible at the start
T of the eye event. Note that all “VIDEO _” variables
are applicable to SceneLink recordings or some
Experiment Builder recordings only. For
SceneLink recordings, please check out the “Data
Loading” Preference Settings.

VIDEO NAME END Name of the video frame that was visible at the end
of the eye event.
VIDEO NAME START Name of the video frame that was visible at the

start of the eye event.

In addition to these default variables, other user-defined variables are also listed if they
have been defined in the EDF file (see section 7.2.1 on creating trial variable labels) or
created during the viewing session (see section 6.1.1 on using the trial variable manager).

Please note that output for the variables depends on the setting of the interest period filter
(see section 6.4.2 or Figure 6-22) - only those fixation and saccade events falling within
the active interest period will be reported. If the "Trimmed Spanned Fixation Duration"
setting of the "Data Filter" preference is enabled, the duration, start time, and end time of
the fixations that overlap with the start or end of the interest period will be trimmed
accordingly. If a valid reaction time definition is found in a trial, the

TRIAL START TIME will be set as the start as the reaction time definition; otherwise
this will be set as the start of trial recording (see section 6.5.3 on discussion of three time
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periods used in Data Viewer). As a result, the values of CURRENT FIX END and
CURRENT FIX START, which are calculated relative to TRIAL START TIME, will
be different depending on whether a valid reaction time definition is found for the trial.

Note 1: A run of fixations refers to a group of consecutive fixations that are directed
towards the same interest area. Thus, for example, if the interest areas of 10 fixations
are A A B A A A C A E D,theruncountwill be 7. The
following table summarizes the values for some relevant variables.

Variables A A B |A A A |C |]A |E |D
Run (not listed in the variable list) | 1 1 2 |3 3 3 4 |5 6 |7
CURRENT FIX INDEX 1 2 |3 |4 |5 |6 |7 18 |9 10
CURRENT FIX INTEREST A |1 1 2 1 1 1 3 1 5 |4

REA INDEX

CURRENT FIX INTEREST A [6 |6 |1 |6 |6 |6 |1 |6 |1 |1
REA_FIX COUNT

CURRENT FIX INTEREST A |1 |1 |1 |2 [2 |2 |1 [3 [1 |1
REA RUN ID

CURRENT FIX REFIX INTER [0 [0 |0 |1 |1 |1 |0 [1 [0 |oO
EST AREA

CURRENT FIX REFIX PREV_ [0 |0 |0 |1 |1 |1 |0 [1 [0 |1
INTEREST AREA

CURRENT FIX RUN INDEX 1 2 1 1 2 13 1 1 1 1

CURRENT FIX RUN SIZE 2 |2 |1 3 (3 [3 |1 [1 |1 |1

Note *: Messages written in the EDF file will be associated with an event closest in time.
So, for a fixation report, the message could appear during the preceding saccade
(PREVIOUS _SAC MSG #) or the following saccade (NEXT SAC MSG #). In very
rare cases, the message can be written to both saccade and fixation events if the message
was written out after the last sample of a fixation (or saccade) but before the first sample
of the following saccade (or fixation).

6.6.3 Configuring the Fixation Report

Data Viewer allows users to configure the fixation report (and, in a similar fashion, the
saccade report). A few options are available in the “Fixation Output Report” dialog box:
* Users can exclude some trials by entering a string in the “Exclude Trial String”
edit box. This string should be one message or part of a message within the trial
recording (see section 7.1 on defining the start and end of a trial) that uniquely
defines the subset of trials to be excluded.
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* The fixation report (and similarly the saccade report) allows the inclusion of
hidden events in the relative event variables [PREVIOUS and NEXT ]. This can
be done by clicking the “Include Hidden Events in Relative Variables” check box.
If the hidden events in relative variables are included in the analysis, then the
additional check box is available to specify whether or not to treat these hidden
events as missing data in these relative variables.

* To enable the alternative formatting and easy loading of string/text variables into
some statistics software packages with strict requirements, Data Viewer provides
an option of adding a pair of quotation marks for those variables.

* If the “Create Output Report for All Custom Interest Periods” option is enabled,
the Fixation Report will output data across all custom interest periods created in
the viewing session - the “Full Trial Period” or “Reaction Time Period” data is
only included in the report if it is the currently-selected interest period. Users can
save the data from multiple interest periods into a single file or into multiple
individual files.

* [fthe “Create One Report File Per EDF File” option is checked, Data Viewer will
create one report file for each of the EDF files loaded into the viewing session.

Note: If the “Exclude from Reports” property of a trial or trial group is checked, data
from that trial/trial group will not be included in the fixation report (and other reports).

6.7 Saccade Report

Saccade reports provide information about saccade events in the data file. Each row of
the report represents a single saccade event. Depending on the variables selected for
output, each row can contain information on the previous fixation and/or saccade, as well
as the next fixation and/or saccade.

6.7.1 Creating a Saccade Report

To create a saccade report choose:
Analysis — Reports — Saccade Report
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Figure 6-25. Creating a Saccade Report.

6.7.2 Variables in the Saccade Report

Currently, the saccade report includes the following saccade-related information: index,
start time, end time, start X) coordinates, end X) coordinates, duration, amplitude, angle,
direction, average velocity, peak velocity, interest areas of the current, previous, and next
saccades, and whether these saccades have been selected for analysis. It also contains the
following information on the previous fixation and the next fixation: angle, blink around,
direction, distance, duration, start time, end time, pupil size, trial span, the interest area in
which the fixation is located, the nearest interest area, and whether the fixation has been
selected for analysis. In addition, the report contains labels of the data file, data file, and
individual trials, as well as other user-defined variables (see section 6.6.2 Variables in the
Fixation Report for the complete list of variables and their meanings).

EyeLink Data Viewer ©2002-2017 SR Research Ltd. 133



~eh Saccade Output Report .
~Available Variables ~Selected Variables
CURRENT_SAC_ADJUSTED ﬂ RECORDING_SESSION_LABEL

CURRENT_SAC_AMPLITUDE TRIAL_INDEX

CURRENT_SAC_BLINK_START

CURRENT_SAC_CONTAINS_BLINK v
Rl | »
~Variable Definition

CURRENT_SAC_ANGLE 55 N
CURRENT_SAC_AVG_VELOCITY _I _I
CURRENT_SAC_BLINK_DURATION « I - I
CURRENT_SAC_BLINK_END

Exdude Trial String : |
[~ Indude Hidden Events in Relative (Previous / Next) Variables.
[~ TreatHidden Events as Missing Values in Relative (Previous [ Next) Variables
[~ Place Quotes ( ") Around String / Text Variables
[~ Create Output Report For All Custom Interest Periods
{* ReportIP Datain One Fle. . ReportIP Data in Multiple Files,
[~ Create one Report File per EDF File
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Figure 6-26. Variables in a Saccade Report.

6.8 Interest Area Report

Interest area reports provide information concerning each interest area in a trial. Each

row of the report represents an interest area, arranged in an ascending order of the interest

area ID.
6.8.1 Obtaining an Interest Area Report
To obtain an interest area report,

1) From the application menus, choose:
Analysis -> Reports -> Interest Area Report

EyeLink Data Viewer ©2002-2017 SR Research Ltd.

134



~e Eyelink Data Viewer Version 2.6.0 - Untitled.evs (C:\Temp\Untitled)
File Edit | Analysis Window Help

T e s [ [ P
; L R P | <o
Trial Variable Manager ... Fixation Report ... Ctrl+F || -2 ¢ e
LT Trial Variable Value Editor ... Saccade Report ...
e T =
I T Trial Report ... Ctrl+T O Dlj ‘ IE
. Lgtitled.evs Sample Report ...
-5 picture Message Report
: picture: Trial: 1 i —
: picture: Trial: 2 Aggregate Event Statistics ... e
i picture: Trial: 3 Aggregate Interest Area Report ... e
- . Interest Area Templates Time Course (Binning) Analysis ...
Import Report Variable Selection ... A3 -
Export Report Variable Selection ...
P nichiure: Trial: 1: Fivatinn: 179 me AI

Figure 6-27. Creating an Interest Area Report.

2) In the following output report dialog, select the variables in the list of available output
variables (left panel) and press ">>" to enter the variables into the list of selected output
variables. You can also drag the selected variables and drop them to the intended position
in the selected variables list.

* To remove variables from the output list, simply select the variables and press <<.
You can also drag the selected variables and drop them back to the Available
Variables list.

* To change the order in which the variables are listed, simply select one variable
and use the 4 or ¥ button to move it to the desired position. Repeat this step
until all variables are in the right position. You can also select the variable(s) and
then drag and drop them to the intended position.

* Data Viewer supports exporting and importing of variable selection across
viewing sessions. For example, users may go through each of the output reports to
configure the selection of variables in an intended order, then export the variable
selection into a property file by clicking “Analysis -> Reports -> Export Report
Variable Selection”. For all future viewing sessions, the variable selection in the
reports can be automated by importing the previously saved property file (through
“Analysis -> Reports -> Import Report Variable Selection”).
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Figure 6-28. Variables in an Interest Area Report.

3) Once all the desired variables have been entered into the output list, press the Next
button.

4) In the Save dialog box, browse to the directory in which you want to save the output
report. The default output directory can be configured through "General Preferences".

5) In the File name text box, enter the name for the document and choose the appropriate
file extension. Note, if the output report file extension is set to "All Files" and the file
name does not contain an extension, the file name is appended with a ".txt" by default.

6) Press the "Save" button.
Data Viewer allows users to configure the interest area report. Users can exclude some
trials by entering a string in the "Exclude Trial String" edit box. This string should be one

message or part of a message within the scope of the trial recording that uniquely defines
that subset of trials to be excluded. In addition, to enable correct loading of string/text
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variables in some statistics software, the Viewer also has an option of adding a pair of

quotation marks for such variables.

6.8.2 Variables in the Interest Area Report

Currently, the interest area report provides information for the following variables. Please
note that the values of all variables marked with a “q” sign are calculated relative to
TRIAL START TIME, and therefore will be different depending on whether a valid
reaction time is found in the trial. Output for most variables in this report will change if a

different interest period is used.

Field

Contents

RECORDING SESSION LABEL

Label of the data file.

DATA FILE

File name of the recording.

EYE USED Records which eye's data (LEFT or RIGHT) was
used to create the report.
IA AREA Pixel area for the current interest area.

IA_AVERAGE FIX PUPIL SIZE

Average pupil size across all fixations in the
interest area.

IA_ BOTTOM

Y coordinate of the lower-right corner of a
rectangular or elliptical interest area (““.” For a
freehand interest area).

IA DWELL TIME

The sum of the duration across all fixations that
fell in the current interest area.

IA DWELL TIME %

Percentage of trial time spent on the current
interest area (IA_ DWELL TIME
/TRIAL_DWELL TIME, the latter is the summed
duration of all fixations within the trial interest
period).

[A_ DYNAMIC Whether the current interest area is a dynamic one
(true or false).
IA_END TIME Time (relative to the start of the current interest

period) when the last instance of the current
interest area ends. This variable is applicable to
dynamic interest areas only.

IA FIRST FIXATION DURATIO
N

Duration of the first fixation event that was within
the current interest area.

IA_FIRST FIXATION INDEX

Ordinal sequence of the first fixation that was
within the current interest area.

IA FIRST FIXATION RUN IND
EX

The number of runs of fixations that have occurred
when a first fixation is made to an interest area.
The current run is also included in the tally.

Y IA_FIRST FIXATION TIME

Start time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
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first fixation to enter the current interest area.

IA_FIRST FIXATION VISITED
IA_COUNT

This reports the number of different interest areas
visited so far before the first fixation is made to the
current interest area.

IA FIRST FIXATION X

The X position of the first fixation event within
the current interest area.

IA FIRST FIXATION Y

The Y position of the first fixation event within the
current interest area.

IA_FIRST FIX PROGRESSIVE

Checks whether later interest areas have been
visited before the first fixation enters the current
interest area. 1 if NO higher IA ID in earlier
fixations before the first fixation in the current
interest area; 0 otherwise. This measure is useful
in reading to check whether the first run of
fixations in this interest area is in fact first-pass
fixations.

IA FIRST RUN DWELL TIME

Dwell time of the first run (i.e., the sum of the
duration of all fixations in the first run of fixations
within the current interest area). Note that this
measure does not include the duration of the
saccades. You could retrieve the total time of the
first run in an interest area by subtracting
IA_FIRST RUN _START TIME from
IA_FIRST RUN _END TIME. These two
variables correspond to the start time of the first
fixation and the end time of the last fixation,
respectively.

Y IA_FIRST RUN END TIME

End time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
first run of fixations in the current interest area.

IA_FIRST RUN FIXATION %

Percentage of all fixations in a trial falling in the
first run of the current interest area.

IA_FIRST RUN FIXATION CO
UNT

Number of all fixations in a trial falling in the first
run of the current interest area.

Y IA_FIRST RUN_START TIME

Start time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
first run of fixations in the current interest area.

IA FIRST SACCADE AMPLITU
DE

Amplitude (in degrees of visual angle) of the first
saccade entering into the current interest area.

IA_FIRST SACCADE ANGLE

Angle between the horizontal plane and the
direction of the first saccade entering into the
current interest area.

1A _FIRST SACCADE END TI

End time (in milliseconds relative to the start of
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ME

the current trial "TRIAL START TIME") of the
saccade that first landed within the current interest
area.

IA _FIRST SACCADE INDEX

Ordinal index of the saccade in a trial which first
landed within the current interest area.

YIA_FIRST SACCADE START
TIME

Start time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
saccade that first landed within the current interest
area.

A FIXATION %

Percentage of all fixations in a trial falling in the
current interest area.

IA_FIXATION COUNT

Total number of fixations falling in the interest
area.

IA_FSA COUNT

The number of fixations, with (fixation N) starting
in the current row of interest area and (fixation N +
fixation_skip count) ending in the current column
of interest area. Please see section 6.8.3.1
“Fixation Sequence Analysis” for detailed
explanation of this variable.

IA_FSA DURATION

The summed duration for all fixations, with
(fixation N) starting in the current row of interest
area and (fixation N + fixation_skip count) ending
in the current column of interest area. Please see
section 6.8.3.1 “Fixation Sequence Analysis” for
detailed explanation of this variable.

IA_GROUP

Group label for the current interest area.

IA ID

Ordinal ID of the current interest area.

IA_INSTANCE COUNT

The total number of individual instances of the
current dynamic interest area.

IA LABEL Label for the current interest area.
IA_LAST FIXATION DURATIO | Duration of the last fixation event that was within
N the current interest area.

IA LAST FIXATION RUN

Index of run that the last fixation is in.

9IA_LAST FIXATION TIME

Start time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
last fixation to enter the current interest area.

IA_ LAST FIXATION X

The X position of the last fixation event that was
within the current interest area.

IA LAST FIXATION Y

The Y position of the last fixation event that was
within the current interest area.

IA_ LAST RUN DWELL TIME

Dwell time of the last run (i.e., the sum of the
duration of all fixations in the last run of fixations
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within the current interest area).

fIA_ LAST RUN END TIME

End time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
last run of fixations in the current interest area.

IA_LAST RUN FIXATION %

Percentage of all fixations in a trial falling in the
last run in the current interest area.

IA_LAST RUN FIXATION COU
NT

Number of all fixations in a trial falling in the last
run in the current interest area.

9IA_ LAST RUN START TIME

Start time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
last run of fixations in the current interest area.

IA_LAST SACCADE AMPLITU
DE

Amplitude (in degree of visual angle) of the last
saccade entering into the current interest area.

IA LAST SACCADE ANGLE

Angle between the horizontal plane and the
direction of the last saccade entering into the
current interest area.

YIA_LAST SACCADE END TI
ME

End time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
last saccade that landed within the current interest
area.

IA_ LAST SACCADE INDEX

Ordinal index of the last saccade in a trial that
landed within the current interest area.

1A LAST SACCADE START T
IME

Start time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
last saccade that landed within the current interest
area.

IA LEFT X coordinate of the upper-left corner of a
rectangular or elliptical interest area (““.” For a
freehand interest area).

IA LEGAL IA_LEGAL for an interest area N will be equal to

1 only if the first fixation in interest area N was
preceded at some point earlier in the trial by a
fixation in interest area (N-1). IA LEGAL will be
0 if the first fixation in interest area N was not
preceded at some point earlier in the trial by a
fixation in interest area (N-1). This variable is
relevant for experiments that run in a contingent
display paradigm, as it ensures that readers could
see the target area before actually fixating it.

IA LEGAL IMMEDIATE

IA_ LEGAL IMMEDIATE for an interest area N
will be equal to 1 only if the first fixation in
interest area N was immediately preceded by a
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fixation in interest area (N-1).

IA_ LEGAL IMMEDIATE will be 0 if the first
fixation in interest area N was not immediately
preceded by a fixation in interest area (N-1). This
variable is relevant for experiments that run in a
contingent display paradigm, as it ensures that
readers could see the target area before actually
fixating it.

IA MAX FIX PUPIL SIZE

Maximum pupil size among all fixations in the
interest area. Note this measure does not represent
the maximum pupil size within a fixation — rather
it is the largest CURRENT FIX PUPIL SIZE
value for fixations in the IA, and
CURRENT FIX PUPIL SIZE represents the
average pupil size during that fixation.

IA MIN FIX PUPIL SIZE

Minimum pupil size among all fixations falling
within the interest area. Note this measure does not
represent the minimum pupil size within a fixation.

IA_POINTS

List of points for a freehand interest area

[

(otherwise “.” is reported).

IA_ REGRESSION_IN

Whether the current interest area received at least
one regression from later interest areas (e.g., later
parts of the sentence). 1 if interest area was
entered from a higher IA_ID (from the right in
English); 0 if not.

IA_REGRESSION IN_COUNT

Number of times interest area was entered from a
higher IA ID (from the right in English).

IA_ REGRESSION OUT

Whether regression(s) was made from the current
interest area to earlier interest areas (e.g., previous
parts of the sentence) prior to leaving that interest
area in a forward direction. 1 if a saccade exits the
current interest area to a lower IA_ID (to the left in
English) before a later interest area was fixated; 0
if not.

IA_REGRESSION_OUT COUNT

Number of times interest area was exited to a
lower IA_ID (to the left in English) before a higher
IA 1D was fixated in the trial.

IA_ REGRESSION OUT FULL

Whether regression(s) was made from the current
interest area to earlier interest areas (e.g., previous
parts of the sentence). 1 if a saccade exits the
current interest area to a lower IA_ID (to the left in
English); 0 if not. Note that

EyeLink Data Viewer

©2002-2017 SR Research Ltd. 141




IA_REGRESSION OUT only considers first-pass
regressions whereas
IA_REGRESSION OUT FULL considers all
regressions, regardless whether later interest areas
have been visited or not.

IA_REGRESSION OUT FULL C
OUNT

Number of times interest area was exited to a
lower IA 1D (to the left in English).

IA_ REGRESSION PATH DURA
TION

The summed fixation duration from when the
current interest area is first fixated until the eyes
enter an interest area with a higher IA ID.

IA RIGHT

X coordinate of the lower-right corner of a
rectangular or elliptical interest area (““.” For a
freehand interest area).

IA RUN_COUNT

Number of times the Interest Area was entered and
left (runs).

IA_ SECOND FIXATION DURA
TION

Duration of the second fixation in A, regardless of
run.

IA_ SECOND FIXATION RUN

Index of run that the second fixation is in.

9 IA_ SECOND FIXATION TIME

Time (in milliseconds relative to the start of the
current trial "TRIAL START TIME") of the
second fixation in IA, regardless of run.

IA_ SECOND FIXATION X

The X position of the second fixation event that
was within the current interest area.

IA_ SECOND FIXATION Y

The Y position of the second fixation event that
was within the current interest area.

IA_SECOND RUN DWELL TIM
E

Dwell time for the second run (i.e. the sum of the
duration across all fixations of the second run of
fixations within the current interest area).

9 IA_SECOND RUN_END TIME

End time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
second run of fixations in the current interest area.

IA_ SECOND RUN FIXATION
%

Percentage of all fixations in a trial falling in the
second run of the current interest area.

IA_ SECOND RUN _FIXATION
COUNT

Number of all fixations in a trial falling in the
second run in the current interest area.

YIA_SECOND RUN_START TI
ME

Start time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
second run of fixations in the current interest area.

IA_SELECTIVE REGRESSION
PATH DURATION

Duration of fixations and refixations of the current
interest area before the eyes enter an interest area
with a higher ID.

[IA SKIP

An interest area is considered skipped (i.e.,
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IA_SKIP = 1) if no fixation occurred in first-pass
reading.

IA_SPILLOVER

The duration of the first fixation made on 'interest
area (N+1)' after leaving 'interest area N' in first
pass.

IA_START TIME

Time (relative to the start of the current interest
period) when the first instance of the current
interest area starts. This variable is applicable to
dynamic interest areas only.

IA THIRD FIXATION DURATI
ON

Duration of the third fixation in IA, regardless of
run.

IA THIRD FIXATION RUN

Index of run that the third fixation is in.

YIA_THIRD FIXATION TIME

Time (in milliseconds relative to the start of the
current trial "TRIAL START_ TIME") of the third
fixation in IA, regardless of run.

IA THIRD FIXATION X

The X position of the third fixation event that was
within the current interest area.

IA THIRD FIXATION Y

The Y position of the third fixation event that was
within the current interest area.

IA THIRD RUN DWELL TIME

Dwell time for third run (i.e. the sum of the
duration across all fixations in the third run of
fixations within the current interest area).

YIA_ THIRD RUN END TIME

End time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
third run of fixations in the current interest area.

IA THIRD RUN FIXATION %

Percentage of all fixations in a trial falling in the
third run of the current interest area.

IA THIRD RUN FIXATION CO
UNT

Number of all fixations in a trial falling in the third
run in the current interest area.

YIA_ THIRD RUN START TIME

Start time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
third run of fixations in the current interest area.

IA TOP Y coordinate of the upper-left corner of a
rectangular or elliptical interest area (““.” For a
freehand interest area).

IA TYPE Type of interest area (rectangular, elliptical, or

freehand).

IP END EVENT MATCHED

Whether an event that matches the end of the
selected interest period has been found in the
current trial.

IP_ END TIME

End time (in milliseconds since EyeLink tracker
was activated; i.e., EDF file time) of the interest
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period.

IP_INDEX The index (starting from 1) of interest period
created by the user. For the Full-Trial period or
Reaction-Time Period, a missing value is given as
they are not created by the user.

IP_ LABEL Label of the current interest period selected in the

viewing session.

IP START EVENT MATCHED

Whether an event that matches the start of the
selected interest period has been found in the
current trial.

IP START TIME

Start time (in milliseconds since EyeLink tracker
was activated; i.e., EDF file time) of the interest
period.

REPORTING METHOD

Whether a fixation-based or sample-based
calculation is used in creating the interest area
report. The reporting method can be configured
through "Output/Analysis Preference -> Perform
Sample-based Calculation". See section “5.9.25
Output Reports and Preferences” for information
on the difference between sample and fixation-
based calculations.

TRIAL DWELL TIME

Dwell time (i.e., summation of all fixation
durations) for the trial within the currently-selected
interest period.

TRIAL FIXATION COUNT

Total number of fixations in the trial within the
currently-selected interest period.

TRIAL IA COUNT

Reports the total number of interest areas found in
the trial.

TRIAL INDEX

Sequential order of the trial in the recording.

TRIAL LABEL

Label of the trial.

¢ TRIAL START TIME

The start time (in milliseconds since EyeLink
tracker was activated; i.e., EDF file time) of the
trial. If a valid reaction time is found in the trial,
TRIAL START TIME will be set to the start time
of the reaction time definition instead.

TRIAL TOTAL VISITED IA C
OUNT

Reports total number of unique interest areas
visited in the trial.

Besides these default variables, additional trial variables will be listed if they have been
defined in the EDF file (see trial variable labels) or created during the viewing session

(see trial variable manager)..
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6.8.3 Using Interest Area Report

The output in the interest area report depends on the setting of the interest period filter
(see section 6.4.2 or Figure 6-22) — only those fixation and saccade events falling within
the active interest period will be reported. If a valid reaction time definition is found in a
trial, the TRIAL START TIME will be set as the start as the reaction time definition;
otherwise this will be set as the start of trial recording (see section 6.5.3 on discussion of
three time periods used in Data Viewer). As a result, the values of all those variables
marked with a “q” symbol, which are calculated relative to TRIAL START TIME, will
be different depending on whether a valid reaction time is found in the trial. If the
"Trimmed Spanned Fixation Duration" setting of the "Data Filter" preference is enabled,
the duration, start time, and end time of the fixations that overlap with the start or end of
the interest period will be trimmed accordingly.

Some variables in the interest area report may be influenced by outlier fixations that do
not belong to any interest area. For example, the presence of an outlier fixation may
break the run of fixations on a particular interest area and therefore shortens the measure
of IA_FIRST RUN DWELL TIME and increases the IA RUN_COUNT value.
Therefore, users should ensure that all fixations are assigned to a particular interest area
before creating an interest area report, if "run"-related measures are important. Users can
either manually move the position of those outlier fixations or, more conveniently, enable
the "Use Nearest Interest Area for Outlier Fixations" option of the Output/Analysis
preference settings.

Interest area reports are designed to support analysis of data from different research
paradigms and, therefore, users will typically only need to use a small number of
variables in one output. If you have lots of interest areas in a trial, including
IA_FSA _COUNT and IA_FSA DURATION in the output report may cause Data
Viewer to take a very long time to generate the report. A progress dialog (see Figure
6-29) will be displayed while creating the report. Users may abort the process by
pressing the “Cancel” button.

( i Creating Report
Session 0; Trial 1; 14 20
L

Cancel I

Figure 6-29. Progress Dialog Box Displayed when Creating the Interest Area Report

6.8.3.1 Fixation Sequence Analysis

Variables IA_ FSA COUNT and IA_ FSA DURATION are used primarily for fixation
sequence analysis (i. e., examination of the frequency of saccades directed from the
current interest area to all interest areas). If there are N interest areas in a trial, this will
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generate N columns in the output report, with column labels being IA_ FSA COUNT 1
to JA_ FSA COUNT N for counts and IA_ FSA DURATION 1 to

IA_FSA DURATION N for duration outputs. Each column in the output file reports the
number of fixations coming to one particular interest area from each of all possible
interest areas. Each row reports number of fixations starting from the current interest
area and ending at each of the interest areas (when “Fixation Skip Count” in the
Output/Analysis preference settings is set to 1).

Interest Area 1 2 3 4 5 6 7
Text He said: "Truth is a pathless land".
Fixation Sequence 1—2 — 3 > 4355

6—»7 =8 :9

/

10
1A IA FSA_ | IA FSA_ | IA_FSA_|IA FSA_ | IA FSA_|IA FSA_ | IA FSA_
. COUNT_ | COUNT_ | COUNT_ | COUNT_ | COUNT | COUNT | COUNT_
ID 1 2 3 4 5 6 7
IA_LABEL | He said: “Truth | Is a pathless | Land”.
1 | He 0 1 0 0 0 0 0
2 | said: 0 0 1 0 0 0 0
3 | ‘Truth 0 0 0 1 0 1 0
4 |is 0 0 0 0 0 1 0
5 |a 0 0 0 0 0 0 0
6 | pathless 0 0 1 0 0 1 1
7 | land?. 0 0 0 0 0 1 0

The above example illustrates the use of fixation sequence analysis. Take interest area #6
(“pathless”) for example. It received four fixations in total. These fixations came from
interest area #3 (Fixation 4), #6 (Fixation 5), #4 (Fixation 8), and #7 (Fixation 10). This
is reported in the column “IA_ FSA COUNT 6. There are three fixations starting from
interest area #6: Fixation 5 (to [A #6), Fixation 6 (to [A #3), and Fixation 9 (to [A #7).
This is reported in the row with IA_ID being 6 (“pathless”).

Please note that users should also check the setting for “Fixation Skip Count” in the
Output/Analysis preference settings. The fixation skip count defines the number (should
be an integer no less than 1) of fixations to skip when looking for the next interest area to
use in the fixation sequence analysis variables of the Interest Area report. The default
setting is 1 and uses the next available fixation for the sequence analysis (from the
current interest area to all interest area). A value of 2 uses the fixation following the next
one for the analysis, and so on.
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6.8.3.2 Regression Analysis

A lot of the variables in the interest area report are intended for the regression analysis,
especially in reading research. The following example illustrates the use of the interest
area report in the regression analysis.

1A ID 1 2 3 4 516 7
IA LABEL He said: | “Truth | Is a | Pathless Land”.
IA DWELL TIME F1 F2 F3+ | F7 O|F4+F5+ |F9
F6 F8
+ F10
IA FIXATION 1 1 2 1 04 1
~COUNT
IA RUN COUNT 1 2 1 3 1
IA_FIRST FIXATION 2 3 7 4 9
_INDEX
IA_FIRST FIXATION 1 2 3 6 4 8
_RUN _INDEX [1] [1, [1,2, [[1,2,3, [1,2,3,6] |[1,2,3,
2] 3] 6, 3, 4] 6, 3, 4,
6, 7]
IA_FIRST FIXATION 0 1 2 4 3 5
_VISITED TA COUNT [] [1] [1,2] [[1,2,3, [1,2,3] [1,2,3,
6] 6, 4]
IA_FIRST FIX 1 1 1 0 1 1
PROGRESSIVE
IA_FIRST FIXATION F1 F2 F3 F7 F4 F9
DURATION
IA_FIRST RUN F1 F2 F3 F7 F4 + F5 F9
DWELL TIME
IA_SECOND FIXATION F6 F5
DURATION
IA_SECOND FIXATION 2 1
~RUN
IA_ SECOND RUN F6 F8
_DWELL TIME
IA REGRESSION IN 0 0 1 0 1 0
IA_ REGRESSION IN 0 0 1 0 1 0
COUNT
IA_ REGRESSION 0 0 0 0 1 1
OUT
IA_ REGRESSION 0 0 0 0 1 1
OUT COUNT
IA_ REGRESSION F1 F2 F3 F7 F4+F5+ |F9+
_PATH DURATION F6 F10
+F7 +F8
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IA_SELECTIVE FI |[F2 [F3 F7 . [F4+F5+ [F9
_REGRESSION_PATH F8
_DURATION

Take interest area #6 (“pathless”) for example. A REGRESSION PATH DURATION
includes the first pass fixations on the interest area (F4 + F5), time spent in previous parts
of the sentence following regressive eye movements (F6 + F7), and time due to
refixations coming from the left before the eyes move past the interest area (F8). The
calculation of IA_ SELECTIVE REGRESSION PATH DURATION only includes the
first run fixation on the interest area (F4+F5) and the refixations on the interest area (F8)
before the eyes enter next interest area with a higher IA_ID (“land”).

IA_FIRST FIX PROGRESSIVE checks whether later interest areas have been visited
before the first fixation enters the current interest area. Therefore, this variable would be
0 for the interest area “is” because it was fixated on Fixation 7 while Fixations 4 and 5
were on a later part of the sentence (“pathless”). IA_ REGRESSION OUT checks
whether at least one regression was made from the current interest area to previous parts
of the sentence prior to leaving that interest area in a forward direction. Therefore, the
transition from F5 — F6 makes this flag true for the interest area #6 (labeled as
“pathless””). IA REGRESSION IN checks whether a given interest area received at
least one regression from later parts of the sentence. Therefore, this is true for both
interest areas #3 “truth” (F5 — F6) and #6 “pathless” (F9 — F10).

6.8.4 Configuring the Interest Area Report

See section 6.5.4 “Configuring the Trial Report” for a review of these identical
configuration settings.

6.9 Sample Report

Sample reports provide information concerning each sample in a trial. The sample report
option will not be available if the samples are not loaded into a viewing session. As in
the other reports, the sample report only outputs samples that fall within the active
interest period for the trial.

6.9.1 Loading Samples into a Viewing Session

The sample report option will not be available from the Analysis menu if samples are not
loaded into the viewing session. To make sample data available to a viewing session,
please first change the data loading preferences and then reload the EDF files.

1) Before loading any EDF files, please go to "Start -> Programs -> SR Research ->
EyeLink -> Data Viewer" to start the software.

2) Once the application starts up, click the "Preferences" tab and go to "Data
Loading" preferences. Check the "Load Samples" option. If you want this changes
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to be persistent over future viewing sessions, you may consider saving this as the
default setting. This can be done by selecting the topmost preference tree node,

clicking the right mouse buttons and selecting "Save Properties as Defaults".

3) Now, start loading in the EDF files.

6.9.2 Creating a Sample Report

To create an output report for samples,
1) From the application menus, choose:
Analysis -> Reports -> Sample Report

~eh EyeLink Data Viewer Version 2.6.0 - Untitled.evs (C:\Temp\Untitled)

File Edit | Analysis Window Help

Reports »
| [ i -
Trial Variable Manager ...

Trial Variable Value Editor ...
& Data l Reaction Time Manager ...

, Untitled.evs
=8 picture
|
picture: Trial: 2
i picture: Trial: 3
. Interest Area Templates

E-E-E

Recording Event Sequence Data ...
Ctrl+F

Fixation Report ...

Saccade Report ...
Interest Area Report ...
Trial Report ... Ctrl+T

Sample Report ...

Message Report ...

Aggregate Event Statistics ...
Aggregate Interest Area Report ... =
Time Course (Binning) Analysis ...

Import Report Variable Selection ...
Export Report Variable Selection ...

P nicture: Trial: 1: Fixation: 179 ms

Al

Figure 6-30. Creating a Sample Report.

2) In the following output report dialog, select the variables in the list of available output
variables (left panel) and press ">>" to enter the variables into the list of selected output
variables. You can also drag the selected variables and drop them to the intended position

in the selected variables list.
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~gh\ Sample Output Report X|

~Available Variables —Selected Variables

AVERAGE_ACCELERATION_X il RECORDING_SESSION_LABEL
AVERAGE_ACCELERATION_Y TRIAL_INDEX
AVERAGE_GAZE_X
AVERAGE_GAZE_Y LI
AVERAGE_INTEREST_AREAS « I
AVERAGE_INTEREST_AREA_DATA
AVERAGE_INTEREST_AREA_DISTANCE
AVERAGE_INTEREST_AREA_ID
AVERAGE_INTEREST_AREA_LABEL |

il

~Variable Definition

Exclude Trial String :
[~ Indude Hidden Events in Relative (Previous / Next) Variables.
|~ TreatHidden Events as Missing Values in Relative (Previous / Next) Variables
[~ Place Quotes (™) Around String / Text Variables
[~ Create Output Report For All Custom Interest Periods
{* ReportIP Datain One File, € Report IP Data in Multiple Files,
[~ Create one Report File per EDF File
[~ Re-sample Original Recordings with a Lower Sampling Rate.

Intended Output Sampling Rate (Hz): I
Reset | Undo | Cancel | Next |

Figure 6-31. Variables in a Sample Report.

* To remove variables from the output list, simply select the variables and press <<.
You can also drag the selected variables and drop them back to the Available
Variables list.

* To change the order in which the variables are listed, simply select one variable
and use the 4 or ¥ button to move it to the desired position. Repeat this step
until all variables are in the right position. You can also select the variable(s) and
then drag and drop them to the intended position.

* Data Viewer supports exporting and importing of variable selection across
viewing sessions. For example, users may go through each of the output reports to
configure the selection of variables in an intended order, then export the variable
selection into a property file by clicking “Analysis -> Reports -> Export Report
Variable Selection”. For all future viewing sessions, the variable selection in the
reports can be automated by importing the previously saved property file (through
“Analysis -> Reports -> Import Report Variable Selection”).
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3) Once all the desired variables have been entered into the output list, press the Next
button.

4) In the Save dialog box, browse to the directory in which you want to save the output
report. The default output directory can be configured through "General Preferences".

5) In the File name text box, enter the name for the document and choose the appropriate
file extension. Note, if the output report file extension is set to "All Files" and the file
name does not contain an extension, the file name is appended with a ".txt" by default.

6) Press the "Save" button.
Note: Depending on the size of the EDF file(s), generating this report may take a long
time.

6.9.3 Variables in the Sample Report

Currently, the sample output report provides output for the following variables:

Field Contents

RECORDING SESSION LABEL Label of the data file.

AVERAGE ACCELERATION X Acceleration value (in degree/second/second)
along the x axis averaged across both eyes'.

AVERAGE ACCELERATION_ Y Acceleration value (in degree/second/second)
along the y axis averaged across both eyes'.

AVERAGE GAZE X Gaze coordinate along the x axis averaged across
both eyes'.

AVERAGE GAZE'Y Gaze coordinate along the y axis averaged across
both eyes'.

AVERAGE IN BLINK This will be true when both LEFT IN BLINK

and RIGHT IN BLINK are true, false when
both LEFT IN BLINK and RIGHT IN BLINK
are false, and a missing value (.) when the two
don't match. For monocular recordings with the
Cyclopean Mode option enabled
(Output/Analysis preferences), it uses the blink
status of the tracked eye (LEFT IN BLINK or
RIGHT IN_ BLINK). The output of this variable
may be affected by the “Blink Correction for
Pupil Size Calculations” settings in the “Data
Filters” preferences.

AVERAGE IN SACCADE This will be true when both
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LEFT IN SACCADE and
RIGHT IN SACCADE are true, false when
both LEFT IN SACCADE and
RIGHT IN SACCADE are false, and a missing
value (.) when the two don't match. For
monocular recordings with the Cyclopean Mode
option enabled (Output/Analysis preferences), it
uses the saccade status of the tracked eye
(LEFT _IN_SACCADE or

RIGHT IN SACCADE).

AVERAGE _INTEREST AREAS

List of interest areas in which the current sample
(averaged across both eyes) falls.

AVERAGE_INTEREST AREA DA
TA

Reports as a list the data (interest area type,
dynamic/static interest area, and coordinate data)
of the interest area in which the current sample
(averaged across both eyes) falls.

AVERAGE INTEREST AREA DIS
TANCE

Distance (in degrees of visual angle) between the
current sample (averaged across both eyes) and
the center of the interest area in which the
sample falls. For a freehand interest area, this
reports the distance to the bound’s center (the
center of the bounding rectangle for the freehand
interest area).

AVERAGE INTEREST AREA ID

ID of the interest area in which the current
sample (averaged across both eyes ') falls.

AVERAGE _INTEREST AREA LA
BEL

Label of the interest area in which the current
sample (averaged across both eyes ') falls.

AVERAGE _INTEREST AREA PI
XEL AREA

Pixel area of the interest area in which the
current sample (averaged across both eyes) falls.

AVERAGE PUPIL SIZE

Pupil size of the current sample across two eyes.

AVERAGE VELOCITY X

Velocity value (in degrees/second) along the x
axis averaged across both eyes'.

AVERAGE VELOCITY Y

Velocity value (in degrees/second) along the y
axis averaged across both eyes'.

DATA FILE

File name of the EDF data file.

EYE TRACKED

Reports which eye (left, right, both) is tracked
for the current trial.

HTARGET DISTANCE *

Distance between the head target and eye camera
(in millimeters) for an EyeLink Remote
recording. Returns a missing value if the head
target was missing or if the data was recorded
with a non-Remote eye tracker.
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HTARGET FLAGS *

Flags used to indicate the head target tracking
status ("............ "if target tracking is ok;
otherwise error code) for an EyeLink Remote
recording. Returns a missing value if the data
was recorded with non-Remote eye tracker.

HTARGET X*

X position of the head target in camera
coordinates for an EyeLink Remote recording.
Returns a missing value if the head target was
missing or if the data was recorded with a non-
Remote eye tracker.

HTARGET Y *

Y position of the head target in camera
coordinates for an EyeLink Remote recording.
Returns a missing value if the head target was
missing or if the data was recorded with a non-
Remote eye tracker.

I[P DURATION

Duration of the interest period in milliseconds.

IP END EVENT MATCHED

Whether an event that matches the end of the
selected interest period has been found in the
current trial.

IP_ END TIME

End time (in milliseconds since EyeLink tracker
was activated) of the interest period.

IP_INDEX

The index (starting from 1) of interest period
created by the user. For the Full-Trial period or
Reaction-Time Period, a missing value is given
as they are not created by the user.

IP LABEL

Label of the current interest period selected in
the viewing session.

IP START EVENT MATCHED

Whether an event that matches the start of the
selected interest period has been found in the
current trial.

IP START TIME

Start time (in milliseconds since EyeLink tracker
was activated) of the interest period.

LEFT ACCELERATION X

Acceleration value (in degree/second/second) of
the left eye along the x axis.

LEFT ACCELERATION Y

Acceleration value (in degree/second/second) of
the left eye along the y axis.

LEFT FIX INDEX

Ordinal sequence of the fixation in the trial to
which the left-eye sample belongs.

LEFT GAZE X

Left eye gaze coordinate along the x axis.

LEFT GAZE Y

Left eye gaze coordinate along the y axis.

LEFT INTEREST AREAS

List of interest areas in which the left-eye sample
falls.
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LEFT INTEREST AREA DATA

Reports the data (interest area type,
dynamic/static interest area, and coordinate data)
of the interest area in which the left-eye sample
falls.

LEFT INTEREST AREA DISTAN
CE

Distance (in degrees of visual angle) between the
current left-eye sample and the center of the
interest area in which the sample falls.

LEFT INTEREST AREA ID

Index of the interest area in which the left-eye
sample falls.

LEFT INTEREST AREA LABEL

Label of the interest area in which the left-eye
sample falls.

LEFT INTEREST AREA PIXEL
AREA

Pixel area of the interest area in which the left-
eye sample falls.

LEFT IN BLINK

Whether the left eye is in a blink (1 if true, 0 if
false). The output of this variable may be
affected by the “Blink Correction for Pupil Size
Calculations” settings in the “Data Filters”
preferences.

LEFT IN SACCADE

Whether the left eye is in a saccade (1 if true, 0 if
false).

LEFT PUPIL SIZE

Left eye pupil size of the current sample.

LEFT SACCADE_INDEX

Ordinal sequence of the saccade in the trial to
which the left-eye sample belongs.

LEFT VELOCITY X

Velocity value (in degree/second) of the left eye
along the x axis.

LEFT VELOCITY Y

Velocity value (in degree/second) of the left eye
along the y axis.

RESOLUTION X

Horizontal angular resolution (in screen pixels
per degree) for the sample.

RESOLUTION Y

Vertical angular resolution (in screen pixels per
degree) for the sample.

RIGHT ACCELERATION X

Acceleration value (in degree/second/second) of
the right eye along the x axis.

RIGHT ACCELERATION Y

Acceleration value (in degree/second/second) of
the right eye along the y axis.

RIGHT FIX INDEX

Ordinal sequence of the fixation in the trial to
which the right-eye sample belongs.

RIGHT GAZE X

Right eye gaze coordinate along the x axis.

RIGHT GAZE Y

Right eye gaze coordinate along the y axis.

RIGHT INTEREST AREAS

List of interest areas in which the right-eye
sample falls.

RIGHT INTEREST AREA DATA

Reports the data (interest area type,
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dynamic/static interest area, and coordinate data)

of the interest area in which the right-eye sample
falls.

RIGHT INTEREST AREA DISTA

NCE

Distance (in degrees of visual angle) between the
current right-eye sample and the center of the
interest area in which the sample falls.

RIGHT INTEREST AREA ID

ID of the interest area in which the right-eye
sample falls.

RIGHT INTEREST AREA LABEL

Label of the interest area in which the right-eye
sample falls.

RIGHT INTEREST AREA PIXEL

_AREA

Pixel area of the interest area in which the right-
eye sample falls.

RIGHT IN BLINK

Whether the right eye is in a blink (1 if true, 0 if
false). The output of this variable may be
affected by the “Blink Correction for Pupil Size
Calculations” settings in the “Data Filters”
preferences.

RIGHT IN_SACCADE

Whether the right eye is in a saccade (1 if true, 0
if false).

RIGHT PUPIL SIZE

Right eye pupil size of the current sample.

RIGHT SACCADE INDEX

Ordinal sequence of the saccade in the trial to
which the right-eye sample belongs.

RIGHT VELOCITY X

Velocity value (in degree/second) of the right
eye along the x axis.

RIGHT VELOCITY Y

Velocity value (in degree/second) of the right
eye along the y axis.

SAMPLE BUTTON

If the EyeLink button box is pressed, this records
the ID of the EyeLink button number.

SAMPLE INDEX

The index of the sample in the trial.

SAMPLE INPUT

The input value for the current sample.

SAMPLE MESSAGE

Message text printed out during the current
sample. Multiple messages associated with the
current sample are delimited by a semicolon (;).

TARGET ACCELERATION X

Acceleration value (in degree/second/second) of
the target along the x axis.

TARGET ACCELERATION Y

Acceleration value (in degree/second/second) of
the target along the y axis.

TARGET VELOCITY X

Velocity value (in degree/second) of the target
along the x axis.

TARGET VELOCITY Y

Velocity value (in degree/second) of the target
along the y axis.

TARGET VISIBLE

Whether the target is visible during the current
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sample. To support the retrieval of target
position from a sample report, the target position
data must be written according in the appropriate
format (see section "Protocol for EyeLink Data
to Viewer Integration -> Target Position
Commands").

TARGET X

Target position on X axis (in screen pixel
coordinates). To support the retrieval of target
position from a sample report, the target position
data must be written according in the appropriate
format (see section "Protocol for EyeLink Data
to Viewer Integration -> Target Position
Commands").

TARGET Y

Target position on Y axis (in screen pixel
coordinates). To support the retrieval of target
position from a sample report, the target position
data must be written according in the appropriate
format (see section "Protocol for EyeLink Data
to Viewer Integration -> Target Position
Commands").

TIMESTAMP

The time stamp of the sample (in milliseconds
since EyeLink tracker was activated).

TRIAL INDEX

Sequential order of the trial in the recording.

TRIAL LABEL

Label of the trial.

¢ TRIAL START TIME

The start time (in milliseconds since EyeLink
tracker was activated; i.e., EDF file time) of the
trial. If a valid reaction time is found in the trial,
TRIAL START TIME will be set to the start
time of the reaction time definition instead.

VIDEO FRAME INDEX

Index of the video frame that was visible at the
sample time. Note that all “VIDEO_” variables
are applicable to SceneLink recordings or some
Experiment Builder recordings only. For
SceneLink recordings, please check out the
“Data Loading” Preference Settings.

VIDEO NAME

Name of the video frame that was visible at the
sample time.

Note ! If one eye has valid data whereas the other eye has a missing value or was not
recorded at all, the "AVERAGE_*" data in the Sample Report will be based on the good
eye if the “Cyclopean Mode” option (in the Output/Analysis Preferences) is checked. If
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this is not checked, then a missing value is reported if no valid data is available from
either eye. This option has no effect when both eyes have valid or missing data.

Note > Please note that HTARGET DISTANCE, HTARGET X, HTARGET Y, and
HTARGET FLAGS outputs are intended for a qualitative indication of subject head
position in the camera coordinates. If you need quantitative data output for the head
movements and rotation angle, you will need an independent head tracker.

In addition, other user-defined trial variable labels will also be listed. Please note that the
data output in the sample report depends on the setting of the interest period filter (see
section 6.4.2 or Figure 6-22) — only those samples, fixation and saccade events falling
within the active interest period will be reported. If a valid reaction time definition is
found in a trial, the § TRIAL START TIME variable will be set as the start of the
reaction time definition; otherwise this will be set as the start of trial recording (see
section 6.5.3 on discussion of three time periods used in Data Viewer).

6.9.4 Configuring the Sample Report

Data Viewer allows users to configure the sample report. A few options are available in
the “Sample Output Report” dialog box:

* Users can exclude some trials by entering a string in the “Exclude Trial String”
edit box. This string should be one message or part of a message within the trial
recording (see section 7.1 on defining the start and end of a trial) that uniquely
defines the subset of trials to be excluded.

* The sample report allows the inclusion of hidden events in the relative event
variables [LEFT SACCADE INDEX, LEFT FIX INDEX,

RIGHT SACCADE INDEX, RIGHT FIX INDEX]. This can be done by
clicking the “Include Hidden Events in Relative Variables” check box.

* To enable correct loading of string/text variables into some statistics software,
Data Viewer provides an option of adding a pair of quotation marks for those
variables.

* [fthe “Create One Report File Per EDF File” option is checked, Data Viewer will
create one report file for each of the EDF files loaded into the viewing session.

* Version 2.6 of the Data Viewer software allows users to create a shorter sample
report by enabling the “Re-sample Original Recordings with a Lower Sampling
Rate” option. Users can then fill out the “Intended Output Sampling Rate (Hz):”
edit box.

Note: If the “Exclude from Reports” property of a trial or trial group is checked, data
from that trial/trial group will not be included in the sample report (and other reports).
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6.10 Message Report

Message reports provide information concerning the messages written in each trial as
well as the eye movement events to which the messages are associated. As with the other
reports, message report only outputs messages that fall within the active interest period
for the trial.

6.10.1 Creating a Message Report
To create an output report for messages,

1) From the application menus, choose:
Analysis -> Reports -> Message Report

~e Eyelink Data Viewer Version 2.6.0 - Untitled.evs (C:\Temp\Untitled)

File Edit | Analysis Window Help

ey Evert e vsta.. |
| n|e - & o el
Trial Variable Manager ... Fixation Report ... Cti+F |l =2
L Trial Variable Value Editor ... Saccade Report ...
© Data I Reaction Time Manager ... Interest Area Report ... -
I T Trial Report ... Ctrl+T LWO Dlj ‘ (£
5 Lgtitled.evs Sample Report ...
| -
i picture: Trial: 2 Aggregate Event Statistics ... L
picture: Trial: 3 Agaregate Interest Area Report ... o=
- |, Interest Area Templates Time Course (Binning) Analysis ...
Import Report Variable Selection ... -
Export Report Variable Selection ...
P nichire: Trial: 1: Fivatinn: 179 me AI

Figure 6-32. Creating a Message Report.

2) In the following output report dialog, select the variables in the list of available output
variables (left panel) and press ">>" to enter the variables into the list of selected output
variables. You can also drag the selected variables and drop them to the intended position
in the selected variables list.
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~e Message Output Report 5]

~Available Variables ~Selected Variables

CURRENT_MSG_BLINK_DURATION - RECORDING_SESSION_LABEL
CURRENT_MSG_BLINK_END TRIAL_INDEX
CURRENT_MSG_BLINK_INDEX

CURRENT_MSG_BLINK_START L’
CURRENT_MSG_FIX_DURATION « I
CURRENT_MSG_FIX_END

CURRENT_MSG_FIX_INDEX
CURRENT_MSG_FIX_START
CURRENT_MSG_FIX_X |

il

~Variable Definition

Exdude Trial String : |

[~ Place Quotes ( ™) Around String / Text Variables
[~ Create Output Report For All Custom Interest Periods

{* ReportIP Datain One Fle. ¢ ReportIP Data in Multiple Files,

[~ Create one Report File per EDF File

Reset | Undo | Cancel I Next I

Figure 6-33. Variables in a Message Report.

* To remove variables from the output list, simply select the variables and press <<.
You can also drag the selected variables and drop them back to the Available
Variables list.

* To change the order in which the variables are listed, simply select one variable
and use the 4 or ¥ button to move it to the desired position. Repeat this step
until all variables are in the right position. You can also select the variable(s) and
then drag and drop them to the intended position.

* Data Viewer supports exporting and importing of variable selection across
viewing sessions. For example, users may go through each of the output reports to
configure the selection of variables in an intended order, then export the variable
selection into a property file by clicking “Analysis -> Reports -> Export Report
Variable Selection”. For all future viewing sessions, the variable selection in the
reports can be achieved by importing the previously saved property file (through
“Analysis -> Reports -> Import Report Variable Selection™).

3) Once all the desired variables have been entered into the output list, press the Next
button.
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4) In the Save dialog box, browse to the directory in which you want to save the output
report. The default output directory can be configured through "General Preferences".

5) In the File name text box, enter the name for the document and choose the appropriate
file extension. Note, if the output report file extension is set to "All Files" and the file
name does not contain an extension, the file name is appended with a ".txt" by default.

6) Press the "Save" button.

Data Viewer also allows users to configure the message output report. Users can exclude
some trials by entering a string in the "Exclude Trial String" edit box. This string should
be one message or part of a message within the scope of the trial recording that uniquely
defines that subset of trials to be excluded. In addition, to enable correct loading of
string/text variables in some statistics software, the Viewer also has an option of adding a
pair of quotation marks for such variables.

6.10.2 Variables in the Message Report

Currently, the following variables are included in the message output report. Please note
that the values of all variables marked with a “q” symbol are calculated relative to
TRIAL START TIME, and therefore will be different depending on whether a valid
reaction time is found in the trial (see section 6.5.3 on discussion of three time periods
used in Data Viewer).

Field Contents

RECORDING SESSION LABEL Label of the data file.

CURRENT MSG BLINK DURATI | Duration of the blink to which the message is
ON associated.

f CURRENT MSG BLINK END End time (in milliseconds relative to the start of
the current trial "TRIAL START_ TIME") of the
blink to which the message is associated.

CURRENT MSG BLINK INDEX | Index of the blink to which the message is
associated.

CURRENT MSG BLINK START | Start time (in milliseconds relative to the start of
the current trial "TRIAL START_ TIME") of the
blink during which the message was written.

CURRENT MSG FIX DURATION | Duration of the fixation to which the message is
associated.

 CURRENT MSG FIX END End time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
fixation to which the message is associated.

CURRENT MSG FIX INDEX Index of the fixation to which the message is
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associated.

¢ CURRENT MSG FIX START

Start time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
fixation to which the message is associated.

CURRENT MSG FIX X

X position of the fixation to which the message
is associated.

CURRENT MSG FIX Y

Y position of the fixation to which the message
is associated.

CURRENT MSG_INDEX

Index of the current message.

CURRENT MSG _INTEREST ARE
AS

List of interest areas in which the current eye
position falls at the time the message is recorded.

CURRENT MSG INTEREST ARE
A ID

The ID of the interest area in which the current
eye position falls when the message is recorded.
If the message falls into multiple interest areas,
the interest area with lowest ID will be used.

CURRENT MSG INTEREST ARE
A_INDEX

The index of the interest area in which the
current eye position falls when the message is
recorded. This measure is the same as the
CURRENT MSG _INTEREST AREA ID
except when there are multiple interest areas
with the same ID, or interest area IDs didn’t start
from 1.

CURRENT MSG INTEREST ARE
A LABEL

Label for the interest area in which the current
eye position falls when the message is recorded.

CURRENT MSG IS RT END

Whether the current message is the end event of
a reaction-time definition.

CURRENT MSG IS RT START

Whether the current message is the start event of
a reaction-time definition.

{ CURRENT MSG LABEL

Label of the current message event.

CURRENT MSG SAC_AMPLITU
DE

Amplitude (in degrees of visual angle) of the
saccade to which the message is associated.

CURRENT MSG SAC AVG VEL
OCITY

Average velocity (in degrees/second) of the
saccade to which the message is associated.

CURRENT MSG SAC DURATIO
N

Duration of the saccade to which the message is
associated.

YCURRENT MSG SAC END TIM
E

End time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
saccade to which the message is associated.

CURRENT MSG SAC END X

X coordinate of the end point for the saccade to
which the message is associated.

CURRENT MSG SAC END Y

Y coordinate of the end point for the saccade to
which the message is associated.
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CURRENT MSG SAC INDEX

Index of the saccade to which the message is
associated.

CURRENT MSG SAC PEAK VE
LOCITY

Peak velocity (in degrees/second) of the saccade
to which the message is associated. The peak
velocity calculation depends on whether the
samples are loaded in the viewing session.

YCURRENT MSG SAC START T
IME

Start time (in milliseconds relative to the start of
the current trial "TRIAL START_ TIME") of the
saccade to which the message is associated.

CURRENT MSG SAC_START X

X coordinate of the start point for the saccade to
which the message is associated.

CURRENT MSG SAC START Y

Y coordinate of the start point for the saccade to
which the message is associated.

CURRENT MSG TEXT

Text string of the current message.

¢ CURRENT MSG TIME

Trial time (in milliseconds relative to the start of
the current trial "TRIAL START TIME") of the
message.

CURRENT MSG X POSITION

X position of the current message text. It may be
a missing value if samples are not loaded in the
viewing session.

CURRENT MSG Y POSITION

Y position of the current message text. It may be
a missing value if samples are not loaded in the
viewing session.

DATA FILE File name of the EDF data file.

EYE USED Records which eye's data (LEFT or RIGHT) was
used to create this report.

I[P DURATION Duration of the interest period in milliseconds.

IP END EVENT MATCHED

Whether an event that matches the end of the
selected interest period has been found in the
current trial.

IP_ END TIME

End time (in milliseconds since EyeLink tracker
was activated) of the interest period.

IP_INDEX

The index (starting from 1) of interest period
created by the user. For the Full-Trial period or
Reaction-Time Period, a missing value is given
as they are not created by the user.

IP LABEL

Label of the current interest period selected in
the viewing session.

IP START EVENT MATCHED

Whether an event that matches the start of the
selected interest period has been found in the
current trial.
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IP START TIME Start time (in milliseconds since EyeLink tracker
was activated) of the interest period.

TRIAL INDEX Sequential order of the trial in the recording.
TRIAL LABEL Label of the trial.
 TRIAL START TIME The start time (in milliseconds since EyeLink

tracker was activated; i.e., EDF file time) of the
trial. If a valid reaction time is found in the trial,
TRIAL START TIME will be set to the start
time of the reaction time definition instead.

Note: Messages written in the EDF file will be associated with the eye event closest in
time. In very rare cases, the message can be associated with both a saccade and fixation
event if the message was written out after the last sample of a fixation (or saccade) but
before the first sample of the following saccade (or fixation).

In addition, other user-defined trial variable labels will also be listed.
6.10.3 Configuring the Message Report

See section 6.5.4 “Configuring the Trial Report”.

6.11 Aggregate Event Statistics
The Aggregate Event statistics provide summary statistics for each trial group in the

current interest period. If no trial grouping was performed in the viewing session, the
report provides summary statistics for each of the EDF files loaded.

6.11.1 Creating an Aggregate Event Statistics Report
To create an Aggregate Event Statistics report,

1) From the application menus, choose:
Analysis -> Reports -> Aggregate Event Statistics
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~ah EyeLink Data Viewer Version 2.6.0 - Untitled.evs (C:\Temp\Untitled)

Flle Edit Window Help

Recording Event Sequence Data ... E'i‘: J IE =
_I_ Trial Variable Manager .. Fixation Report ... Ci+F || =2 | =
Trial Variable Value Edihor Saccade Report ...
@ Data I Reaction Time Manager ... Interest Area Report ... =
: T Trial Report .. Crl+T DIO Fﬂ‘ 2
Lghﬂed .evs Sample Report ... e, 75
E . pldJJ Message Report ...
& ! plcture Trlal 2 Aggregate Event Statistics ...
: ;-; picture: Trial: 3 Agaregate Interest Area Report ...
- |, Interest Area Templates Time Course (Binning) Analysis ...
Import Report Variable Selection ... ; g
Export Report Variable Selection ...
P nichire: Trial: 1: Fivatinn: 179 me AI

Figure 6-34. Creating an Aggregate Event Statistics Report.

2) In the following output report dialog, select the variables in the list of available output
variables (left panel) and press ">>" to enter the variables into the list of selected output
variables. You can also drag the selected variables and drop them to the intended position

in the selected variables list.

~¢' Aggregate Event Statistics 5'
~Available Variables ~Selected Variables
BLINK_COUNT - TRIAL_GROUP
BUTTON_COUNT

FIXATION_COUNT
FIXATION_DURATION_MEAN
FIXATION_DURATION_MEDIAN
FIXATION_DURATION_SD
GROUP_INDEX

INPUT_COUNT
INTEREST_AREA_COUNT

~Variable Definition

_» |
_« |

GROUPING_VARIABLES

_ |
=2

Exdude Trial String : |

[~ Place Quotes ( ™) Around String / Text Variables

[~ Create Output Report For All Custom Interest Periods
{* Report IP Data in One Fle.

Reset |

¢ Report IP Data in Multiple Files,

Undo I Cancel | Next |

Figure 6-35. Variables in an Aggregate Event Statistics Report.
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* To remove variables from the output list, simply select the variables and press <<.
You can also drag the selected variables and drop them back to the Available
Variables list.

* To change the order in which the variables are listed, simply select one variable
and use the 4 or ¥ button to move it to the desired position. Repeat this step
until all variables are in the right position. You can also select the variable(s) and
then drag and drop them to the intended position.

* Data Viewer supports exporting and importing of variable selection across
viewing sessions. For example, users may go through each of the output reports to
configure the selection of variables in an intended order, then export the variable
selection into a property file by clicking “Analysis -> Reports -> Export Report
Variable Selection”. For all future viewing sessions, the variable selection in the
reports can be automated by importing the previously saved property file (through
“Analysis -> Reports -> Import Report Variable Selection”).

3) Once all the desired variables have been entered into the output list, press the Next
button.

4) In the Save dialog box, browse to the directory in which you want to save the output
report. The default output directory can be configured through "General Preferences".

5) In the File name text box, enter the name for the document and choose the appropriate
file extension. Note, if the output report file extension is set to "All Files" and the file
name does not contain an extension, the file name is appended with a ".txt" by default.
6) Press the "Save" button.

6.11.2 Variables in the Aggregate Event Statistics Report

Currently, the following variables are included in the Aggregate Event Statistics output:

Field Contents

TRIAL GROUP Name of the trial group (encoding the value(s)
of the grouping variable(s) for the current trial
group).

GROUPING_VARIABLES Label(s) of the grouping variable(s) for the
current viewing session.

BLINK COUNT Average number of blinks in a trial in the

current interest period, calculated as the total
number of blinks in the trial group divided by
the number of trials in the group.

BUTTON COUNT Average number of button presses in a trial,
calculated as the total number of button presses
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in the trial group divided by the number of trials
in the group.

FIXATION COUNT

Average number of fixations in a trial in the
current interest period, calculated as the total
number of fixations in the trial group divided by
the number of trials in the group.

FIXATION DURATION MEAN

Average duration (in milliseconds) of all
fixations in the trial group. This is calculated by
summing up the duration of all fixations in the
trial group divided by the total number of
fixations in the group.

FIXATION DURATION MEDIAN

Median duration (in milliseconds) of all
fixations in the trial group.

FIXATION DURATION SD

Standard Deviation (in milliseconds) of the
duration across all fixations in the trial group.

GROUP_INDEX

Order of the trial group in the viewing session.

INPUT COUNT

Average number of input events that occur in
the trial group, calculated as the total number of
input events in the trial group divided by the
number of trials in the group.

INTEREST AREA COUNT

Average number of interest areas in the trial
group, calculated as the total number of interest
areas across all trials in the trial group divided
by the number of trials.

I[P DURATION Duration of the interest period (in milliseconds)
averaged across all trials in the trial group.

IP_INDEX The index (starting from 1) of interest period
created by the user. For the Full-Trial period or
Reaction-Time Period, a missing value is given
as they are not created by the user.

IP_ LABEL Label of the current interest period selected in
the viewing session.

PUPIL SIZE Average pupil size (in arbitrary units) across all
non-blink samples in the trial group.

RUN_COUNT Average number of fixation runs (two or more

consecutive fixations in the same interest area
belong to the same run) averaged over all trials
in the current interest period. This is calculated
as the average run count across all trials in the
trial group.

SACCADE AMPLITUDE MEAN

Average size (in degrees of visual angle) of all
saccades in the trial group. This is calculated by
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summing up the amplitude of all saccades in the
trial group divided by the total number of
saccades in the group.

SACCADE AMPLITUDE MEDIAN | Median size (in degrees of visual angle) of all
saccades in the trial group.

SACCADE _AMPLITUDE SD Standard Deviation (in degrees of visual angle)
of the amplitude of all saccades in the trial
group.

SACCADE COUNT Average number of saccades in a trial,

calculated as the total number of saccades in the
trial group divided by the number of trials in the

group.

SAMPLE COUNT Average number of samples in trials contained
in the group, calculated as the total number of
samples in the trial group divided by the number
of trials in the group.

TRIAL COUNT Total number of trials in the trial group.

TRIAL DURATION Average duration (in milliseconds) of trial
recording (between the START event and the
END event) across all trials in the trial group.

TRIALS WITH IAS COUNT Number of trials in the trial group that contain at
least one interest area in the current interest
period.

VISITED INTEREST AREA COU | Number of unique interest areas visited in the

NT trial (calculated as the average count across all

trials in the group).

Please note that the data output in the Aggregate Event Statistics depends on the setting
of the interest period filter (see section 6.4.2 or Figure 6-22) — only those events falling
within the active interest period will be reported. Presently, all user-defined trial variables
will report a missing value.

6.11.3 Configuring the Aggregate Event Statistics Report

To enable correct loading of string/text variables into some statistics software, Data
Viewer provides an option of adding a pair of quotation marks for those variables.

Note: If the “Exclude from Reports” property of a trial or trial group is checked, data

from that trial/trial group will not be included in the Aggregate Event Statistics report
(and other reports).
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6.12 Aggregate Interest Area Report

The Aggregate Interest Area Report provides information concerning each interest area in
each trial group. If no trial grouping was performed in the viewing session, this will be a
report for each interest area per each EDF file. This report assumes that trials in a trial
group have the same interest area setup; if not, the interest area report will be based on
the ID of the interest areas; the property of the interest areas will be drawn from the first
instance found in the trial group.

6.12.1 Obtaining an Aggregate Interest Area Report

To create an Aggregate Interest Area Report,
1) From the application menus, choose:
Analysis -> Reports -> Aggregate Interest Area Report

~e Eyelink Data Viewer Version 2.6.0 - Untitled.evs (C:\Temp\Untitled)
File Edit | Analysis Window Help

Recording Event Sequence Data ... e >
| == o || [¢ |«
Trial Variable Manager ... Fixation Report ... Ctrl+F B
Trial Variable Value Editor ... Saccade Report ...
© Data I Reaction Time Manager ... Interest Area Report ... o
Y T Trial Report ... Ctrl+T LO L\lj ‘ ILE4
o Lgtitled.evs Sample Report ...
=55 picture Message Report ...
i picture: Trial: 1 —
: picture: Trial: 2 Agaregate Event Statistics ... L
- 1, Interest Area Templates Time Course (Binning) Analysis ...
Import Report Variable Selection ... ; -
Export Report Variable Selection ...
P nichire: Trial: 1: Fivatinn: 179 me AI

Figure 6-36. Creating an Aggregate Interest Area Report.

2) In the following output report dialog, select the variables in the list of available output
variables (left panel) and press ">>" to enter the variables into the list of selected output
variables. You can also drag the selected variables and drop them to the intended position
in the selected variables list.
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Figure 6-37. Variables in an Aggregate Interest Area Report.

* To remove variables from the output list, simply select the variables and press <<.
You can also drag the selected variables and drop them back to the Available

Variables list.

* To change the order in which the variables are listed, simply select one variable
and use the 4 or ¥ button to move it to the desired position. Repeat this step
until all variables are in the right position. You can also select the variable(s) and
then drag and drop them to the intended position.

* Data Viewer supports exporting and importing of variable selection across
viewing sessions. For example, users may go through each of the output reports to
configure the selection of variables in an intended order, then export the variable
selection into a property file by clicking “Analysis -> Reports -> Export Report
Variable Selection”. For all future viewing sessions, the variable selection in the
reports can be automated by importing the previously saved property file (through

“Analysis -> Reports -> Import Report Variable Selection”).

3) Once all the desired variables have been entered into the output list, press the Next

button.

4) In the Save dialog box, browse to the directory in which you want to save the output
report. The default output directory can be configured through "General Preferences".
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5) In the File name text box, enter the name for the document and choose the appropriate
file extension. Note, if the output report file extension is set to "All Files" and the file
name does not contain an extension, the file name is appended with a ".txt" by default.

6) Press the "Save" button.

6.12.2 Variables in the Aggregate Interest Area Report

Currently, the following variables are included in the Aggregated Interest Area Report.
Please note that the values of all variables marked with a “q[” symbol are calculated
relative to TRIAL START TIME, and therefore will be different depending on whether
a valid reaction time is found in the trial (see section 6.5.3 on discussion of three time

periods used in Data Viewer).

Field

Contents

TRIAL GROUP

Name of the trial group (encoding the value(s)
of the grouping variable(s) for the current trial

group).

GROUPING VARIABLES

Label(s) of the grouping variable(s) for the
current viewing session.

IA_AREA Pixel area for the current interest area. This is
based on the data from the first trial/instance in
the trial group.

IA_ BOTTOM Y-coordinate of the lower-right corner of a

rectangular or elliptic interest area ("." for a
freehand interest area). This output is based on
the data from the first trial/instance in the trial

group.

IA DWELL TIME

Dwell time (i.e., summation of the duration
across all fixations) on the current interest area.
This is calculated as the sum of the duration of
all fixations into the interest areas with this ID,
divided by the number of trials using this
interest area (TRIALS USING THIS TA).

IA DWELL TIME %

Percentage of trial time spent on the current
interest area. This is calculated as the sum of all
fixation duration into the interest areas with this
ID, divided by the total fixation dwell time of
those trials using this interest area.

[A_ DYNAMIC Whether the current interest area is a dynamic
one (true or false). This is based on the data
from the first trial/instance in the trial group.

IA END TIME Time (relative to the start of the current interest
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period) when the last instance of the current
interest area ends. This variable is applicable to
dynamic interest areas only and is based on the
data from the first trial/instance in the trial

group.

IA _FIRST FIXATION DURATION

Duration of the first fixation event that was
within the current interest area. This is an
average value across all trials with a fixation
into the interest area with this ID.

Y IA FIRST FIXATION TIME

Start time of the first fixation to enter the current
interest area. This is an average value across all
trials with a fixation into the interest area with
this ID.

IA FIRST FIXATION VISITED IA
_COUNT

The number of different interest areas visited so
far before the first fixation is made into the
current interest area. This is an average value
across all trials with a fixation into the interest
area with this ID.

IA_FIXATION COUNT

Average number of total fixations falling in the
interest area. This is calculated as the total
number of fixations into the interest areas with
this ID, divided by the number of trials using
this interest area (TRIALS USING THIS TA).

IA_FIX COUNT %

Percentage of all fixations in a trial falling in the
current interest area. This is calculated as the
total number of fixations into the interest areas
with this ID, divided by the total number of
fixations in those trials using this interest area
(TRIALS USING THIS IA).

IA ID

Ordinal ID of the current interest area. In the
Aggregate Interest Area report, all of the
calculation is based on the ID of the interest
areas.

IA_INSTANCES COUNT

The total number of individual instances of the
current dynamic interest area. This is based on
the data from the first trial/instance in the trial

group.

IA_ LABEL Label for the current interest area. This is based
on the data from the first trial/instance in the
trial group.

IA LEFT X-coordinate of the upper-left corner of a

rectangular or elliptic interest area ("." for a
freehand interest area). This is based on the data
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from the first trial/instance in the trial group.

IA_POINTS

List of points for a freehand interest area
nn

(otherwise "." is output). This is based on the
data from the first trial/instance in the trial

group.

IA REVISIT TRIAL %

This is calculated as the total number of trials
with more than one run of fixations on the
interest area with this ID, divided by the total
number of trials using this interest area
(TRIALS USING THIS IA).

IA RIGHT

X-coordinate of the lower-right corner of a
rectangular or elliptic interest area ("." for a
freehand interest area). This is based on the data
from the first trial/instance in the trial group.

IA RUN_COUNT

Number of times the Interest Area was entered
and left (runs). This is calculated as the sum of
run count from all trials using this interest area,
divided by the number of trials using this
interest area (TRIALS USING THIS TA).

IA_START TIME

Time (relative to the start of the current interest
period) when the first instance of the current
interest area starts. This variable is applicable to
dynamic interest areas only and outputs the data
from the first trial/instance in the trial group.

IA TOP Y-coordinate of the upper-left corner of a
rectangular or elliptic interest area ("." for a
freehand interest area). This outputs the data
from the first trial/instance in the trial group.

IA TYPE Type of interest area (rectangular, elliptic, or

freehand). This is based on the data from the
first trial/instance in the trial group.

IA_ VISITED TRIAL %

The total number of trials with at least one
fixation on the interest area with this ID divided
by the total number of trials using this interest
area (TRIALS USING THIS TA).

IP_INDEX The index (starting from 1) of interest period
created by the user. For the Full-Trial period or
Reaction-Time Period, a missing value is given
as they are not created by the user.

IP LABEL Label of the current interest period selected in

the viewing session.

TRIALS IN GROUP

Total number of trials in the trial group.

TRIALS USING THIS IA

Total number of trials in the current trial group
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that have an interest area with this ID in the
current interest period.

Please note that the data output in the Aggregate Interest Area Report depends on the
setting of the interest period filter (see section 6.4.2 or Figure 6-22) — only those events
falling within the active interest period will be reported. Presently, all user-defined trial
variables will report a missing value.

6.12.3 Configuring the Aggregate Interest Area Report

To enable correct loading of string/text variables into some statistics software, Data
Viewer provides an option of adding a pair of quotation marks for those variables.

Note: If the “Exclude from Reports” property of a trial or trial group is checked, data
from that trial/trial group will not be included in the Aggregate Interest Area report (and
other reports).

6.13Time Course (Binning) Analysis Report

Some eye-tracking studies (e.g., Visual World Paradigm, or people working with
dynamic stimuli such as videos) examine how likely participants are to look at specific
areas of interest at different times during a trial and make inferences about the time
course of the underlying cognitive processes. Researchers typically divide a recording
trial into a set of consecutive time windows and examine the proportions of fixations on
various interest areas during each time window. The Time Course (Binning) Analysis
creates a series of consecutive time bins from the beginning of the currently-selected
interest period and tallies the distribution of gaze in a set of predefined interest areas for
each time bin. It generates two possible reports — a trial-based report which provides data
output for each consecutive time window for each trial in the viewing session, and an
optional collapsed report which provides averaged data in the same time window across
all trials and participants within each trial group. The collapsed report allows users to
examine how likely the participants are, on average, at a given moment in time, to look at
each of the interest areas.

The time-course analysis offered by Data Viewer is intended as a replacement for the
Visual World Analysis Script provided by the SR Research support forum. Using the
same calculation principle, the current Time Course (Binning) Analysis provides a direct
report output from Data Viewer without having to execute an external Python script. It
has a much faster data processing speed and provides an easier interface to configure
various report options. It also offers refinements of some calculation details. In particular,
the Time Course Analysis now provides separate measures for blink, and off-screen
sample count, which were grouped within the Interest Area O (any area onscreen that was
not within a predefined interest area) in the Visual World analysis script.
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6.13.1 Loading Samples into a Viewing Session

The time-course analysis will not be available from the Analysis menu if samples are not
loaded into the viewing session. While recent versions of Data Viewer loads samples into
the viewing session by default, please do the following in case samples are not loaded.

1) Before loading any EDF files, please go to "Start -> Programs -> SR Research ->
EyeLink -> Data Viewer" to start the software.

2) Once the application starts up, click the "Preferences" tab and go to "Data
Loading" preferences. If not already enabled, check the "Load Samples" option. If
you want this changes to be persistent over future viewing sessions, you may
consider saving this as the default setting. This can be done by selecting the
topmost preference tree node, clicking the right mouse buttons and selecting
"Save Properties as Defaults".

3) Now, start loading in the EDF files.

6.13.2 Creating a Time-Course (Binning) Analysis Report
To create a Time-Course (Binning) Analysis Report,

1) From the application menus, choose:
Analysis -> Reports -> Time Course (Binning) Analysis

~eh EyeLink Data Viewer Version 2.6.0 - Untitled.evs (C:\Temp\Untitled)
File Edit | Analysis Window Help

T e st ST P
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Il T Trial Report ... Ctrl+T 11O Dlj
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i Aggregate Event Statistics ...
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Import Report Variable Selection ...
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Figure 6-38. Creating a Time-Course (Binning) Report.

2) In the following output report dialog, select the variables in the list of available output
variables (left panel) and press ">>" to enter the variables into the list of selected output
variables. You can also drag the selected variables and drop them to the intended position
in the selected variables list.
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~¢\ Time Course (Binning) Analysis 5]

~Available Variables —Selected Variables

AVERAGE_BLINK_SAMPLE_COUNT -~ RECORDING_SESSION_LABEL
AVERAGE_BLINK_SAMPLE_COUNT_% TRIAL_LABEL

AVERAGE_EXCLUDED_SAMPLE_COUNT 5> TRIAL_INDEX =
AVERAGE_EXCLUDED_SAMPLE_COUNT _% _I BIN_INDEX _I

AVERAGE_GAZE_X_BIN « I -
AVERAGE_GAZE_Y_BIN —I
AVERAGE_IA_*_SAMPLE_COUNT

AVERAGE_IA_* SAMPLE_COUNT_%

AVERAGE_OFF_SCREEN_SAMPLE_COUNT ¥

~Variable Definition

Bin Interval (in Milliseconds): |20 Maximum Number of Bins: |2000
Interest Areas Used for Calculations (First Four Interest Areas if the Edit Box is Left Empty).

Provide Optional Interest Area IDs or Labels (Separated By Commas *,”) : |

Calculation of the Proportion of Samples in Each Interest Area:

(" Across All Samples.

{+ Across All On-Screen Samples (i.e., Samples Assigned to All Interest Areas, including Null IA 0).

" Across All Samples Assigned to Predefined Interest Areas Only (i.e, Excluding Samples to Null IA 0).

Data Selection:

¢ Include All Samples in Fixations and Saccades.

(" Exdude Samples during Saccades.

" Exdude Samples during Saccades and Excdude Bins That Contain Non-Fixation Samples.

Exclude Trial String : |

[V Create a Separate Report, Collapsing Data Across All Trials in the Same Trial Group.
[~ Create Output Report For All Custom Interest Periods
{* ReportIP Datain One File. € Report IP Data in Multiple Files,

Reset | Undo | Cancel | Next |

Figure 6-39. Variables and Configuration Options in a Time-Course Analysis Report.

* To remove variables from the output list, simply select the variables and press <<.
You can also drag the selected variables and drop them back to the Available
Variables list.

* To change the order in which the variables are listed, simply select the variable(s)
and use the 4 or ¥ button to move the selection to the desired position. Repeat
this step until all variables are in the right position. You can also select the
variable(s) and then drag and drop them to the intended position.
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* Data Viewer supports exporting and importing of variable selection across
viewing sessions. For example, users may go through each of the output reports to
configure the selection of variables in an intended order, then export the variable
selection into a property file by clicking “Analysis -> Reports -> Export Report
Variable Selection”. For all future viewing sessions, the variable selection in the
reports can be automated by importing the previously saved property file (through
“Analysis -> Reports -> Import Report Variable Selection™).

* Several configuration options are available to the Time-Course Analysis report —
please check section 6.13.4 “Configuring the Time Course Analysis Report” for
details. In case you want to restore the changes made, click the “Undo” button to
undo recent changes. Clicking on the “Reset” button will reset the configurations
to factory settings.

3) Once all the desired variables have been entered into the output list and proper
configurations are set, press the Next button.

4) In the Save dialog box, browse to the directory where you want to save the output
report. The default output directory can be configured through "General Preferences".

5) In the File name text box, enter the file name and choose the appropriate file extension.
Note, if the output report file extension is set to "All Files" and the file name does not
contain an extension, the file name is appended with a ".txt" by default.

6) Press the "Save" button.

Note: Depending on the quantity and size of the EDF file(s), it may take some time to
create this report.

6.13.3 Variables in the Time Course Analysis Report

Two possible Time Course Analysis reports are created — a trial-based report which
provides output for each consecutive time window (bin) for each trial loaded in the
viewing session, and a collapsed version which provides averaged data in the same time
window across all trials and participants for each trial group in the viewing session. The
following variables are available for the trial-based report.

Field Contents
RECORDING SESSION LABEL Label of the data file.
TRIAL LABEL Label of the trial.
#BIN INDEX Sequential order of the bin in the interest period.
#AVERAGE BLINK SAMPLE CO | The total number of samples (based on the
UNT! average data across both eyes) in the current bin
that were in a blink event. In the collapsed output
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report, this reports the total number of blink
samples in the current bin index across all trials
within that trial group.

#AVERAGE BLINK_SAMPLE _CO
UNT %!

The percentage of the total number of samples
(based on the average data across both eyes) in
the current bin that were in a blink event across
the total number of samples in the bin. In the
collapsed output report, this variable is
calculated similarly based on the samples in the
current bin index across all trials within that trial

group.

#AVERAGE _EXCLUDED SAMPL
E COUNT

The total number of samples (based on the
average data across both eyes) in the current bin
that are excluded from all other counts (due to
the data selection configuration). In the collapsed
output report, this reports the total number of
excluded samples in the current bin index across
all trials within that trial group.

#AVERAGE_EXCLUDED SAMPL
E COUNT %'

The percentage of the total number of samples
(based on the average data across both eyes) in
the current bin that are excluded from all other
counts (due to the data selection configuration)
across the total number of samples in the bin. In
the collapsed output report, this variable is
calculated similarly based on the samples in the
current bin index across all trials within that trial

group.

#AVERAGE _GAZE X BIN'?

Average binocular/cyclopean X gaze position
across all selected non-blink samples in the
current bin.

#AVERAGE _GAZE Y BIN'?

Average binocular/cyclopean Y gaze position
across all selected non-blink samples in the
current bin.

#AVERAGE IA * SAMPLE COU
NT'

This will create several columns — it will create
one column for each interest area that is included
in the report calculations and one column for all
on-screen samples outside of all interest areas.
The symbol * will become an interest area index
for each column and 0 will indicate the column
for all on-screen samples that don't belong to any
other interest areas used for calculations. The
value in each column (* will become a number
indicating the interest area index) will be the
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total number of samples (based on the average
data across both eyes) in the current bin that fall
in that interest area. In the collapsed output
report, this reports the total number of samples in
the current bin index across all trials within that
trial group.

#AVERAGE IA * SAMPLE COU
NT %!

The percentage of the total number of samples
(based on the average data across both eyes) in
the current bin that fall in the * (=index) interest
area across the total number of samples
according to the selected calculation option (i.e,
all samples, valid samples including IA 0, or
valid samples excluding IA_0). In the collapsed
output report, this variable is calculated similarly
based on the samples in the current bin index
across all trials within that trial group. Please
note [A_0 is the null interest area (for all on-
screen samples that don't belong to any other
interest areas used for calculations).

#AVERAGE OFF SCREEN SAMP
LE COUNT!

The total number of samples (based on the
average data across both eyes) in the current bin
that fall outside of the display boundary (off
screen). In the collapsed output report, this
reports the total number of off-screen samples in
the current bin index across all trials within that
trial group.

#AVERAGE _OFF SCREEN SAMP
LE_COUNT %!

The percentage of the total number of samples
(based on the average data across both eyes) in
the current bin that fall outside of the display
boundary (off screen) across the total number of
samples in the bin. In the collapsed output report,
this variable is calculated similarly based on the
samples in the current bin index across all trials
within that trial group.

#AVERAGE PUPIL SIZE BIN ' 2

Average binocular/cyclopean pupil size across
all selected non-blink samples in the current bin.

#BIN DURATION

The duration (in milliseconds) of the bin.

BIN END TIME

The end time (in milliseconds relative to the start
of the interest period) of the bin.

#BIN_SAMPLE_COUNT

The total number of samples in the bin. In the
collapsed output report, it reports the sample
count in the same bin index across all trials
within that trial group. Please note that in the
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latter report, the total bin samples don't necessary
come by all trials but only the active trials, and
hence the averaging is adjusted based on that.

BIN START TIME

The start time (in milliseconds relative to the
start of the interest period) of the bin.

EYE TRACKED

Reports which eye (left, right, both) is tracked
for the current trial.

HTARGET DISTANCE BIN

Average Distance between the head target and
eye camera (in millimeters) for an EyeLink
Remote recording in the current bin. Returns a
missing value if the head target was missing or if
the data was recorded with a non-Remote eye
tracker.

HTARGET X BIN

Average X position of the head target in camera
coordinates for an EyeLink Remote recording in
the current bin. Returns a missing value if the
head target was missing or if the data was
recorded with a non-Remote eye tracker.

HTARGET Y BIN

Average Y position of the head target in camera
coordinates for an EyeLink Remote recording in
the current bin. Returns a missing value if the
head target was missing or if the data was
recorded with a non-Remote eye tracker.

#IA * ID

The ID and label of the interest area that
corresponds to the given IA Index. Please note
IA_0 is the null interest area (for all on-screen
samples that don't belong to any other interest
areas used for calculations).

I[P DURATION

Duration of the interest period in milliseconds.

IP END EVENT MATCHED

Whether an event that matches the start of the
selected interest period has been found in the
current trial.

IP END TIME

End time (in milliseconds since EyeLink tracker
was activated) of the interest period.

IP_INDEX

The index (starting from 1) of interest period
created by the user. For the Full-Trial period or
Reaction-Time Period, a missing value is given
as they are not created by the user.

#IP LABEL

Label of the current interest period selected in
the viewing session.

IP START EVENT MATCHED

Whether an event that matches the start of the
selected interest period has been found in the
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current trial.

IP START TIME

Start time (in milliseconds since EyeLink tracker
was activated) of the interest period.

#LEFT BLINK SAMPLE COUNT

The total number of left-eye samples in the
current bin that were in a blink event. In the
collapsed output report, this reports the total
number of blink samples in the current bin index
across all trials within that trial group.

#LEFT BLINK SAMPLE COUNT
%

The percentage of the total number of left-eye
samples in the current bin that were in a blink
event across the total number of samples in the
bin. In the collapsed output report, this variable
is calculated similarly based on the samples in
the current bin index across all trials within that
trial group.

#LEFT EXCLUDED SAMPLE CO
UNT

The total number of left-eye samples in the
current bin that are excluded from all other
counts (due to the data selection configuration).
In the collapsed output report, this reports the
total number of excluded samples in the current
bin index across all trials within that trial group.

#LEFT EXCLUDED SAMPLE CO
UNT %

The percentage of the total number of left-eye
samples in the current bin that are excluded from
all other counts (due to the data selection
configuration) across the total number of
samples in the bin. In the collapsed output report,
this variable is calculated similarly based on the
samples in the current bin index across all trials
within that trial group.

#LEFT GAZE X BIN *

Average left-eye X gaze position across all
selected non-blink samples in the current bin.

#LEFT GAZE Y BIN ’

Average left-eye Y gaze position across all
selected non-blink samples in the current bin.

#LEFT IA * SAMPLE COUNT

This will create several columns — it will create
one column for each interest area that is included
in the report calculations and one column for all
on-screen samples outside of all interest areas.
The symbol * will become an interest area index
for each column and 0 will indicate the column
for all on-screen samples that don't belong to any
other interest areas used for calculations. The
value in each column (* will become a number
indicating the interest area index) will be the
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total number of left-eye samples in the current
bin that fall in that interest area. In the collapsed
output report, this reports the total number of
samples in the current bin index across all trials
within that trial group.

#LEFT IA * SAMPLE COUNT %

The percentage of the total number of left-eye
samples in the current bin that fall in the *
(=index) interest area across the total number of
samples according to the selected calculation
option (i.e, all samples, valid samples including
IA_0, or valid samples excluding IA_0). In the
collapsed output report, this variable is
calculated similarly based on the samples in the
current bin index across all trials within that trial
group. Please note IA 0 is the null interest area
(for all on-screen samples that don't belong to
any other interest areas used for calculations).

#LEFT OFF _SCREEN SAMPLE C
OUNT

The total number of left-eye samples in the
current bin that fall outside of the display
boundary (off screen). In the collapsed output
report, this reports the total number of off-screen
samples in the current bin index across all trials
within that trial group.

#LEFT OFF SCREEN SAMPLE C
OUNT %

The percentage of the total number of left-eye
samples in the current bin that fall outside of the
display boundary (off screen) across the total
number of samples in the bin. In the collapsed
output report, this variable is calculated similarly
based on the samples in the current bin index
across all trials within that trial group.

#LEFT PUPIL SIZE BIN 2

Average left-eye pupil size across all selected
non-blink samples in the current bin.

#RESOLUTION X BIN

Average horizontal angular resolution (in screen
pixels per degree) across all samples in the
current bin.

#RESOLUTION_ Y BIN

Average vertical angular resolution (in screen
pixels per degree) across all samples in the
current bin.

#RIGHT BLINK_SAMPLE COUN
T

The total number of right-eye samples in the
current bin that were in a blink event. In the
collapsed output report, this reports the total
number of blink samples in the current bin index
across all trials within that trial group.

#RIGHT BLINK SAMPLE COUN

The percentage of the total number of right-eye
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T %

samples in the current bin that were in a blink
event across the total number of samples in the
bin. In the collapsed output report, this variable
is calculated similarly based on the samples in
the current bin index across all trials within that
trial group.

#RIGHT EXCLUDED SAMPLE C
OUNT

The total number of right-eye samples in the
current bin that are excluded from all other
counts (due to the data selection configuration).
In the collapsed output report, this reports the
total number of excluded samples in the current
bin index across all trials within that trial group.

#RIGHT EXCLUDED SAMPLE C
OUNT %

The percentage of the total number of right-eye
samples in the current bin that are excluded from
all other counts (due to the data selection
configuration) across the total number of
samples in the bin. In the collapsed output report,
this variable is calculated similarly based on the
samples in the current bin index across all trials
within that trial group.

#RIGHT GAZE X BIN?

Average right-eye X gaze position across all
selected non-blink samples in the current bin.

#RIGHT GAZE Y BIN?

Average right-eye Y gaze position across all
selected non-blink samples in the current bin.

#RIGHT IA_* SAMPLE COUNT

This will create several columns — it will create
one column for each interest area that is included
in the report calculations and one column for all
on-screen samples outside of all interest areas.
The symbol * will become an interest area index
for each column and 0 will indicate the column
for all on-screen samples that don't belong to any
other interest areas used for calculations. The
value in each column (* will become a number
indicating the interest area index) will be the
total number of right-eye samples in the current
bin that fall in that interest area. In the collapsed
output report, this reports the total number of
samples in the current bin index across all trials
within that trial group.

#RIGHT IA_* SAMPLE COUNT
%

The percentage of the total number of right-eye
samples in the current bin that fall in the *
(=index) interest area across the total number of
samples according to the selected calculation
option (i.e, all samples, valid samples including
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IA_0, or valid samples excluding IA_0). In the
collapsed output report, this variable is
calculated similarly based on the samples in the
current bin index across all trials within that trial
group. Please note IA 0 is the null interest area
(for all on-screen samples that don't belong to
any other interest areas used for calculations).

#RIGHT OFF SCREEN SAMPLE
COUNT

The total number of right-eye samples in the
current bin that fall outside of the display
boundary (off screen). In the collapsed output
report, this reports the total number of off-screen
samples in the current bin index across all trials
within that trial group.

#RIGHT OFF SCREEN SAMPLE
COUNT %

The percentage of the total number of right-eye
samples in the current bin that fall outside of the
display boundary (off screen) across the total
number of samples in the bin. In the collapsed
output report, this variable is calculated similarly
based on the samples in the current bin index
across all trials within that trial group.

#RIGHT PUPIL SIZE BIN >

Average right-eye pupil size across all selected
non-blink samples in the current bin.

SAMPLE INTERVAL

The time interval between samples (4, 2, 1, or
0.5 milliseconds) for the trial, depending on the
version of the tracker and setting used during
data collection.

SAMPLING RATE

The sampling rate of the eye tracking system
(250, 500, 1000, or 2000 Hz) for the trial,
depending on the version of the tracker and
setting used during data collection.

TRIAL INDEX

Sequential order of the trial in the recording.

TRIAL LABEL

Label of the trial.

q TRIAL_START TIME ’

The start time (in milliseconds since EyeLink
tracker was activated; i.e., EDF file time) of the
trial. If a valid reaction time is found in the trial,
TRIAL START TIME will be set to the start
time of the reaction time definition instead.

Those variables in the trial-based report marked with # will also be available in the
collapsed report. The following variables are specific to the collapsed report.

| Field

‘ Contents
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GROUP INDEX Order of the trial group in the viewing session.

GROUP_LABEL Label of the trial group (encoding the value(s) of
the grouping variable(s) for the current trial
group).

GROUPING_VARIABLES Label(s) of the grouping variable(s) for the
current viewing session.

BIN TRIAL COUNT Total number of trials that contribute data to the
current bin.

Note ' Variables beginning with “AVERAGE ” are affected by the “Cyclopean Mode”
setting in the Output/Analysis Preferences. If one eye has valid data whereas the other

eye has missing data or is not recorded at all, the "AVERAGE_*" data in the report will

be based on the good eye if the “Cyclopean Mode” is enabled. Otherwise, a missing

value will be reported if no valid data is available from either eye. The “Cyclopean Mode”
option has no effect when both eyes have valid or missing data. In addition to the analysis
of binocular recording data, the “AVERAGE_*” variables will be useful for reports when
the original EDF files were recorded with different eyes across participants (please make
sure the “Cyclopean Mode” option in the Output/Analysis Preferences is turned on).

Note > The pupil size and gaze data change rapidly when a blink starts or ends. As a
result, all of the samples in a blink saccade are removed in the average X, Y, and pupil
size calculations.

Note * If a valid reaction time definition is found in a trial, the § TRIAL_START TIME
variable will be set as the start of the reaction time definition; otherwise this will be set as
the start of trial recording (see section 6.5.3 on discussion of three time periods used in
Data Viewer). Please note that the data output in the Time Course Analysis report
critically depends on the setting of the interest period filter (see section 6.4.2 or Figure 6-
22) because consecutive time windows are created starting from the beginning of the
currently-selected interest period.

6.13.4 Configuring the Time Course Analysis Report

The Time Course Analysis report provides the following configurable settings.
1) Bin Interval (in Milliseconds): This sets the size of consecutive time windows (by
default, 20 milliseconds). The first time bin starts from the beginning of the
currently-selected interest period.

2) Maximum Number of Bins: This sets the maximum possible time bins (by
default, 2000) that will be created for the trial-based and collapsed reports. Fewer
time bins will be actually created if trials are short. If set to -1, the maximum bin
number will be based on the longest loaded trial in the currently-selected interest
period.
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3) Interest Areas Used for Calculations: This allows users to specify a set of interest
areas to be used in the Time Course Analysis. If the edit box is left empty, four
interest areas will be used with the IDs being 1, 2, 3, and 4. Users can provide
customized interest area settings (IDs or labels) in the edit box, using a comma to
delimit interest areas.

i. If a single number is specified in the edit box, interest area IDs are
mapped from1 to the given number. Maximum number of interest areas
supported is 10.

ii. If a series of elements (IDs or labels) are provided in the edit box
separated by commas, the interest areas will be mapped according to the
IDs or labels provided in sequence. Examples entries can be “1, 3, 4, 6” or
“Target, 2nd_targ, comp 1, comp 2” (all of the characters are case-
sensitive). Adding the IA_* ID variable to the report will provide
feedback on the ID and label of the interest areas used. The interest area
IDs or labels that you type into the edit box have to map on to the actual
IDs or labels used in your viewing session; otherwise, the time-course
analysis will not be able to identify the interest areas required for the
calculations.

Note — should a collapsed report be created to average data in the same time bin
across all trials within each trial group, users must make sure the type of interest
areas are consistent across all trials (e.g., interest area #1 refers to target across all
trials, #2 refers to 2nd_targ, #3 refers to comp_1, etc.).

4) Calculation of the Proportions of Samples in Each Interest Area: In any given
time window, the eye samples can be classified into the following categories
(assuming that there are four valid interest areas): blink samples, off-screen
samples, samples in Interest Area 1, samples in Interest Area 2, samples in
Interest Area 3, samples in Interest Area 4, samples not falling into any interest
areas (i.e., Null Interest Area 0), and other possible excluded samples. The last
category consists of samples excluded due to certain data selection considerations
discussed in the next section (e.g., users may just analyze the fixation data while
ignoring all samples during saccades). For most time series analyses, the
AVERAGE_IA_*_SAMPLE_COUNT, LEFT_IA_*_SAMPLE_COUNT,
RIGHT_IA_*_SAMPLE_COUNT, and / or the corresponding *_% variables will
be required.

The proportions of samples to each interest areas can be calculated in several
ways.
i.  Across All Samples — this simply divides the number of samples in each
interest area by the total number of samples in the time bin to get the
percentage value.
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5)

6)

ii.

iil.

Across All On-Screen Samples (i.e., Samples Assigned to All Interest
Areas, including Null IA 0) - this divides the number of samples in each
interest area by the sum of all samples made to each interest area,
including the Null interest area O (i.e.,IA_1_samples + IA_2_samples +
IA_3_samples + IA_4_samples + [A_0O_samples) to get the percentage
value.

Across All Samples Assigned to Predefined Interest Areas Only (i.e,
Excluding Samples to Null IA 0) - this divides the number of samples in
each interest area by the sum of all samples made to each interest area
ignoring the null interest area 0 (i.e.,IA_1_samples + IA_2_samples +
IA_3_samples + IA_4_samples) to get the percentage value.

For all of the above scenarios, the percentage values for the blink, off-screen, and
other-exclusion samples are calculated based on the total samples in the time bin.

Data Selection: The EyeLink event parser groups individual eye samples into
fixations, and saccades (a blink is contained within and is part of a saccade event).
The Time-Course Analysis report allows users to choose which samples to be
included in the analysis.

1.

ii.

iil.

Include All Samples in Fixations and Saccades — this uses all of the
samples in the time window.

Exclude Samples during Saccades — this basically uses fixation samples
only (samples during saccades and blinks are excluded from analysis).
Exclude Samples during Saccade and Exclude Bins that Contain Non-
Fixation Samples — this checks whether any samples in the time bin
belong to a saccade or blink. If so, data from the entire time bin are
excluded from the analysis.

Create a Separate Report, Collapsing Data Across All Trials in the Same Trial
Group: This option, if checked, allows users to create a collapsed Time-Course
Analysis report by averaging data in the same time window across all trials within
each trial group. Please make sure trial grouping is performed before creating the
report (by default, data will be averaged across all trials of the same participant as
trials are grouped by Recording Sessions/EDF files).

6.14 Recording Event Sequence Data

Recording Event Sequence Data is a trimmed version of the EyeLink ASC file. For each
trial, it outputs the selected events only and excludes the hidden events.

6.14.1

Creating Recording Event Sequence Data
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To create a recording event sequence data report:
1) From the menus, choose:
Analysis — Reports — Recording Event Sequence Data.

2) In the “Please select the Recording Session(s)” dialog box, select the recording

session(s) to be included in the Event Sequence Data report.

~e" Please select the Recording Session(s): ﬁl

~Session(s)

dynamic_1

[~ Create an Event Sequence for All Custom Interest Periods

o

0 ~rt+ TD M= e
O REpPOortir Datain

Select All Deselect All I Cancel || OK I

Figure 6-40. Creating a Recording Event Sequence Data Report

3) In the Save dialog box, browse to the directory in which you want to save the

data. Type in the name for the report file in the File name text box.
4) Click “Save” button.

6.14.2 Formats of the Recording Event Sequence Data

The following output is a trimmed version of a sample recording event sequence report.

text

START 63636314

MSG 63595059 TRIALID PAGEl

BUTTON 636362835 true

MSG 63636309 DRIFTCORRECT LR LEFT at 512,384 OFFSET 0.55 deg. 14.7,-8.8 pix.

MSG 63636309 DRIFTCORRECT LR RIGHT at 320,40 OFFSET 0.15 deg. =-1.9,-4.7 pix.

MSG 63636312 RECCFG CR 250 2 1

MSG 63636312 GAZE_COORDS 0.00 0.00 1023.00 767.00

EFIX R 63636322 63636732 414 515.0 389.5 1684.0 false [72: dogs,]

MSG 63636446 DISPLAY ON

MSG 63636449 SYNCTIME 3

BUTTON 63636709 5 false

ESACC R 63636736 63636788 56 514.0 388.2 257.7 25.9 13.546693
374.97235 false

EFIX R 63636792 63636912 124 249.2 36.0 1368.0 false [4: read]

ESACC R 63636916 63636940 28 243.7 40.9 124.3 32.9 3.9540324
215.27245 false

EFIX R 63636944 63637164 224 115.4 40.3 1244.0 false [1: Buck]

ESACC R 63637168 63637192 28 116.7 42.6 197.1 43.5 2.6579807
165.28857 false

EFIX R 63637196 63637376 184 199.5 47.6 1363.0 false [3: not]

ESACC R 63637380 63637396 20 204.1 49.7 272.5 52.5 2.285299 168.15387
false

EFIX R 63637400 63637616 220 277.6 55.6 1537.0 false [4: read]

ESACC R 63637620 63637640 24 281.3 59.2 360.4 51.3 2.6691074
179.91034 false

EFIX R 63637644 63637840 200 364.0 57.4 1665.0 false [6: newspapers, ]
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ESACC R 63637844 63637872 32 364.3 58.8 520.4 43.3 5.276039 284.2054 false

EFIX R 63637876 63638016 144 522.9 48.2 1772.0 false [6: newspapers, ]

ESACC R 63638020 63638044 28 523.9 47.8 637.2 36.6 3.7913043
233.63866 false

EFIX R 63638048 63638328 284 635.6 42.6 1848.0 false [9: would]

EFIX R 63658584 63658824 244 603.0 686.2 2092.0 false [141: four]

ESACC R 63658828 63658844 20 601.5 691.9 526.2 690.5 2.4371634
178.58197 false

EFIX R 63658848 63659080 236 520.3 695.5 2070.0 false [139: around]

ESACC R 63659084 63659104 24 519.7 698.5 616.3 687.9 3.133251 208.82329
false

EFIX R 63659108 63659372 268 621.5 691.2 2141.0 false [141: four]

ESACC R 63659376 63659400 28 620.2 694.5 737.4 700.3 3.723637 224.23352
false

EFIX R 63659404 63660120 720 746.9 711.4 2172.0 false [142: sides.]

BUTTON 636600335 true

MSG 63660033 ENDBUTTON 5

MSG 63660150 TRIAL RESULT 5

END 63660135

6.14.2.1 Fixation Events

Fixation events are recorded in the format of:
* EFIX <eye> <stime> <etime> <dur> <axp> <ayp> <aps> <ma> <ia>

The values following EFIX (end fixation) report the eye used in the recording, the time of
the first and last sample in the fixation, and computes the duration of the fixation in
milliseconds. The average X and Y eye position (the type of position data is determined
when the event was generated) and the average pupil size (area or diameter) are reported.
In addition, the output contains information on whether the fixation has been manually

adjusted <ma> and the ID and name of the interest area in which the current fixation falls
<ia>.

6.14.2.2 Saccade Events

Saccade events are recorded in the format of:

* ESACC <eye> <stime> <etime> <dur> <sxp> <syp> <exp> <eyp> <ampl>
<pv> <ma~>

The values following ESACC (end saccade) report the eye used in the recording, the time
of the first and last sample in the saccade, its duration in milliseconds. The X and Y eye
position at the start and end of the saccade (<sxp>, <syp>, <exp>, <eyp>) are listed. The
total visual angle covered in the saccade is reported by <ampl>, which can be divided by
(<dur>/1000) to obtain the average velocity. Peak velocity is given by <pv>. In
addition, the output contains information on whether the saccade has been manually
adjusted <ma>.

6.14.2.3 Blink Events

Blink events are recorded in the format of:
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« EBLINK <eye> <stime> <etime> <dur>

The values following EBLINK (end blink) report the eye used in the recording, the time
of the first and last sample in the blink, and the duration of the blink in milliseconds.

6.14.2.4 Message Events

Messages are recorded in the format of:
* MSG <time> <message>

A message line contains the text of a time stamped message. The <message> text fills
the entire line after the timestamp <time> and any blank space following it.

6.14.2.5 Button Events

Button events are recorded in the format of:

e BUTTON <time > <button #> <button pressed>

Button lines report a change in state of buttons on a supported button box attached to the
host computer. The <button #> reports which button has changed state. The

<button_pressed> value will be true if the button has been pressed, false if it has been
released.

6.14.2.6 Input Events

Input events are recorded in the format of:
* INPUT <time > <input value>
INPUT lines report a change in state of input channel (e.g., digital input port of the

analog card, or the input channel on the Host PC parallel port) the tracker is monitoring.
The <input value> reports the value of the input event received.
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7 Protocol for EyeLink Data to Viewer Integration

Data Viewer can interpret a range of message commands contained within EyeLink data
files that allow the software to automate some of the viewer configuration for a given
data file or trial. Examples of these commands include defining the image or images over
which gaze data is plotted, and specifying trial variables. These messages can be written
by the display experiment to the EDF file using the API function that allows the writing
of a custom message to the EDF file.

Messages that make up the EyeLink data file protocol for the viewer are not added to the
Message list that is created for viewing within the viewer tool. Message commands are
therefore invisible to the viewing windows, and are only interpreted by the Viewer during
data file loading.

Important: Do not use space characters in any component of a viewer message

command; the space character is used to tokenize and interpret all viewer messages.
Instead of using a space character within a message token, use the _ character.

7.1 Defining the Start and End of a Trial

Data Viewer uses two special message commands to define what should be considered
the start and end of a trial for the purpose of parsing the EyeLink data files.

7.1.1 Trial Start Message

Identifier (Default): TRIALID

Description:

This message defines the start of a trial. This is not the same as the start of recording
message “START” that is logged when the trial recording begins. The viewer will not
parse any messages, events, or samples that exist in the data file prior to this message.

The command identifier can be changed in the data loading preference settings.

Format:
TRIALID <Trial ID value list>

Example:

MSG 3362269 TRIALID PIX1 Blurred

EyeLink Data Viewer ©2002-2017 SR Research Ltd. 190



Note: If the trial start message is not found, or if no trial start message is defined for the
viewing session, the START message is used to indicate the start of a trial for the Viewer.

7.1.2 Trial End Message

Identifier (Default): TRIAL RESULT

Description:

This message defines the end of a trial. This is not the same as the end of recording
message “END” that is logged when the trial recording ends. The viewer will not parse
any messages, events, or samples that exist in the data file after this message. The

command identifier can be changed in the data loading preference settings.

Format:
TRIAL RESULT <possible trial result values>

Example:
MSG 3383842 TRIAL RESULT O

Note: If the trial end message is not found, or if no trial end message is defined for the
viewing session, the END message is used by Data Viewer to indicate the end of a trial.

7.2 Pre-Trial Message Commands
The following message commands, if defined, MUST be sent to the EyeLink data file
prior to the Trial Start message defined above (i.e., outside the scope of a trial as defined

for Data Viewer). If they are sent during trial recording, these messages will not be
interpreted.

7.2.1 Trial Variable Labels
Identifier (Default): TRIAL VAR LABELS
Description:

This message allows the definition of the labels to be used for trial variables within Data
Viewer. The command identifier can be changed in the data loading preference settings.

Format:
TRIAL VAR LABELS <trial variable list>
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Example:

MSG 3363553 TRIAL VAR LABELS TRIAL VAR 1 TRIAL VAR 2 TRIAL VAR 3

7.2.2 Display Coordinates
Identifier: DISPLAY COORDS or GAZE COORDS
Description:

This message specifies the display coordinates to be used within Data Viewer. This
message MUST be present for the viewer to function correctly.

Format:
DISPLAY COORDS <left> <top> <right> <bottom>

Left, top, right, and bottom refer to the x-y coordinates of the top-left and bottom-right
corners of display.

Example:

MSG 3325521 DISPLAY COORDS 0 0 1279 1023

7.2.3 Trial Grouping

Identifier: V. TRIAL GROUPING
Description:

The trial grouping message is used to group together trials that are in the same
experimental condition, so that they can be manipulated (e.g., selecting, hiding, deleting,
applying interest area templates) collectively. This message must be sent after
TRIAL VAR LABELS message but before first trial start message in the EDF file.

Format:
V_TRIAL GROUPING <trial variable list>

The trial grouping variable(s) must be a member of the variables listed in the
TRIAL VAR LABELS; otherwise, this variable is ignored.

Example:

MSG 3363553 V_TRIAL GROUPING TYPE DIRECTION
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Note: Trial variables are space delimited. Trial variables that do not exist in the variable
list for that trial (see section 7.2.1) are ignored.

7.3 Trial Message Commands

The following message commands MUST be specified within the scope of a trial, or the
message commands will not be interpreted by Data Viewer.

IMPORTANT: All message commands within the trial scope must start with a 'V
directive, or the command will not be interpreted and will instead appear as a regular
message in the visible message list.

Tip: In almost all instances, each of the following commands will be repeated for every
trial of an EyeLink data file.

7.3.1 Trial Variable Values

Identifier (Default): TRIAL VAR DATA

Description:

This message specifies the list of trial variable values for the trial. The list of trial
variable values must be in the same order as was specified in the TRIAL VAR LABELS
command for the viewer to properly match the variable label with the variable value. The
command identifier can be changed in the data loading preference settings.

Note: If this command is the same as the Trial Start Command (TRIALID), the values
will still be extracted from the Trial Start Line; however a !V is not needed in the
message.

Format:

!V TRIAL VAR DATA <trial variable list>

Example:

MSG 3363553 !V TRIAL VAR DATA valuel value2 value3

7.3.2 Single Trial Variable Message Token
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Identifier (Default): TRIAL VAR
Description:

This command lets users specify a trial variable and value for the given trial. One
message should be sent for each trial condition variable and its corresponding value. If
this command is used there is no need to use TRIAL VAR LABELS. The default
command identifier can be changed in the data loading preference settings. Please note
that the eye tracker can handle about 20 messages every 10 milliseconds. So be careful
not to send too many messages too quickly if you have many trial condition messages to
send. Add one millisecond delay between message lines if this is the case.

Format:

!V TRIAL VAR <trial var label> <trial var value>

<trial var label> is the label for the variable being set. If the current Data Viewer session
does not have this variable yet, it is created. <trial var value> defines the value to set
for the variable for the given trial.

Example:

MSG 9350338 !V TRIAL VAR trial 1

MSG 9350339 !V TRIAL VAR condition gap

MSG 9350340 !V TRIAL VAR direction Left

MSG 9350341 !V TRIAL VAR gap duration 200

MSG 9350342 !V TRIAL VAR t x 212

MSG 9350343 !V TRIAL VAR t_y 384

7.3.3 Image Commands

Data Viewer supports a set of commands that display a default image on the overlay
mode of the Trial View Window. All image commands use the IMGLOAD token,

followed by a sub command.

7.3.3.1 Image Loading — Fill Full Screen
Identifier: FILL

Description:
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This message specifies the image to be used as the background for the Spatial Overlay
View of a trial within the viewer. The image is sized to fit the dimensions specified in the
DISPLAY COORDS command message. If images are specified with names only
(without a relative or absolute path), Data Viewer will look for the image in the following
order:

1) In the default image directory specified in the General Preferences settings.

2) In the directory the EyeLink data file is loaded from.

3) In the directory the viewer application is running from.

Format:
!V IMGLOAD FILL <relative image path>

Example:
MSG 3388468 !V IMGLOAD FILL Sac blur.jpg
7.3.3.2 Image Loading — Top Left
Identifier: TOP_LEFT
Description:
This message specifies an image to be used as a segment of the Spatial Overlay View.
The image size is not changed (unless width and height parameters are also specified) and
will be positioned by using the x and y positions specified as the top left corner of the
image. If images are specified with names only (without a relative or absolute path),
Data Viewer will look for the image in the following order:

1) In the default image directory specified in the General Preferences settings.

2) In the directory the EyeLink data file is loaded from.

3) In the directory the viewer application is running from.

Format:

!V IMGLOAD TOP_ LEFT <relative image path> <x position>
<y position> [width] [height]

Note: width and height are optional parameters
Example:

MSG 2740540 !V IMGLOAD TOP LEFT fixations.gif 200 200
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7.3.3.3 Image Loading — Centered
Identifier: CENTER
Description:
This message specifies an image to be used as a segment of the Spatial Overlay View of a
trial within the viewer. The image size is not changed (unless width and height
parameters are specified) and will be positioned centered on the x-y coordinate specified.
If images are specified with names only (without a relative or absolute path), Data
Viewer will look for the image in the following order:

1) In the default image directory specified in the General Preferences settings..

2) In the directory the EyeLink data file is loaded from.

3) In the directory the viewer application is running from.

Format:

!V IMGLOAD CENTER <relative image path> <x position> <y position>
[width] [height]

Note: width and height are optional parameters
Example:

MSG 2740540 'V IMGLOAD CENTER fixations.gif 200 200

7.3.4 Simple Drawing

Besides image loading, Data Viewer also supports a set of commands that draw simple
graphics, such as lines, framed boxes, or filled boxes, as well as display clearing.

7.3.4.1 Clear Overlay View
Identifier: CLEAR
Description:

This command clears the overlay view to the color specified by the red, green, blue
integer values specified in the command. Each RGB value should be an integer between
0 and 255.
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Format:
!V CLEAR <red> <green> <blue>
Example:

MSG 2740540 !V CLEAR 255 255 255

This clears the display to white color.

7.3.4.2 Drawing a Line
Identifier: DRAWLINE
Description:

This command draws a line with the color specified by the red, green, blue integer values
specified in the command. Each RGB value should be an integer between 0 and 255.

Format:

!V DRAWLINE <red> <green > <blue > <x start> <y start> <x end>
<y_end>

<x_start>: x-coordinate of the starting point; <y_start>: y-coordinate of the starting point;
<x_end>: x-coordinate of the end position; <y end>: y-coordinate of the ending position.

Example:

MSG 9441901 !V DRAWLINE 255 0 0 100 100 300 400

This draws a red line, connecting (100, 100) and (300, 400).
7.3.4.3 Drawing a Rectangle

Identifier: DRAWBOX

Description:

This command draws an unfilled rectangle in the color specified by the red, green, blue

integer values specified in the command. Each RGB value should be an integer between
0 and 255.
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Format:
!V DRAWBOX <red> <green> <blue> <left> <top> <right> <bottom>

Note: Left, top, right, and bottom refer to the x-y coordinates of the top-left and bottom-
right corners of rectangle.

Example:
MSG 9441901 !V DRAWBOX 0 255 0 200 300 400 500

This draws a green rectangle (frame), with the top-left corner at (200, 300) and the
bottom-right corner at (400, 500).

7.3.4.4 Drawing a Filled Rectangle

Identifier: FILLBOX

Description:

This command draws a filled rectangle with the color specified by the red, green, blue
integer values specified in the command. Each RGB value should be an integer between
0 and 255.

Format:

1V FILLBOX <red> <green> <blue> <left> <top> <right> <bottom>

Note: Left, top, right, and bottom refer to the x-y coordinates of the top-left and bottom-
right corners of rectangle.

Example:
MSG 9441901 !V FILLBOX 0 0 255 400 500 500 600

This draws a rectangle, with the top-left corner at (400, 500) and the bottom-right corner
at (500, 600). The rectangle is filled with the blue color.

7.3.4.5 Drawing a Fixation Point
Identifier: FIXPOINT
Description:

This command draws a fixation point at a specified position.
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Format:

!V FIXPOINT <target red> <target green> <target blue> <erase red>
<erase_green> <erase blue> <x> <y> <outer diameter>

<inner diameter>

Note: The RGB values for the fixation point drawing color is specified by the

<target red> <target green> <target blue> whereas the color of the fixation center is
specified by <erase red> <erase green> <erase blue>. The fixation point is drawn at the
screen coordinate specified by <x> and <y>. The <outer diameter> and

<inner diameter> specify the diameters of the drawing circles.

Example:
MSG 9441901 !V FIXPOINT 0 0 0 255 255 255 511 383 18 4

This draws a fixation point at (511, 383), with a diameter of 18 pixels for the outer ring
and 4 pixels for the inner ring. The fixation point is drawn in black and its center is
erased with white.

7.3.4.6 Draw List File
Identifier: DRAW_LIST
Description:

When a large number of simple drawings have to be made, it is easier to first record all of
the simple drawings in a draw list file. Data Viewer reads in the drawing commands from
the pre-recorded draw list file and re-creates the display drawing. In a draw list file (.dlf),
each line represents one simple drawing or an image loading command written in the
same format as mentioned above except that "!'V" directive is not necessary.

Format:
!V DRAW LIST <relative path>

Example:
Example: MSG 262495 !V DRAW LIST BER\s1106.d1f

The content of the file being:

CLEAR 255 255 255

IMGLOAD TOP_LEFT BER\color.bmp 772 644 33 33
IMGLOAD TOP LEFT BER\shape.bmp 772 314 33 33
IMGLOAD TOP_LEFT BER\orient.bmp 222 424 33 33
IMGLOAD TOP_ LEFT BER\color.bmp 552 94 33 33

This first clears the display and then loads four small bitmap images.
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7.3.5 Interest Area Commands

Data Viewer supports a set of interest area commands that inform the software which
interest areas to create by default for a given trial. Trials that have interest area
commands specified in the data file have a custom interest area set created when the data

is loaded containing the specified interest areas.

All interest area commands start with the TAREA token and are followed by a one word
sub command.

7.3.5.1 Rectangular Interest Area
Identifier (Default): RECTANGLE
Description:

This message specifies the attributes of a rectangular interest area for the trial. Each trial
can have a set of such rectangular interest areas.

Format:

!V IAREA RECTANGLE <id> <left> <top> <right> <bottom> [label

string]
Note: The label string parameter is optional.
Example:
MSG 2740540 !V IAREA RECTANGLE 1 547 410 585 449 square
7.3.5.2 Elliptical Interest Area

Identifier (Default): ELLIPSE
Description:

This message specifies the attributes of an elliptical interest area for the trial. Each trial
can have a set of such elliptical interest areas.

Format:
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'V IAREA ELLIPSE <id> <left> <top> <right> <bottom> [label

string]

Note: The label string parameter is optional. Left, top, right, and bottom refer to the x-y
coordinates of the top-left and bottom-right corners of the bounding rectangle.

Example:

MSG 2740540 !V IAREA ELLIPSE 2 647 310 685 349 circle
7.3.5.3 Freehand Interest Area

Identifier (Default): FREEHAND

Description:

This message specifies the attributes of a freehand interest area for the trial. Each trial can
have a set of such freehand interest areas.

Format:

'V IAREA FREEHAND <id> <Xx > <X > ... <X > [label string]
1M1 252 n>XVn

Note: The label string parameter is optional. x ,y, refers to the X,) coordinates of a
point. The x, y coordinates of each point are separated by a comma.

Example:

MSG 2740540 !V TAREA FREEHAND 3 512,284 612,384 512,484 412,384 diamond
7.3.5.4 Interest Area Set

Identifier (Default): FILE

Description:

When a large number of interest areas have to be specified (such as in reading research),
it is easier to first write all the interest area information into a text file and Data Viewer

can then locate and import this interest-area set file. The !v IAREA FILE serves this

purpose. In an interest-area file, each line represents one interest area, recorded in the
format of “RECTANGLE id left top  right bottom [label]” for a
rectangular interest area, “ELLIPSE id left top  right bottom [label]” for
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an elliptical interest area, and “FREEHAND id x,y, x,,y, ... x,,», [label]” for a

freechand interest area.

Format:

!V IAREA FILE <relative file path>

Example:

MSG 2740540 'V

IAREA FILE

segments\example.ias

The following are some example interest areas contained in an .ias file.

RECTANGLE
RECTANGLE
RECTANGLE
RECTANGLE
RECTANGLE
RECTANGLE

o O W N

7.3.6 Target Position Commands
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For experiments in which a moving resource is used, users may need to keep track of the
position of the resource. Data Viewer allows users to calculate the position, velocity, and
acceleration data of the target for each individual sample in the sample output report.
With such messages, position, velocity, and acceleration can also be displayed in the
Temporal Graph View.

Identifier (Default): TARGET POS

Description:

This message specifies the position and visibility of the targets at the specific message
time. The command identifier can be changed in the data loading preference settings. A
semicolon is required if you are supplying two target positions.

Format:

!V TARGET POS <Targetl Key> <(targetl x, targetl y)> <target 1

visibility> <target 1 step>;

<Target2 Key> <(target2 x, target2

y)> <target 2 visibility> <target 2 step>
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Where <Targetl Key> and <Target2 Key>: the tokens to extract the
position(s) of target(s);
<(targetl x, targetl y)> and <(target2 x, target2 y)>: the
position(s) of the targets. The coordinates must be enclosed in
a pair of brackets;
<target 1 visibility> and <target 2 visibility>: if 1, the
targets are visible; if 0, the targets are hidden;
<target 1 step> and <target 2 step>: if 1, the position of the
target will be in steps; if 0, the position of the target is

interpolated across samples.
Example:

MSG 9071000 !V TARGET POS TARGLl (351, 278) 1 0; TARG2 (590, 134) 1 O

Note: Users can use any token word to indicate the target ID. The "key" property of the
Temporal Graph View preference settings is set to blank by default so that various token
words can be used. If two targets are involved and if the order of the two targets is
important, set that field to the token strings used in the target position command string.

7.4 Reaction Time Definitions

To obtain an accurate reaction time (RT) measure, the EyeLink Data Viewer relies on a
set of reaction time definitions to parse the start and end events for RT calculation. The
reaction time definition command messages inform the Viewer of the RT start message,
the type of RT end events (fixation, saccade, message, or button), the parameters of the
end event, as well as the conditions to which the RT definition is applied. Reaction time
definition commands can be provided in two ways. Users can employ a pre-trial
(condition-based) command message to specify an RT definition for each of the
experimental conditions. All pre-trial reaction time commands start with the V_RT token
and are followed by a one word subcommand, indicating the type of RT end event
(BUTTON, MESSAGE, FIXATION, or SACCADE). Alternatively, users can supply a
custom reaction time definition specifically for each trial. All custom trial-specific
reaction time commands start with the 'V V_CRT token and are followed by a one word
subcommand. Users can also choose to create the reaction time definitions right in the
viewing session after the data is collected.

Important: When an EyeLink Data File is loaded into the Viewer, existing Reaction
Time Definitions for the Viewing Session will be applied to the new data file just

imported, and override custom RT definitions if there are any in the newly imported EDF
files.
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7.4.1 Button Events

Identifier: BUTTON

Description:

This will treat a particular button press/release as the reaction time end event.
Pre-Trial Message Command Format:

V_RT BUTTON <rt start msg> <button id> <state> [CONDITION LABEL 1]
[condition wvalue 1] [CONDITION LABEL 2] [condition value 2]

Trial-specific Message Command Format:

!V V_CRT BUTTON <rt start msg> <button id> <state>

Note: Button_id refers to the intended button ID (from 1 to 8, use 0 for any button event).
Button state could be 0 (button release) or 1 (button press). Condition labels and their
values are not required for the trial-specific message commands and are optional for the
pre-trial message command (if not specified, the RT definition is applied to all
conditions). In case both a condition-based pre-trial message command and a custom
trial-specific message command are applicable for one trial, the trial-specific command
will override the more general one.

Example:
MSG 329381 V_RT BUTTON SYNCTIME 5 1 TYPE normal

In this example, the end event for RT calculation is pressing button 5. This RT definition
is applicable to the condition in which the value of the variable TYPE is “normal”.

7.4.2 Fixation Events

Identifier: FIXATION

Description:

This will treat the appearance of a specific fixation as the RT end event. Users can
specify the parameters of the fixation end event: the minimum fixation duration (in
milliseconds) required, the Xy coordinates for the region center, as well as the diameter of

the fixation region.
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Pre-Trial Message Command Format:

V_RT FIXATION <rt start msg> <fixation duration> <x> <y>
<diameter> [CONDITION LABEL 1] [condition value 1] [CONDITION
LABEL 2] [condition value 2]

Trial-specific Message Command Format:

!V V_CRT FIXATION <rt start msg> <fixation duration> <x> <y>

<diameter>

Note: If the location information of the target fixation is not important, set the values of
x, v, and diameter as -1. Condition labels and their values are not required for the trial-
specific message command and are optional for the pre-trial message command (if not
specified, the RT definition is applied to all conditions).

Example:

MSG 329381 V_RT FIXATION SYNCTIME 500 -1 -1 -1

In this example, the RT end event is the occurrence of the first fixation with a minimum
duration of 500 milliseconds whereas the location information of the fixation is not
important.

7.4.3 Saccade Events

Identifier: SACCADE

Description:

This will treat the appearance of a specific saccade as the RT end event. Users can
specify the parameters of the saccade end event: the minimum saccadic amplitude (in
degrees of visual angle) required, the XY coordinates for the region center, as well as the

diameter of the fixation region.
Pre-Trial Message Command Format:
V_RT SACCADE <rt start msg> <saccadic amplitude> <x> <y> <diameter>

[CONDITION LABEL 1] [condition value 1] [CONDITION LABEL 2]

[condition value 2]
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Trial-specific Message Command Format:
!V V_CRT SACCADE <rt start msg> <saccadic amplitude> <x> <y>

<diameter>

Note: If the location information of the saccade is not important, set the values of x, y,
and diameter as -1. Condition labels and their values are not required for the trial-
specific message command and are optional for the pre-trial message command (if not
specified, the RT definition is applied to all conditions).

Example:

MSG 329381 V_RT SACCADE SYNCTIME 5.0 300 400 100 TYPE Normal

In this example, the RT end event is the occurrence of the first saccade with a minimum

amplitude of 5.0 degrees of visual angle. The saccade must fall within 50 pixels (the
radius given a diameter of 100) from the region center (300, 400).

7.4.4 Message Events

Identifier: MESSAGE
Description:

This will treat the first occurrence of a matching message as the end event for reaction
time calculation.

Pre-Trial Message Command Format:

V_RT MESSAGE <rt start msg> <rt end msg> [CONDITION LABEL 1]
[condition value 1] [CONDITION LABEL 2] [condition wvalue 2] ..

Trial-specific Message Command Format:

!V V_CRT MESSAGE <rt start msg> <rt end msg>

Note: Condition labels and their values are not required for the trial-specific message
command and are optional for the pre-trial message command (if not specified, the RT

definition is applied to all conditions).

Example:
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MSG 329381 V_RT MESSAGE SYNCTIME END RT

7.4.5 Reaction Time Definition Set

Identifier: FILE
Description:

When a large number of RT definitions have to be specified, it is easier to first record all
RT definitions into a file and later on the Data Viewer can read the RT definition file
with the V_RT FILE command. In a reaction-time definition file, each line represents
one RT definition, which is written in the same format as the pre-trial message command
for each respective type of RT end event, except that in this case V_RT token is not
necessary.

Pre-Trial Message Command Format:
V_RT FILE <relative path>

Example:
MSG 329381 V RT FILE rt\default.rts

The following is the content of an example defaults.rts file.

BUTTON SYNCTIME 2 1
MESSAGE SYNCTIME ENDBUTTON

7.5 Changes in the Sample Experiments

The preceding sections list the special messages and commands that can be sent to the
EDF file to enable the EyeLink Data Viewer to extract information in a more efficient
way. The current section provides an overview of the changes made in the sample
experiment templates. Please refer to the “Programming EyeLink Experiments in
Windows Version 2.0” manual for the description of individual templates.

7.5.1 “Simple” Template

Two EyeLink Data Viewer commands have been introduced in the “Simple” template:
“TRIAL VAR LABELS” for the definition of the labels to be used for trial condition
variables within the viewer and “TRIAL VAR DATA” for the assignment of condition
values for each trial. All these changes, listed in the following table, were made in the
w32 simple_trials.c file of the template.
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Data Viewer Functionality

Message Commands

Trial Variable Labels eyemsg_printf("TRIAL VAR LABELS
TRIAL WORD");
Trial Variable Values eyemsg_printf(“!V TRIAL VAR DATA %s”,

trial word[num-1]);

7.5.2 “Text” Template

Along with the “TRIAL_ VAR LABELS” and “TRIAL VAR DATA” commands, the
“Text” template also uses “IMGLOAD FILL” to load a single image and “IAREA FILE”
to import a file containing interest areas for the trial. All of these changes, listed in the
following table, were made in the w32 text trials.c file of the template.

Data Viewer Functionality

Message Commands

Trial Variable Labels eyemsg printf("TRIAL VAR LABELS PAGE");
Trial Variable Values eyemsg printf("!V TRIAL VAR DATA %d", num);
Images eyemsg_printf("!'V IMGLOAD FILL Images/%s",

image fn);

Interest Areas

eyemsg printf("!V IAREA FILE Segments/%s", seg fn);

7.5.3 “Picture” Template

One additional feature of the “Picture” template is the demonstration of another approach
to load images and to specify interest areas for the trial. The third trial of the template
loads individual images (IMGLOAD TOP_LEFT) to create a composite image in Data
Viewer and reads individual rectangular interest areas directly (“IAREA RECTANGLE”).
All these changes, listed in the following table, were made in the w32 picture trials.c file

of the template.

Data Viewer Functionality

Message Commands

Trial Variable Labels eyemsg printf("TRIAL VAR LABELS TYPE");

Trial Variable Values eyemsg_printf("!'V TRIAL VAR DATA %s",
imgname[num-1]);

Images

“Normal” image

eyemsg_printf("!'V IMGLOAD FILL
images/sacrmeto.jpg");

“Blurred” image

eyemsg_printf("!'V IMGLOAD FILL
images/sac_blur.jpg");

“Composite” image

eyemsg_printf("!'V IMGLOAD
TOP_LEFT %s %d %d %d %d", small images[i],
points[i].x, points[i].y, SCRWIDTH/2,
SCRHEIGHT/2);

Interest Areas

EyeLink Data Viewer

©2002-2017 SR Research Ltd. 208




“Composite” image

eyemsg_printf("!'V IAREA
RECTANGLE %d %d %d %d %d %s", i+1,
points[i].x, points[i].y, points[i].x + SCRWIDTH/2,
points[i].y + SCRHEIGHT/2, small images[i]);

7.5.4 “EyeData” Template

The following table lists all of the changes made to the w32 data_trials.c file of the

“EyeData” template.

Data Viewer Functionality

Message Commands

Trial Variable Labels eyemsg printf("TRIAL VAR LABELS CONDITION");
Trial Variable Values eyemsg_printf("!V TRIAL VAR DATA Playback");
Images eyemsg printf("!'V IMGLOAD FILL images/grid.png");

Interest Areas

eyemsg_printf("!V IAREA FILE segments/grid.ias");

7.5.5 “GCWindow” Template

The following table lists all of the changes made to the w32 gcwindow _trials.c file of the

“GCWindow” template.

Data Viewer Functionality

Message Commands

Trial Variable Labels eyemsg_printf("TRIAL VAR LABELS TYPE
CENTRAL PERIPHERAL");
Trial Variable Values
Trial 1 eyemsg_printf("!'V TRIAL VAR DATA TEXT TEXT
MASK");
Trial 2 eyemsg_printf("!'V TRIAL VAR DATA TEXT MASK
TEXT");
Trial 3 eyemsg_printf("!'V TRIAL VAR DATA IMAGE
IMAGE MASK");
Trial 4 eyemsg_printf("!'V TRIAL VAR DATA IMAGE MASK
IMAGE");
Trial 5 eyemsg_printf("!'V TRIAL VAR DATA IMAGE
IMAGE BLURRED");
Images
Trials 1 &2 eyemsg_printf("!'V IMGLOAD FILL images/text.png");

Trials 3,4, & 5

eyemsg_printf("!'V IMGLOAD FILL
images/sacrmeto.jpg");

Interest Areas

Trials 1 & 2

eyemsg_printf("!V IAREA FILE segments/text.ias");

7.5.6
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The following messages and commands have been added to the w32 control trials.c file

of the “Control” template.

Data Viewer Functionality

Message Commands

Trial Variable Labels

eyemsg printf(“TRIAL VAR LABELS CONDITION™);

The following messages and commands have been added to the w32 control trial.c file

of the “Control” template.

Data Viewer Functionality

Message Commands

Trial Variable Values

eyemsg printf("!V TRIAL VAR DATA GAZECTRL");

Images

eyemsg_printf("!'V IMGLOAD FILL images/grid.png");

Interest Areas

eyemsg_printf("!'V IAREA FILE segments/grid.ias");

7.5.7 “Dynamic” Template

One important feature introduced in the “Dynamic” template is the addition of custom
reaction time definition (!V V_CRT”) for the saccade trials. Reaction time is defined as
the interval between the onset of the target (“SYNCTIME” message) and the occurrence
of the first saccade, with a minimum amplitude of 2.0°, that falls within 25 pixels from
the saccade target (goal x, goal y). The following table lists all of the messages and
commands that have been added in the w32 data_trials.c file of the “Dynamic” template.

Data Viewer Functionality

Message Commands

Trial Variable Labels eyemsg_printf("TRIAL VAR LABELS TRIAL TYPE
DIRECTION");
Trial Variable Values eyemsg_printf("!'V TRIAL VAR DATA %d %s %s",

num, trial labels[0][num-1], trial labels[1][num-1]);

Reaction Time Definitions

Trials 3-8

eyemsg_printf("!'V V_CRT SACCADE SYNCTIME 2.0
%d %d 50", goal x, goal y);

7.5.8 “Comm_simple” Template

Similar to the “Simple” template, “TRIAL VAR LABELS” and “TRIAL VAR DATA”
commands were added to the w32 simple _trials.c file of the template (see the Table).

Data Viewer Functionality

Message Commands

Trial Variable Labels eyemsg_printf("TRIAL VAR LABELS
TRIAL WORD");
Trial Variable Values eyemsg_printf(“!V TRIAL VAR DATA %s”,

trial word[num-1]);
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7.5.9 Other Templates

Since the “Broadcast” and “Comm_listener” templates do not produce EyeLink data files,
no change has been made in those templates to support Data Viewer analysis.
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8 Preference Settings

Many properties of Data Viewer can be configured by users from the Preference tab of
the Inspector Window. These include everything from the default colors used, to which
elements of an EDF file are loaded. All the changes can be saved, allowing the changed
preference settings to be applied to subsequent viewing sessions.

Any preferences setting can be edited by clicking on the value cell and changing the
value. To make the changed preference settings persist over future sessions, users can
click the right mouse button and select "Save Properties as Defaults". Data Viewer also
supports exporting and importing of preference settings across viewing sessions.
Exporting the preference settings into a property file can be done by right-clicking and
selecting "Export Properties". To use the saved preference settings for a given session,
right click and select "Import Properties".

~e¢\ EyeLink Data Viewer Version 2.6.0 - Untitled.evs (C:\Temp\Untitled)
File Edit Analysis Window Help

I E eI R et el e R S R et R Es

~e\ Inspector ( Memory Usage 2|
@ Data #ff Preferences I
|J Preferences
% WGeneral Save Properties as Defaults

----- # Data Loading

- Ju Output / Analysis
‘ Data Filters Export Properties
#- |, Data Views Import Properties

Restore Factory Defaults

I Field Value
|lUse Right Eye if Binocular v
Include Hidden Events ]

|Def'ault Viewing Session File ... IC:\Users\Jiye\Documents
IDefauIt Data File Directory C:\Users\Jiye\Documents
IDefault IA File Directory C:\Users\Jiye\Documents

Inafaiilt Tmana Nirartars Fllcarel Tua\Nam imante

Figure 8-1. Saving Properties as Defaults.
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8.1 General Preferences

The General Preferences setting covers the following elements:

o Inspector ( Me

@ Data W Preferences |

&

Preferences

L WGeneral

# Data Loading
Qutput / Analysis

# Data Filters
Data Views

Field

Value

Use Right Eye if Binocular

Include Hidden Events

v
-

Default Viewing Session File ...

C:\Users\Jiye\Documents

Default Data File Directory

C:\Users\Jiye\Documents

Default IA File Directory

C:\Users\Jiye\Documents

Default Image Directory C:\Users\Jiye\Documents
Default Video Directory C:\Users\Jiye\Documents
Default Qutput Directory C:\Users\Jiye\AppData\Loca...
Remember Last Browsed Dir... | [V

Data Viewer Display Top 1]

Data Viewer Display Left 1]

Data Viewer Display Width 1024

Data Viewer Display Height 768

Dismiss Delay of ToolTip 40

Use Right Eye if Binocular: For a binocular

recording, which eye’s data is to be
displayed and output in any reports (right
eye if checked; left eye if unchecked);

Include Hidden Events: Whether or not to

include hidden events in the trial views
and output reports. Hidden events falling
outside of the currently selected interest
period are drawn in dashed-lines.
Checking this option will affect report
variables related to the reporting of
individual events (e.g., fixation, saccade,
message), index of the event in the trial
(e.g., CURRENT FIX_ INDEX), as well
as the total event count in the trial (e.g.,
FIXATION_COUNT).

Default Viewing Session File Directory,

Default Data File Directory, Default IA
File Directory, Default Image Directory,
Default Video Directory, and Default
Output Directory: Set default directories
for accessing viewing session files, data
file loading, interest area, images/video
loading/saving, and data output (analysis
report, fixation map, moving and trial
image saving, etc.). These settings can be
changed by clicking on the current values
and choosing a default directory from a
Set window. Note, changes to these
preference settings only take effect on files
loaded after the change. Versions 2.1 and
above support selection of multiple
directories for the "Default Image
Directory" and "Default Video Directory".

Remember Last Browsed Directory: If enabled, Data Viewer - when Viewing Session
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File Directory, Data File Directory, IA File Directory and Output Directory are
needed - will use (and automatically update) the last browsed directory instead of the
default ones.

Data Viewer Display Left and Data Viewer Display Top: Set the X and Y coordinate of
the top-left corner for Data Viewer to run properly if
DISPLAY COORDS/GAZE COORDS message is not found in the EDF file;
otherwise, these preferences are ignored.

Data Viewer Display Width and Data Viewer Display Height: Set the display width
and height to enable Data Viewer to run properly if
DISPLAY COORDS/GAZE COORDS message is not found in the EDF file;
otherwise, these preferences are ignored.

Dismiss Delay of Tooltip: This sets how long (in seconds) a tooltip (description of a

property or preference settings when you hover the mouse pointer over the item
without clicking on it) will be displayed.
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8.2 Data Loading Preferences

Data loading preference settings consist of the following parameters:

- ﬂ
@ Data W Preferences |
, Preferences

# General

.
Output / Analysis

# Data Filters
, Data Views

Field Value
Load Samples v -~
Load Fixations v
Load Saccades v
Load Blinks v
Load Messages v
Load Buttons v
Load Input Events v
Load ExperimentBuilder Lo... | [
Read INPUT Data from Ev... | [V
Trial Segmentation Type Message Based
ITrial Load Start Value TRIALID
Trial Load End Value TRIAL_RESULT
All Trial Variable Labels Me... TRIAL_VAR_LABELS
All Trial Variable Values Me... TRIAL_VAR_DATA
Single Trial Variable Message [TRIAL_VAR
'Target Position String TARGET_POS
Collapse Identical Interest ...| v |
Prompt for the Interest Ar... | [V
Exclude Message String
L~

EyeLink Data Viewer

Load Samples, Load Fixations, Load
Saccades, Load Blinks, Load
Messages, Load Buttons, Load Input
Events: Allow the loading of samples,
fixations, saccades, blinks, messages,
and buttons from the EDF files. By
default samples and all events are
loaded.

Load Experiment Builder Log Messages:
If enabled, Data Viewer will import
Experiment Builder generated log
messages into the viewing session (if the
log file exists in the same folder as the
EDF file).

Read INPUT Data from Events: This
determines whether the INPUT events in
the viewing session are loaded from the
events or from the sample stream in the
EDF file. This option is ignored if the
EDF file contains the INPUT data in the
sample stream only, or in the event
stream only.

Trial Segmentation Type: This allows users
to define the start and end of a trial in
Data Viewer based on the supplied
message or input values. For each trial,
all events/samples before the start
message/input event or after the end
message/input event will not be loaded.
By default, Data Viewer treats
“TRIALID” as the start message for data
loading and “TRIAL RESULT” as the
end message. Users can supply their
own messages to split a continuous long
recording into shorter trial segments. An
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alternative to the default Message Based
trial segmentation is to use Input data, in
which case users should supply input
values to mark trial start and trial end.

Trial Load Start Value: This message/input value is used to define the start of a trial
segment. A new trial segment will be created upon the START of the recording if the
Trial Load Start Value is not supplied, missing, or found after the start of the
recording segment.

Trial Load End Value: This message/input value is used to define the end of a trial
segment. This field is optional. If the end value is not supplied or found, Data
Viewer will define the end of trial using the next start message/input value or the
END event of the trial recording, whichever comes first.

All Trial Variable Labels Message and All Trial Variable Values Message: The former
allows the definition of labels to be used for trial variables within the viewer and the
latter specifies the list of trial variable values for the trial. By default, the trial
variable labels message is set as “TRIAL VAR LABELS” and the trial variable
values message is set as “TRIAL_ VAR DATA”.

Single Trial Variable Message: This command lets users specify a trial variable and
value for the given trial. Send one message for each pair of trial condition variable
and its corresponding value. This means that there is really no need to use the
TRIAL VAR LABELS command when using the TRIAL VAR command. Default
command token is "TRIAL VAR".

Target Position String: String used to specify the position of the targets at the specific
message time.

Collapse Identical Interest Areas with Different Time Stamps: If checked (the default
setting), all interest areas with identical coordinates and label will be merged together
(and thus treated as one single interest area). If unchecked, interest areas are
organized based on the time stamps and therefore interest areas with identical
coordinates and label but different time stamps are treated as separate items. In
general, the former approach is typically used if the data analysis is done on the
whole trial recording whereas the latter setting is used if the data analyses are done
based on individual interest periods.

Prompt for the Interest Area Import: When saving an interest area set into a file, this

option will make the interest area set available to the current viewing session so that
you don't have to re-import the saved interest area set file.
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Exclude Message String: Any messages (within the scope of a trial as defined by the
Trial Load Start Message and Trial Load End Message) containing the string will be
ignored by the Viewer. Add a “;” to separate multiple message strings.

Enable SceneLink Gaze Mapping: If checked, allows users to load EDF file with
mapped gaze data to scene video coordinates.

Generate SceneLink Frame Message: If checked, allows users to generate frame
number messages when loading file. The frame number message will only be written
if a lookup table has been created for synchronized playback of eye movement data
over the scene video (see section 5.1 of the "EyeLink II Scene Camera User
Manual").

Default Encoding: This option is used in case the interest area files are saved in a
different encoding type. Leave this to Default unless you know the exact encoding of

the interest area files to import.

Note: Users have to save the preferences and reload the data file before the changes in
the above preference settings take effect.
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8.3 Output/ Analysis

The Output / Analysis preferences settings consist of the following elements:

&P Data gf Preferences I

2|

| Preferences
# General
# Data Loading
b
# Data Filters
-, Data Views

| Field

Value

|0utput Reports

Use UTF8 Encoding

i [

Variable Delimiter ( \t for T...

Missing Value

Decimal Places

Include Hidden EventsinR...

Treat Hidden Events as Mi...

Bracket Strings with Quotes

Exclude Trials with Messag...

Use Nearest Interest Area...

Use Nearest Interest Area...

Auto Select Interest Area ...

Create One Report File Pe...

Cyclopean Mode

e

1As Handling

Perfom Sample Based Calc...

Include Fixation in Single IA

Assign Fixations to Dynami...

Allow Interpolation

<I<T™

Interpolation Interval in ms

[
o
o

Identify First/Last Saccade...

Apply Offset to Pasted Items

Y

Paste to Current Mouse Po...

EyeLink Data Viewer

Output Reports

Use UTF8 Encoding: By default
(unchecked), the saved report
output file and interest area file will
be a plain text file in ANSI
encoding. If checked, the saved tab-
delimited text file will be in UTF-8
encoding and the .XLS file will be
in Unicode Text to better support
non-ASCII characters in the output
reports.

Variable Delimiter (\t for Tab):
Specifies the delimiter string for

separating columns in the output
file.

Missing Value: Replaces variables with
missing values with a string
specified here.

Decimal Places: Specifies the number
of digits to appear after the decimal
point. Data Viewer uses the default
decimal symbol set in the operating
system. On Mac, to change the
decimal symbol to a point, you
need to change the "Preferred
language" to one that uses decimal
point, rather than decimal coma. On
windows, you need to change the
"Formats" property in Region and
Language settings to a language
that uses decimal point (e.g.,
English).
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Include Hidden Events in Relative Variables: Allows the inclusion of hidden
events in the relative event variables [i.e., those variables beginning with
PREVIOUS FIX ,NEXT FIX , PREVIOUS SAC , NEXT SAC ,
LEFT/RIGHT FIX INDEX, and LEFT/RIGHT SACCADE INDEX].

Treat Hidden Events as Missing Values: If hidden events in the relative
variables are included in the analysis, users can further decide whether or not to
treat these events as missing data.

Bracket Strings with Quotes: Adds a pair of quotation marks for string variables.

Exclude Trials with Message String: Excludes trials containing the specified
message string. This string should be one message or part of a message within
the scope of a trial that uniquely defines that subset of trials to be excluded.

Use Nearest Interest Area for Outlier Fixations: If the current fixation is not in
any defined interest areas, assigns the nearest interest area (the one with lowest
interest area ID if multiple interest areas are found) as the current interest area
for the fixation. Please note that this option is applicable to static interest areas
only.

Use Nearest Interest Area for Outlier Samples in Sample Report: When
creating a sample report, if the current sample is not in any defined interest
areas, use the nearest interest area (the one with lowest interest area ID if
multiple interest areas are found) as the current interest area for the sample.

Auto Select Interest Area Set for Trial: If true, trial interest arca set association is
done automatically by using the "Image Name mapping" attribute of interest
area set templates in the Data Viewer session. The default is false.

Create One Report File Per EDF File: If checked, this will create one report file
for each of the EDF files loaded into the viewing session.

Cyclopean Mode: If one eye has valid data whereas the other eye has a missing
value or is not recorded at all, the "AVERAGE_*" data in the Sample Report
and Time-Course (Binning) Analysis Report will be based on the good eye if
the “Cyclopean Mode” option is turned on. If this is not enabled, then a missing
value is reported if no valid data are available from either eye. The option has
no effect when both eyes have valid or missing data.

IAs Handling
Perform Sample Based Calculation: If selected, samples within fixations (if
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loaded) are used for interest area matching and report calculation. If disabled
(default option), the average x, y position of the fixation is used. This option
makes a difference for those data sets where fixations have a large spatial
spread (e.g., smooth pursuit).

Include Fixation in Single IA: This is applicable when a fixation lands in multiple
overlapping interest areas. When this option is enabled, the fixation is assigned
only to the winner interest area (for static interest areas, the winner IA is the
one with the lower ID; for dynamic interest areas, the winner is decided based
on the setting "Assign Fixations to Dynamic IA Ordered by Relative
Duration"). The assigned interest area gets the full length of the fixation when
calculating dwell times. If this option is disabled (default setting), the fixation
can be assigned to multiple overlapping interest areas, and the effective
duration (the total amount of time that fixation and instances of the same 1A
intersect) for each of the interest areas is used for the calculation of dwell
times.

Assign Fixations to Dynamic IA Ordered by Relative Duration: Some variables
(e.g., “CURRENT FIX INTEREST AREA INDEX” in the Fixation Report)
require a fixation to be assigned to a single interest area. If a fixation lands in
multiple dynamic interest areas, the assignment by default will be based on the
duration of fixation in the interest areas - the interest area in which the fixation
stayed the longest gets the fixation assignment. Unchecking this option will do
the fixation assignment by interest area index (so the fixation will be assigned
to the IA with the lowest index).

Allow Interpolation: If selected, any dynamic interest area that has its interpolation
property enabled will interpolate spatially across its duration to the next
instance’s position and shape (if it’s of the same shape type).

Interpolation Interval in ms: Sets how often dynamic interest areas are
interpolated.

Identify First/Last Saccade Based on First/Last Fixation: The end point of a
saccade doesn't necessarily have the same coordinate as the following fixation
event (because the eye is not absolutely still during a fixation; small eye
movements such as drifts, tremors, microsaccades can occur during a fixation).
As aresult, a saccade and the following fixation may end in different interest
areas. If the "Identify First/Last Saccade Based on First/Last Fixation" option is
checked, Data Viewer first identifies the first and last fixation event in a trial
and then finds the preceding saccade of the fixation event and uses this as the
first/last saccade of the trial, despite the fact that occasionally the end x, y
location of the identified saccade may not actually land in the current interest
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areas. If this option is unchecked, the saccades are identified based on the
actual end point and there might be a disconnect between the first/last saccade
and the first/last fixation in an interest area.

Apply Offset to Pasted Items: If checked, then pasted interest areas or interest
area instances will be offset slightly down and to the right from the location of
the original interest area or interest area instance that has been cut/copied to the
clipboard. This option will be ignored if the “Paste to Current Mouse Position”
option is enabled.

Paste to Current Mouse Position: If this option is enabled, the location of the
interest areas for the paste, paste current, paste after operation will be at the
current mouse position. If the option is not checked, the location is based on the
original interest area location (with an offset if the "Apply Offset to Pasted
Items" option is enabled).

Fixation/Saccade Report

Maximum Message Variables for Eye Event: Maximum number of messages
associated with a given fixation or saccade that will be shown in the output
report.

Eye Event Msg. Variable String Match Token: If left blank, all messages
associated with an eye event will be reported; otherwise, only those messages

containing the "token" will be reported. Use a *“;” to separate multiple message
strings.

Fixation Stream Analysis

Fixation Skip Count: Defines the number of fixations to skip when looking for the
next interest area to use in the fixation sequence analysis variables of the
Interest Area report. Default is 1. Cannot be less than 1.
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8.4 Fixation Map

~e Inspector ( Mem J=|
&P Data ﬂf Preferenoesl

) Preferences
# General
4 Data Loading
=~ ) Output / Analysis
e
i 4 Data Filters
, Data Views

Field Value
'Static Heat Map -
Type Duration
Sigma (in degrees) 1.0
Low Activity % Cut-off (0.... |10.0
Fixed Minimum Value 0.0
Clip Map Below Fixed Minim...| [
Fixed Maximum Value -1.0
Draw Title v

ITitle Center X Position % (... |50

Title Center Y Position % (... |1
Text Color —
IText Font Size 12
|Heat Map Mode
Enable Heat Map Mode v
Transparency (0.0 - 100.0) |50.0
High Positive Activity Color
Medium Positive Activity C...
Low Activity Color
Medium Negative Activity ...
High Negative Activity Color
Draw Legend v
Legend Center X Position ... 95
Legend Center Y Position ... |50 L'

Static Heat Map

Type: The fixation map is created based on
the duration of fixations, count of the
fixation, probability of fixation across
the display, or proportion of trial dwell
time.

Sigma (in degrees): Sets the standard
deviation of the Gaussian distribution
for each fixation point when creating
a fixation map.

Low Activity % Cut-off (0.0 - 100.0):
Sets the minimum amount of
activation required to have an area
painted with an activation color - this
is a certain percent of the actual
maximum per-trial-average value for
the map to keep the contour of the
fixation map in case the actual
maximum per-trial-average value is
different from the "Fixed Maximum
Value". If set to 0, the whole map is
painted (with most of the areas in
low-activity color).

Fixed Minimum Value: By default, the
scale of the legend starts from 0. A
non-zero value set here will be used
as the minimum value of the scale.
Any areas with an activation value
below this "fixed minimum value"
but above the "Low Activity % Cut-
off (0.0- 100.0)" threshold, will be
painted with the low activity color.

Clip Map Below Fixed Minimum: If this enabled, this will not color an area with an
activation value below the "Fixed Minimum Value" set above.

Fixed Maximum Value: If set to the default value of -1, the maximum value in the
legend is based on the actual heat map maximum value. Any value > 0 will be used
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as the maximum legend scale. Any areas with an activation value above this "fixed
maximum value" will be painted with the high activity color.

Draw Title: If checked, a title is displayed on the fixation map.

Title Center X Position % (0-100): The X position for the center of the title in percent of
the display width.

Title Center Y Position % (0-100): The Y position for the center of the title in percent of
the display height.

Text Color: Sets the color for the text of the heat map title and legend.
Text Font Size: Sets the font size for the text of the heat map title and legend.

Heat Map Mode
Enable Heat Map Mode: If checked, the fixation map will be drawn in a colored heat
map; if unchecked, a grayscale version will be created.

Draw Legend: If checked, a color scale is displayed on the fixation map.

Legend Center X Position % (0-100): The X position for the center of the legend in
percent of the display width.

Legend Center Y Position % (0-100): The Y position for the center of the legend in
percent of the display height.

Apply Aggregate Heatmap to Group: If enabled (default), the fixation map will be
created and applied to all trials within the current trial group. If not checked, the
fixation map will be created only for the trial that you clicked the "Create and Use
Fixation Map" button for.

Export Heat Map Matrix: If enabled, the raw heat map data will be exported as a text file
to the default output directory. The matrix has the same resolution as the viewing
session in Data Viewer (you can find this in the Display Width and Display Height
properties of the session node in the Inspector panel). So if the viewing session
resolution is 1024 x 768, there will be 1024 columns and 768 rows of data. Each
number corresponds to the computed activation value at one pixel in the heat map.

High Positive Activity Color: This sets the color used to paint high activity area (more

fixations) on a heat map. This is also the color used to draw the high positive activity
area on a difference heat map.
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Medium Positive Activity Color: This sets the color used to paint medium activity area
on a heat map. This is also the color used to draw the medium positive activity area
on a difference heat map.

Low Activity Color: This sets the color used to paint low activity (least fixated) area on a
heat map.

Medium Negative Activity Color: This is the color used to paint the medium negative
activity area on a difference heat map.

High Negative Activity Color: This is the color used to draw the high negative activity
area on a difference heat map.

Transparency (0.0 - 100.0): Sets the transparency level of the heat map. If 100, the heat
map will be solid and the underlying image will not be visible.

Dynamic Aggregate Heat Map

Adjust According to Contributing Trials: If the option is enabled, the calculation of the
dynamic heatmap will be adjusted by the number of trials that contribute data to the
current time window (i.e., the fixation duration will be calculated based on the actual
surviving trials in the current time window instead of the total number of trial when
the playback starts).

Show Gaze Cursor when in Heat Map Mode: If enabled, individual gaze cursors will
be drawn on top of the dynamic heat map.

Heat Map Window Duration: The amount of data (in milliseconds centering on the
current playback position) in each trial to be included in the dynamic heat map
calculation.

Fixed Maximum Value: This sets the fixation duration of high activity area on a dynamic

heat map. Any areas with a duration value above this "Fixed Maximum Value" will
be painted in red.
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8.5 Data Filters Preferences

The Data Filters preference settings consist of the following elements:

@ Data ™ Preferencesl

Preferences
# General
# Data Loading
Qutput / Analysis
.
= Data Views
Overlay
i 4 Temporal Graph
= 4 Animation

Field Value
Merge Nearby Fixations
Fixation Merging Amplitud...
Fixation Duration Threshold
Apply Time Weighted Merge
Skip Meraing of Fixations ...

<< 72

Saccade Amplitude Thresh...0.0

|Blink Correction for Pu...
Duration to Exclude Befor...
Duration to Exclude After ...
Apply Blink Correctionin t...

Display Blink Saccades
Remove Fixation Immedia...
Remove Fixation Immedia...

e

Hide Fixations Beyond Dis... _I
S

Merge Nearby Fixations: If checked,

neighboring brief fixations are merged. In
order to be merged, a fixation must have a
duration less than that specified by the
Fixation Duration Threshold and be within
1° of the target fixation. These default
thresholds are set in the “Fixation
Duration Threshold” and “Amplitude
Threshold” fields. If Merge Nearby
Fixations is not checked, but a Fixation
Duration Threshold is set, the below-
threshold fixations will be hidden rather
than merged. Note: Fixation merging
cannot be undone — please make a
backup copy of the viewing session or
test out in a different viewing session
before applying this option.

Fixation Merging Amplitude Threshold: Sets

the amplitude threshold for fixation
merging. The default value is 1.0°.

Fixation Duration Threshold: Sets the duration threshold for fixation merging or hiding.
A fixation will be merged if “Merge Nearby Fixations” is on and its duration is less
than the specified duration threshold and within “Fixation Merging Amplitude
Threshold” of another fixation. If the "Merge Nearby Fixations" option is unchecked,
the under-threshold fixations will be hidden rather than merged. Likewise if "Merge
Nearby fixations" is enabled, fixations that are under the fixation-merging threshold
but above the "Fixation Merging Amplitude Threshold" will be hidden.

Apply Time Weighted Merge: When two Fixations are merged the duration of each
fixation is taken into consideration (time-weighted) for the calculation of the average
spatial location of the newly created Fixation.

Skip Merging of Fixations Separated by Blink: If checked, neighboring brief fixations
that are separated by a blink event are not merged. Note: When not checked, the
fixations will be merged and the blink event will be removed. This cannot be
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undone — please make a backup copy of the viewing session or test out in a
different viewing session before applying this option.

Saccade Amplitude Threshold: Sets the minimum size of a saccade to be displayed in
the viewing session. All saccades will be displayed with an amplitude threshold set to
0.0.

Blink Correction for Pupil Size Calculation

Duration to Exclude Before Blink Saccades (msec):
Milliseconds of samples to exclude before the start of the blink saccades for pupil size
calculation. This is applicable to variables in the Trial Report related to the pupil size
calculation (PUPIL_SIZE *); it does not affect the AVERAGE /LEFT /
RIGHT PUPIL_SIZE output in the Sample Report. If the "Apply Blink Correction in
the Sample Report" option is checked, this will also affect the AVERAGE /LEFT /
RIGHT IN_BLINK output in the Sample Report (but not the AVERAGE /LEFT /
RIGHT PUPIL_SIZE variable output).

Duration to Exclude After Blink Saccades (msec): Milliseconds of samples to exclude
after the end of the blink saccades for pupil size calculation. This is applicable to
variables in the Trial Report related to the pupil size calculation (PUPIL_SIZE *); it
does not affect the AVERAGE /LEFT /RIGHT PUPIL_ SIZE output in the Sample
Report. If the "Apply Blink Correction in the Sample Report" option is checked, this
will also affect the AVERAGE /LEFT /RIGHT IN BLINK output in the Sample
Report (but not the AVERAGE /LEFT /RIGHT PUPIL SIZE variable output).

Apply Blink Correction in the Sample Report: If unchecked, the AVERAGE /LEFT /
RIGHT IN_BLINK output in the Sample Report will be based on whether the
samples are collected during a blink event (1 if true, 0 if false). If this option is
checked, the reporting of the AVERAGE /LEFT /RIGHT IN BLINK output will
be affected by the above-mentioned blink correction mechanism. That is, samples in a
blink saccade as well as those falling within the exclusion period before/after the blink
saccade will be treated as blink samples.

Display Blink Saccades: Shows flanking saccades of a blink.

Remove Fixation Immediately Before Blink, Remove Fixation Immediately After
Blink: If enabled, this will remove a fixation if it occurs immediately before/after a
blink event. Please note that this option has no effect if the current viewing session
was created using a version of Data Viewer before 2.2 (because fixation/blink
sequences need to be marked during the data loading process for this feature to work).

Hide Fixations Beyond Display Bounds: Whether or not to hide the fixations falling
beyond the display boundaries;
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Show Interest Areas Pre Interest Period: If interest periods are defined, whether or not
to display interest areas timed before the start of a selected interest period. If no
interest periods are defined, the interest areas are displayed anyway.

Show Interest Areas Post Interest Period: If interest periods are defined, whether or not
to display interest areas timed after the end of a selected interest period. If no interest
periods are defined, the interest areas are displayed anyway.

Hide Eye Events Only: If checked, filters out eye events (fixations, saccades, and
blinks) falling outside of the RT definition. If unchecked, filters out all events,
including button events and messages.

Hide Spanned Events at Start of IP: Hide eye events (fixations, saccades, and blinks)
that start before the beginning of the currently-selected interest period and end after
the beginning of the currently-selected interest period. This will hide them from the
various views of Data Viewer and will exclude them completely from Reports and
Fixation Maps. If the “Trim Spanned Fixation Duration” option is enabled, only
spanned saccades and blinks will be hidden; spanned fixation durations will be
trimmed.

Hide Spanned Events at End of IP: Hide eye events (fixations, saccades, and blinks) that
start before the end of the currently-selected interest period and end after the end of
the currently-selected interest period. This will hide them from the various views of
Data Viewer and will exclude them completely from Reports and Fixation Maps. If
the “Trim Spanned Fixation Duration” option is enabled, only spanned saccades and
blinks will be hidden; spanned fixation durations will be trimmed.

Trim Spanned Fixation Duration at Start of IP: Trim the duration of fixations that start
before the beginning of the currently-selected interest period and end after the
beginning of the currently-selected interest period. Trimming them will effectively
exclude the portion of the spanned fixation that falls outside the interest period. This
will influence the spanned fixations' durations in the various views of Data Viewer
and in the output that goes into Reports and Fixation Maps. This preference setting
takes precedence over the “Hide Spanned Events at Start of IP” preference.

Trim Spanned Fixation Duration at End of IP: Trim the duration of fixations that start
before the end of the currently-selected interest period and end after the end of the
currently-selected interest period. Trimming them will effectively exclude the
portion of the spanned fixation that falls outside the interest period. This will
influence the spanned fixations' durations in the various views of Data Viewer and in
the output that goes into Reports and Fixation Maps. This preference setting takes
precedence over the “Hide Spanned Events at End of IP” preference.
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Include Display Command Messages: Whether display command messages (i.e.,
command message starts with “!'V” listed in sections 7.3.3 image loading and 7.3.4
simple graphics) should be visible.

Include Audio Command Messages: Whether audio command messages should be
visible. The following built in audio messages are supported: "'V ARECSTART",
"IV ARECSTOP", "IV VOICEKEY", "'V APLAYSTART", and "V
APLAYSTOP".
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8.6 Data Views Preferences

The parameters related to the general Trial View Window preference settings are covered
below:

o\ Inspector ( Mem = Fixation Color, Saccade Color, Blink
© Data f Preferences | Color, IA color, Button Color,
: P.’ef;’;";;s Message Color, Input Color, Reaction
# Data Loading Time Start Color, Reaction Time End
, Output / Analysis . i
e Color, and Selection Square Color: Set
B the colors to be used to show fixations,
, Overlay . .
L9 Temodaat saccades, blinks, interest areas, button
~ # Animation events, input events, messages, the
start/end of reaction time calculation,
and the event selection square. These
= Value settings can be changed by clicking the
Fixation Color - . .
Sateade Clor corresponding cell and choosing a color
ks Sk from the palette dialog or entering the
r
Button Color value in RGB or HSB scales.
Message Color
Input Color
Trial Node Color Trial Node Color: Sets the default color used
Selection Square Color panel of the Inspector Window.
— Changing this property will only affect

Unselected Stroke Width
Selected Stroke Width

recording sessions loaded after the
change. For the existing recording
sessions, the color of the trial nodes can
SO ] Ad be changed through the “Color” property
of the trials/trial groups.

Adjust Saccades with Fixa...
Adjust Fixations with Sacc...

Reaction Time Start Color | | . . . .
———— to paint the trial nodes in the tree view
1
Vv
~

Unselected Stroke Width and Selected
Stroke Width: Pixel width for the
unselected and selected events.

Adjust Saccades with Fixations: Whether or not to adjust saccade parameters when the
fixations are shifted or merged.

Adjust Fixations with Saccades: Whether or not to adjust fixation parameters when the
saccades are shifted or merged.

Batch Drift Correction Error Threshold: The maximum tolerable deviation in the Y
dimension (or the X dimension if the next field is unchecked) for a fixation from the
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mean of the group of fixations to be drift-corrected in a batch. If any fixation within
the group exceeds this threshold, batch drift correction cannot be performed.

Batch Drift Correction Y (X->false): If checked, chooses the Y dimension for batch drift
correction. If unchecked, the X dimension is used.

Auto Select Fixation in Selected IA: When an interest area is selected, whether or not
to select fixations inside the IA as well.

Initial Data View: Selects the mode (Temporal Graph View; Spatial Overlay View;
Animation Playback View) of the Trial View Window when the data is first loaded.

Display RT Graphics: If reaction time definitions are initialized, whether or not to show
the “RT” symbol in the spatial overlay view and to draw the Reaction Time

Start/End lines in the Temporal Graph View of the trial data.

Use Graphics Commands Sent Prior to IP: If no graphics commands are found within
the current interest period, uses those sent prior to the current interest period.
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8.7 Spatial Overlay View Preferences

The Spatial Overlay View preference settings cover the following parameters:

o Inspector ( Me
@ Data W Preferences |

&

Preferences
# General
# Data Loading
Qutput / Analysis
# Data Filters
S Data Views
FO
- 4 Temporal Graph
= 4 Animation

Field Value
Sample Trace Color

Display Fixation Index

Display Fixation Duration

Display Saccade Index

Display Fixations as Scan P...

I VKX

Join Concurrent Selected F...

Display Text Font Size 14

Sample Trace Granularity 5

Sample Tick Width 4

Connect Sample Dots with ... | [V

Minimum IA Size 5

Use SQRT of Fix. Dur. for ... | [V

Fixation Circle Scalar

20.0

Maximum Fixation Circle Wi...

100

Minimum Fixation Circle Wi...

20

Overlay Background Color

Maximum Graphics Comma... |-

Sample Trace Color: Sets the color to be
used to show the sample trace.

Display Fixation Index, Display Fixation
Duration, and Display Saccade
Index: Whether or not to show the
fixation index/fixation
duration/saccade index in the Spatial
Overlay View.

Display Fixations as Scan Path: If
checked, two temporally contiguous
fixations are connected by an arrow,
pointing towards the more recent
fixation.

Join Concurrent Selected Fixations: For
the selected fixations, connects
temporally contiguous fixations.

Display Text Font Size: Size of the font
used in the Overlay view (e.g., size of
the font for fixation durations/indices).

Sample Trace Granularity: If the sample
visibility is toggled on, shows every
nth sample (by default, n = 5).

Sample Tick Width: Diameter (in pixels)
of the sample ticks.

Connect Sample Dots with Lines: If enabled (default), neighboring sample dots are
connected with a line when drawn in the Spatial Overlay View.

Minimum IA Size: Minimum width or height of an interest area. Please note this is only
applicable to the interest areas manually drawn by mouse.
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Use SQRT of Fixation Duration for Circle Size: Uses the square root of fixation
duration to calculate the width of the fixation circle if checked.

Fixation Circle Scalar, Maximum Fixation Circle Width, and Minimum Fixation
Circle Width: If the above Use SQRT of Fixation Duration for Circle Size option
1s not used, use Fixation Circle Scalar to define a scalar for fixation circle width
calculation. The maximum and minimum circle widths are set with the Maximum
Fixation Circle Width/Minimum Fixation Circle Width elements;

Background Color: Background color for the Spatial Overlay View (used only if the
trial image is not loaded).

Maximum Graphics Commands to Process: Sets the maximum number of
graphics commands to process in each trial. This command is useful for those trials
in which there are many viewer graphics commands while users may just need to see
a few of them. If it is set to -1, the viewer will process all graphics commands. For
all other entries of integer numbers, the viewer will process the number of graphics
commands specified when creating the background image for overlay view.

Fit Overlay Image Change to Display: If True, when the background image for a

trial is manually changed, the image is scaled to fit the display dimensions for the trial. If
false, the image size is not altered and the image is centered on the trial overlay view.
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8.8 Image Segmentation Preferences

The parameters related to the auto image segmentation preference settings are covered

below:

@ Data W Preferences I

Preferences
# General
# Data Loading
Output / Analysis
# Data Filters
S Data Views
=} Overlay
L _BImage Segmentation
- 4 Temporal Graph

- # Animation
Field Value

Segmentation Spacing Thres... [7

Left IA Buffer Size 10

Right IA Buffer Size 10

Top IA Buffer Size 10

Bottom IA Buffer Size 10

Fill Gaps Between IA v

Background Threshold (0-765) [350

Backaround Threshold Less ... |[v

Segmentation Direction Left to Right
EyeLink Data Viewer

Segmentation Spacing Threshold: Number of
consecutive pixels below threshold before
segment end is identified.

Left IA Buffer Size, Right IA Buffer Size, Top IA
Buffer Size, Bottom IA Buffer Size: Number
of pixels added to the left, right, top, and
bottom of the interest area. Note that the Top
IA Buffer Size and Bottom IA Buffer Size
fields will not have an effect if Fill Gaps
Between IA is checked.

Fill Gaps Between IA: If checked, gaps between
consecutive Interest Areas will be filled by
expanding the size of each Interest Area.

Background Threshold (0-765): Combined RGB
(R+G+B) to be used as the threshold limit for
segmentation.

Background Threshold Less Than: If checked,
pixels with an RGB value less than the
threshold color are considered ‘background’
pixels. This setting is good for displays with a
lighter background. If this field is unchecked,
pixels with an RGB value greater than the
threshold are considered background pixels
(good for displays with a darker background).
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Segmentation Direction: If "Left to Right" is selected then the interest areas will be created
such that the interest areas furthest to the left will have the lowest index/id and the index/id
values will increase in a left-to-right manner. If "Right to Left" is selected then the interest
areas will be created such that the interest areas furthest to the right will have the lowest
index/id and the index/id values will increase in a right-to-left manner.

Note: Auto segmentation may not work for a display with vertical stripes along its border(s)
that have the ‘foreground’ color. If such stripes are not part of the original image, try to
reload the background image or to change the background color for the Spatial Overlay
View to match with the background color of the original image.
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8.9 Temporal Graph Preferences

The parameters related to the Temporal Graph View preference settings are covered

below:

~e Inspector ( Memc
<L Data Qf Preferenoesl

2|

, Preferences
# General
4 Data Loading
[ |, Output / Analysis
# Data Filters
=~} Data Views
, Overlay
(% ' cmporal Graph
= 4 Animation

| Field

Value

|Right Eye

X Sample Trace Color

Y Sample Trace Color

X Velocity Trace Color

Y Velocity Trace Color

X Acceleration Trace Color

Y Acceleration Trace Color
Pupil Sample Trace Color

|Left Eye

X Sample Trace Color

Y Sample Trace Color

X Velocity Trace Color

Y Velocity Trace Color

X Acceleration Trace Color

Y Acceleration Trace Color
Pupil Sample Trace Color

Targetl

Key

X Position Trace Color
Y Position Trace Color
X Velocity Trace Color
Y Velocity Trace Color

LN

EyeLink Data Viewer

Left Eye/Right Eye

X Sample Trace Color, Y Sample Trace
Color, X Velocity Trace Color, Y
Velocity Trace Color, X Acceleration
Trace Color, Y Acceleration Trace
Color, and Pupil Sample Trace Color:
Set the colors to be used to show the
horizontal and vertical position, velocity,
and acceleration traces of the eye
samples. The pupil sample traces of both
eyes are also displayed. The default
settings can be changed by clicking the
corresponding cell and choosing a color
from the palette or entering the value in
RGB or HSB scales.

Target 1/Target 2 Key: Token word to
indicate the target ID. This field is set to
blank by default so that various token
words can be used. If two targets are
involved and if the order of the two
targets is important, set this field to the
token string used in the EDF file.

X Position Trace Color, Y Position Trace
Color, X Velocity Trace Color, Y
Velocity Trace Color, X Acceleration
Trace Color, and Y Acceleration
Trace Color: Sct the colors to be used to
show the horizontal and vertical
position, velocity, and acceleration
traces of the targets. The default settings
can be changed by clicking the
corresponding cell and choosing a color
from the palette or entering the value in
RGB or HSB scales;
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Acceleration Trace Scaling Factor and Velocity Trace Scaling Factor: Set the
scaling factor for the acceleration and velocity data so that these two traces can be
displayed appropriately in this view.

Pupil Trace Scaling Factor: Sets the scaling factor for the pupil size data so that the
trace can be displayed appropriately in this view. Default scaling factor is 0.1.

Message Triangle Width, Message Triangle Height, Button Triangle Width, Button
Triangle Height, Input Triangle Width, and Input Triangle Height: Set the width

and height of the symbols for message, button, and input events.

Background Color and Ruler color: Set the colors for the background and ruler of the
Temporal Graph View.

Split Y Axis: If true, 0 appear in the middle of the screen, positive values on the top and
negative values at the bottom; otherwise, a descending scale is used, with large
values on the Y-axis appearing at the bottom of the screen. Note, this setting will
only be effective when the data are loaded in a new viewing session.

Display Sample Indicator: Whether or not to show the sample cursor line (and a
pointer/circle at the intersection of the sample cursor line and data traces) in the

Temporal Graph View.

Display Graph Grid Lines: Whether or not to show the graph grid lines in the Temporal
Graph View.

Sample Indicator Color: Sets the color to be used to show the sample cursor line.
Graph Grid Lines Color: Sets the color to be used to show the graph's grid lines.

Interest Period Boundaries Color: Sets the color to be used to show the currently-
selected interest period boundaries.

X Trace Highlighted, Y Trace Highlighted, and Pupil Trace Highlighted: Whether or
not by default the X trace, Y trace, and pupil trace are highlighted.

Initial Visible Sample Count: Total number of initially visible samples in the Temporal
Graph View window (the default is 5000).

Exclude Samples Traces Outside Interest Period: Whether or not to show the traces
of the samples that fall outside the Interest Period in the Temporal Graph View.

Sample Traces Out Of IP Color: Sets the color to be used to show the samples that fall

EyeLink Data Viewer ©2002-2017 SR Research Ltd. 236



outside the Interest Period.
Use X Position for Fixation Location: If checked, use the X position to indicate the

position of a fixation event in the Temporal Graph View; otherwise, use the Y
position.
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8.10 Animation Preferences

The parameters related to the Animation Playback View preference settings are covered

below:

~e\Inspector ( Me
<4 Data ﬁ Preferences I

y-i| Enable Gaze Cursor: By default, the gaze
cursor is drawn on top of the background

, Preferences
# General
# Data Loading
) Output / Analysis
# Data Filters
=+ JJ Data Views
, Overlay
. @ Temporal Graph
e B Animation

image/video during trial playback. If the
option is turned off, the gaze cursor will be
removed from the animation panel. This can
be useful in case users want to look at or
record trial playback without the gaze
cursor being visible on the screen.

Use Average Aggregate Cursor: When

Field Value

Enable Gaze Cursor

Aggregate View is turned on, whether or

Use Average Aggregate C...

a7

Enable History

()
o
o

History Duration

-

Enable Cyclopean Cursor
Right Gaze Cursor Color
Left Gaze Cursor Color
Cydopean Gaze Cursor C...

not to display only the averaged gaze cursor
across all trials.

Enable History: If checked, this displays a
history of prior eye samples in the

Gaze Cursor Diameter 20

animation view.

Gaze Cursor Transparenc... |25

Scale Cursor Size Based o... ||

Gaze Cursor Scaling Factor 0.01

History Duration: Duration of the eye position

Scaled Gaze Cursor Minim... (10

history prior to the current frame (300 ms

Scaled Gaze Cursor Maxim... (50

by default).

Video Handler Default Video Handler

/Animation Background Color
[Trial Tima Calar

Enable Cyclopean Cursor: For a binocular

recording, enabling this option will display
a cyclopean gaze cursor (instead of two
separate gaze cursors) in the animation
view.

Right Gaze Cursor Color, Left Gaze Cursor Color, Cyclopean Gaze Cursor: Set the
colors to be used to show the right, left, and cyclopean gaze cursor. The default
settings can be changed by clicking the corresponding cell and choosing a color from
the palette or entering the value in RGB or HSB scales. Please note that these color
settings are used in the animation view for both the current gaze position and the
history trace (if the “Enable History” option is checked). In the Aggregate Mode, if
the default trial/trial group colors are modified, then these color settings are ignored.
The customized colors specified in the property table of the trial/trial group will be
applied to left, right, and cyclopean cursors.
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Gaze Cursor Diameter: Sets the diameter of the gaze cursor (in pixels); this option is
ignored if the “Make Gaze Cursor Size Dependent on Pupil Size” option is enabled.

Gaze Cursor Transparency (0 - 100): Sets the transparency of the gaze cursor.

Scale Cursor Size Based on Pupil Size: If enabled, the diameter of the gaze cursor in
the animation view is scaled based on pupil size of the current sample. If no samples
are loaded in the trial, the average pupil size for the fixation will be used during
playback within a fixation, and the average of the previous and next fixation pupil
size will be used during playback within a saccade.

Gaze Cursor Scaling Factor: Sets the scaling factor so that the pupil size can be
properly indicated by the size of the gaze cursor. Scaling factor directly multiplies
the pupil size; the resulted cursor size is constrained by the Scaled Gaze Cursor
Minimum and Maximum Diameter.

Scaled Gaze Cursor Minimum Diameter: This sets the smallest possible gaze cursor
size (diameter in pixels) when the size of the gaze cursor is scaled based on the pupil
size data.

Scaled Gaze Cursor Maximum Diameter: This sets the largest possible gaze cursor size
(diameter in pixels) when the size of the gaze cursor is scaled based on the pupil size
data.

Video Handler: The codec used to play the video clips. In general, users are
recommended to use the default option as the software will automatically choose the
optimal video loader for you based on the file extension. This option is applicable to

the Windows version only.

Animation Background Color: Background color for the Animation View (used only
when the trial image is not loaded).

Trial Time Color: Sets the color of the trial time code.

Trial Time X Position (%), Trial Time Y Position (%): Sets the x (percent of screen
width) and y (percent of screen height) coordinates of the trial time code.

Trial Time Font Size: Sets the font size of the trial time code.

Display Frame Number: If checked, displays the frame number of the video being
played.
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Display Trial Time: If checked, displays the current playback time relative to the start of
the trial.

Display IP Time: If checked, displays the current playback time relative to the start of
the currently selected interest period.
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9 Release History

Version 3.1.97
* Provided various bug fixes and documentation updates for the 3.1.1 release
* Added options to skip some stages when performing four-stage fixation cleaning
* Added the following variables to the Trial Report:
SD SACCADE_AMPLITUDE, and SD_FIXATION DURATION

Version 3.1.1
* Added “Add/Edit Event Mode” to the Temporal Graph View
* Added grid lines to the Temporal Graph View
* Added a sample cursor line to the current mouse position in the Temporal Graph
View
* Added “Sample Info” button and floating window to the Temporal Graph View
* Added interest period boundaries to the Temporal Graph View
* Supported displaying dynamic interest areas in the Temporal Graph View
* Added “IA Shape Actions” option to support the following operations when
interest areas are selected:
o Conversion between different interest area shapes
o Horizontal or vertical flip
o Rotating interest areas
o Resizing/rescaling interest areas
o Moving interest areas
* Added interest area “Link” option to replace multiple interest areas with a linked
object; added “Unlink” option to restore the original interest areas
* Added “Create Output Report for all Custom Interest Periods” option to the
Reports
* Added option to create multiple consecutive duration-based interest periods
* Added “Use Average Aggregate Cursor” option to Animation View Preferences
* Allowed to import messages relative to the currently-selected interest period
* Added “Gaze Cursor Transparency (0.0 — 100.0)” to Animation View Preferences
* Added “Video Handler” option to Animation Preferences (Windows version only)
* Added support for playing back .mov video files in the Animation View (for the
data collected with SR Research Experiment Builder)
* Added the following variables to the Trial Report:
MEDIAN SACCADE AMPLITUDE, and MEDIAN FIXATION DURATION
* Added the following variables to the Saccade and Fixation Report:
o CURRENT/PREVIOUS/NEXT SAC BLINK START
o CURRENT/PREVIOUS/NEXT SAC BLINK END
o CURRENT/PREVIOUS/NEXT SAC BLINK DURATION

Version 2.6.1
* Provided a new interface for creating and editing interest periods
* Provided options to create a shorter sample report (i.e., down-sampling)
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Added “File -> Unpack” menu option

Added “Selected Freehand Point” property to freehand interest areas for the
precise adjustment of vertex coordinate

Added "Remember Last Browsed Directory" for some default directories

Added HTARGET DISTANCE BIN, HTARGET X BIN, HTARGET Y BIN,
SAMPLING RATE, and SAMPLE INTERVAL variables to the Time-Course
Analysis Report

Added “Start Event Offset” option to the Reaction Time Definitions

Added “Animation Background Color” to the Animation View preferences
Added “Apply Blink Correction in the Sample Report” option to the Data Filters
preferences

Version 2.5.0

Added Time-Course (binning) Analysis Report

Supported .mov file output on Mac OS X

Added property to fixation event to indicate if the event is trimmed by interest
period filter.

Version 2.4.1

Data Viewer now runs on Windows (XP, Vista, 7, 8, and 10), Mac OS X (Intel
Mac 10.6 or later), Linux (Ubuntu 14.04LTS)

Supported dynamic heat map presentation in the Animation View

Supported creating a difference heat map

Added option to export the fixation map matrix as a text file.

Allowed playback of supported video clips on Mac OS X

Added a history of eye positions in the Animation View

Added Backward Frame and Forward Frame buttons in the Animation View
Supported zooming in or out of the Spatial Overlay View

Supported toggling on/off the background image in the Spatial Overlay View
Added keyboard shortcut help menu to the Trial View Window

Supported scaling gaze cursor size in the Animation View based on pupil size
Added “Pupil Trace Scaling Factor” to the Temporal Graph View preferences
Bug fix for the "Include Hidden Events" option being toggled on randomly. The
hidden events now are drawn in dashed-lines.

Added new variable to Trial Report:
INTEREST AREA FIXATION SEQUENCE

Added new variable to Interest Area Report: [A. LEGAL IMMEDIATE
Added “Apply Strict Event Matching” option to the Interest Period Editor
Added new variables to Trial, Fixation, Saccade, Message, Sample, and Interest
Area Reports: [P END EVENT MATCHED, IP. START EVENT MATCHED

Version 2.3.1

Supported Aggregate Mode
o Displays the aggregate data in the Spatial Overlay and Animation View of
the Trial View Window
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o Displays aggregated statistics for the events and interest areas in the trial
group in the property table
o Provided Aggregate Event Statistics and Aggregated Interest Area Report
* Added support for color coding the visible data in a trial/group of trials
* Supported selecting variables in the output reports though drag-and-drop
* Provided option to display the fixation map in the Spatial Overlay View
* Supported merging viewing sessions
* Supported adjusting the location of the interest areas using the center position
* Added Step Backward button in the toolbar of the Animation View
* Added XVid lookup table support for faster frame seeking.

Version 2.2.1

* Added support for loading input events from EDF files.

* Supported using the input events as the end event in the interest period and
reaction-time definitions.

* Supported trial splitting based on the messages or input events.

* Added “Use Substring Match for Messages” option to the Interest Period and
Reaction Time Definition Editor.

* Supported packaging and unpacking viewing session files.

* Added support for removing fixations immediately before or after a blink event.

* Added new properties to the trial node: Number Input Events, Mode, Pupil Data
Type, Eyes, Event Parse Type, Mount Type, File Filtering Level, and Pupil
Tracking Algorithm.

* Supported inserting a message / editing message text in the viewing session.

* Added “Create one report file per each EDF file” option in each of the reports.

* Added “Default Video Directory” in the General preference.

* Added new properties to the Data file node: EyeLink Version, and Recorded by.

* Added new variables to the sample reports: SAMPLE INPUT

* Added the following variables to the fixation report and saccade report:

CURRENT /PREVIOUS /NEXT FIX INPUT EVENTS,
CURRENT /PREVIOUS /NEXT SAC INPUT EVENTS

* Added the following variables to the trial report: INPUT COUNT,
RT EVENT INPUT

* Added the following variables to the saccade report:

CURRENT SAC START/END INTEREST AREA X OFFSET

CURRENT SAC START/END INTEREST AREA Y OFFSET

CURRENT SAC START/END_INTEREST AREA DATA

General bug fixes for video playback and saving in Data Viewer animation view.

Version 2.1.1
* General performance improvements and reworked on the playback in the
Animation View and video saving.
* Added Dynamic Interest Area Support
o Modified interest area format
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Added Mouse Record Mode for creating dynamic interest area instances

Added Paste Current and Paste After options

Modified interest area creation dialog box

Supported position and shape interpolation across instances of Dynamic

Interest Area

o Interest Area data reporting can be either based on the fixation events or
samples

* Improved Trial Grouping interface

* Supported adding or removing points for a freechand interest area

* Animation View now displays time relative to start of the trial and/or start of the
current interest period.

* Added “Default Video Directory” setting to the General Preferences; supported
selection of multiple directories for the “Default Image Directory” and “Default
Video Directory”.

* Allowed independent setting for “Hide Spanned Events” and “Trim Spanned
Fixation Duration” at the start and end of interest period.

* Added a "Use Substring Match for Messages" option to the Reaction Time and
Interest Period definitions.

* Added new variables to the Interest Area Report: IA. DYNAMIC,

IA_END TIME, IA INSTANCE COUNT, IA START TIME,
REPORTING METHOD, TRIAL IA COUNT,
TRIAL TOTAL VISITED IA COUNT.

* Added new variables to the Fixation Report and Saccade Report:
CURRENT /NEXT /PREVIOUS FIX INTEREST AREA DATA,
CURRENT /NEXT /PREVIOUS FIX INTEREST AREA PIXEL AREA,
CURRENT /NEXT /PREVIOUS FIX INTEREST AREA ID,
CURRENT /NEXT /PREVIOUS SACCADE START INTEREST AREA ID,
and
CURRENT /NEXT /PREVIOUS SACCADE END INTEREST AREA ID.

* Added new variables to the Message Report:
CURRENT MSG _INTEREST AREA ID.

* Added new variables to the Trial Report:
AVERAGE BLINK DURATION, and IA_ COUNT

* Added new variables to the Sample Report:
LEFT FIX INDEX, RIGHT FIX INDEX,
AVERAGE /LEFT /RIGHT INTEREST AREAS,
AVERAGE /LEFT /RIGHT INTEREST AREA DATA,
AVERAGE /LEFT /RIGHT INTEREST AREA DISTANCE,
AVERAGE /LEFT /RIGHT INTEREST AREA PIXEL AREA,
LEFT SACCADE INDEX, RIGHT SACCADE INDEX

O O O O

Version 1.11.900:
* Added support for EyeLink 1000 Plus recording files.
* Fixed crashes in loading some EDF files on Mac OS X.
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Added blink correction for pupil size calculation for PUPIL_SIZE MIN and
PUPIL_SIZE MEAN variables in the trial report; now samples during a blink are
not included in the pupil size calculation.

Added options to exclude some samples before and after a blink event in the pupil
size calculation ("Duration to Exclude Before Blinks (msec)" and "Duration to
Exclude After Blinks (msec)" in the Data Filters preferences).

Bug fix for handling blink events in some EDF files.

Bug fix in handling target position commands ("!V TARGET POS").

Supported saving interest area files in UTF-8 encoding.

Added variables to the Interest Area Report: IA_ FIRST SACCADE INDEX and
IA_LAST SACCADE INDEX.

Bug fix for Interest Area Report variables: IA_ FIRST FIXATION RUN INDEX
and IA_FIRST FIXATION VISITED IA COUNT.

Added option in the "Output/Analysis Preferences" (Identify first/last saccade
based on the first last/last fixation) to match the first/last saccade event to the
first/last fixation event in the Interest Area Report.

Version 1.11.1:

Added support for multiple EDF file loading contained in different directories.
Trial variable value editor now supports copy and paste.

Added a "Report Hidden" option for the Recording Session and trial groups.
Added FIXATION DURATION MAX, FIXATION DURATION MIN,
FIXATION DURATION MAX TIME, and

FIXATION DURATION MIN TIME to trial report.

Added IA_ LAST RUN DWELL TIME, IA LAST RUN END TIME,
IA LAST RUN_FIXATION %, A LAST RUN_FIXATION COUNT,
IA LAST RUN_START TIME, IA LAST FIXATION RUN, and
IA_THIRD RUN FIXATION COUNT to the interest area report.

Fixed various EDF file loading issues.

Bug fix for setting the directories in "General Preferences".

Bug fix for displaying non-ASCII characters in the interest area label, trial
variable value editor, and messages.

Version 1.10.123:

Added support for exporting and importing variable selection in the output reports
(trial, fixation, saccade, interest area, sample, and message).

Added support for exporting and importing interest periods across sessions.
Added support for exporting and importing preference settings.

Added legend to the grayscale version of fixation maps.

Version 1.10.1:

This version runs on Windows 2000, XP, Vista, Windows 7, and Mac OS X.
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* Better support for non-ASCII characters in the trial variable value editor, interest
area label, messages, and report outputs.

* Added "Use UTF-8 Encoding" option to the "Output/Analysis" preference.

* Bug fix for saving the animation view with cyclopean gaze cursor.

Version 1.9.193:

* Added IA FIRST FIXATION X,IA FIRST FIXATION Y,
IA_SECOND FIXATION X, IA SECOND FIXATION Y,
IA_THIRD FIXATION X,IA THIRD FIXATION Y,
IA_LAST FIXATION X, and IA LAST FIXATION Y variables to the interest
area report.

* Added CURRENT MSG INTEREST AREAS,
CURRENT MSG INTEREST AREA INDEX, and
CURRENT MSG INTEREST AREA LABEL to the message report.

* Added LAST BUTTON RELEASED, LAST BUTTON PRESS TIME, and
LAST BUTTON RELEASE TIME to the fixation report. The
LAST BUTTON_TIME variable now returns the time when the last button is
pressed or released.

* Added PUPIL SIZE MIN X, PUPIL SIZE MIN Y, PUPIL SIZE MIN TIME,
and VISITED INTEREST AREA COUNT to the trial report.

* Bug fix for interest period selection if the end time of the interest period is equal
to the start time of a fixation event.

Version 1.9.1:
* Fixation map/heat map is completely redone with the following modifications:

o Four variants of fixation maps are provided: 1 = based on duration; 2 =
based on fixation count; 3 = based on count density; and 4 = based on
duration density.

o A fixation map color legend is provided.

Renamed "Minimum Contrast Multiplier" option in the fixation map

preference settings to "Low Activity % Cut-off".

Supported drawing a title.

Transparency setting supported.

Option added to customize the Low, Medium, and High activity colors.

Option added to set a fixed maximum and minimum value for heatmap

scale.

* The compressed EDF files collected on EyeLink CL eye trackers are now
supported.

* Added TRIAL INDEX variable to the fixation, saccade, sample, message, and
interest area reports.

* Added IA FIRST FIXATION INDEX, IA FIRST FIXATION RUN INDEX,
and IA_FIRST FIXATION VISITED IA COUNT variables to the interest area
report.

©)
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